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Introduction to Acquisitions

There are several areas that must be configured in the Virtua Profiler when first
setting up Acquisitions. You will need to complete the setup prior to adding
purchase orders. Taking the time to set up the information in advance will reduce
many issues with the acquisitions workflows.

First, you will configure the Virtua Profiler:
e Set users and permissions
Set the Basic Options section
Create “Ship to” and “Bill To” Locations
Set currency
Establish taxes and fees
Set up the Purchase Request area

Second, you will create the Account Structure:

e Build your hierarchy with the spending accounts on the lowest level. You may
have a many levels as you want for grouping; however the orders are
expended from the lowest level.

¢ You must allocate funds to begin ordering

¢ You may move money between branches in the hierarchy by using the Fund
Transfer options

Third, you will create Vendor Records:
e Establish contracts and accounts linked to vendors
e Complete the information on the Vendor-Acquisitions Info Tab
e Configure Edifact only if you plan to use this for orders

Taking the time to understand the links from the Virtua Profiler configuration will
help all future parts of the acquisitions workflow to work seamlessly.
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Understanding Menu & Toolbar

As an Acquisitions user, you will be most concerned with the functions available
on the Acquisitions menu.

The Acquisitions drop-down menu displays the following selections: Orders,
Receipts, Invoices, Vouchers, Credits, Reminders, Accounts, Claims, Purchase
Request List, SICI Check-in, EDIFACT Tracker, Vendor Search, New Vendor,
Search Acquisitions, and Transactions.

i Sy
W Virtua - Headquarters - phoenix g@
File Search Circulation @ Acguisiions Cataloging Options Tools Window Help
= T H& Ord [ - = L
2 @il g o 'BB|IN < 9FEal . |aoa
eceip
Default connection: phoeniy  1nvaices W-nt connection: phoenix - staff
Vouchers »
Credits »
Reminders. ..
Accounts L4
Claims r

Purchase Request List »
SICI Check-In

EDIFACT Tracker

Vendor Search

Mew Vendor...

Search Acguisitions
Transactions L4
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Menu bar

Icon

Function
Keys

Function

Acquisitions

Orders
Add
View
Update
Delete

Cancel
Renew

Copy

Send Orders
Search by Vendor

Receipts
Add/Update

View

Invoices
Add

View
Update
Delete
Pay

Search
Acquisitions

Create New Purchase Order

View existing Purchase Order
Edit existing Purchase Order
Delete existing Purchase
Order

Cancel existing Purchase
Order

Renew a Serial Order from an
existing purchase order
Create a new Purchase Order
from an existing Purchase
Order

Send Purchase Order

Search all purchase orders
associated with a selected
vendor

Create a new Receipt or
Update an existing Receipt
View an existing Receipt

Create a new invoice

View an existing invoice
Edit an existing invoice
Delete an existing invoice
Pay an existing invoice

Search acquisitions records

Note: When used with the Alt key, underlined letters denote keyboard

shortcuts.

For example: Alt + s + a performs an author search.
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Menu bar Icon Function Function

Keys
Vouchers
New Add a new Voucher
View View an existing Voucher
Credits
New Add a New Credit
View View existing Credits
Update Edit existing Credit
Delete Delete existing Credit
Reminders Search and List Reminders
Accounts
Setup Create new accounts

Fund Transfer

Claims
Transmit Claims

Purchase_Request
List
Add

Review

SICI Check-in

EDIFACT Tracker
Vendor Search
New Vendor

Transfer funds between
accounts

Create and print claim letters

Display the Add Purchase
Request to add a new title to
the Purchase Request List
Display the Purchase Request
List window for updates

Check-in of serials issues via
SICI barcode

EDIFACT Request window
Browse vendor search

Add new vendor

Note: When used with the Alt key, underlined letters denote keyboard

shortcuts.

For example: Alt + s + a performs an author search.
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Documentation and Help

Virtua Users Guides are available in searchable .pdf format from the Tools
menu; click on the Tools menu, then select Documentation Search Engine.

L S
W Virtua - Headquarters - phoenix E]@
File Search Circulation Acguisiions Cataloging Options  Tools Window Help
W@V AR CSEH MBE O B D

Default connection: phoenix - staff Notepad

WordPad

0n Screen Keyboard

Documentation Search Engine

Note: While the Documentation Search Engine appears on your Tools menu by
default, it is functional only if the Virtua documentation has been installed via the
Documentation Installer. For details on the Documentation Search Engine, see the
section Viewing and Searching the Virtua Documentation in the Virtua Client
Getting Started Primer.

MARC 21, CATMARC, and UNIMARC Format help is available from the Help
menu; click on the Help menu and select the appropriate help category.

-

W Virtua - Headquarters - phoenix g@w

File Search Circulation Acquisions Cataloging Options Tools Window | Help

M@ 42 el AamE N MARC21 Auth Help E

MARC21 Bib Help
Default connection: phoenix - staff MARC21 Holdings Help

MARC21 Community Info Help
Patron MARC Help

CATMARC Help
CATMARC Leader 06 Help
LINIMARC Bib Help
LINIMARC Auth Help

Permissions Help
About...
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Context sensitive help is available; from the window for which help is needed,

using the F1 key or right mouse click will bring forward more information
regarding that portion of the window.

r- =
W Virtua - Headquarters - phoenix o3
File Search Circulation Acquisiions Cataloging Options Tools Window Help
i !
|2 @ i | @ What's This? =JoEd| & |
Defajtmtcﬁurl File Edit Bookmark Options Help o
Help Iu:upiu:sl Black Print 4 B3
To include an order prefix as part of vour order number, 2elect an order prefix from the
drop-dowen list box. Thiz prefic will be added to the order number to create your full purchaze
order number.
The Window menu tracks the order in which open Virtua windows were accessed.
W Virtua - Headquarters - phoenix u@ﬁ
File Search Circulation Acquisiions Cataloging Options Tools | Window Help
[ @0 2% €eB MBE N o=~ D B |
Close All Messages
Default connection: phoenix - staff Cascade Cataloging Windows v

Tile Cataloging Windows

1 Account Management - phoenix
2 Fund Transfer - phoenix
3 Add Account

Close All (Alt + w + a) will close all open Virtua windows.
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Acquisition Record Data Structure

For Virtua acquisitions to function properly, the following elements must exist:

A MARC bibliographic record (for monograph and serial order types only)
A vendor record

Account(s) with funds allocated

Acquisitions Library Location(s)

Order MNotes (40— Purchase I— WVendor
Order
h 4
Line Ttem 1 Line Ttem 2 Line Ttem 3
Bibliographic Copy 1
e —
Eecord ’7
Copy 2
Acquisitions Status
Library —————

Location Copy 3 Cendition

v Account 1 Drate
Bill to:
Address Arcount 2
=hip to:
Address

Line Item Motes
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Rules

Purchase Orders

Multiple users may add purchase orders simultaneously.
Purchase Orders have a unique ID.

Purchase Orders have one vendor.

Line Items have one title.

Titles have one bibliographic record.

Titles may have multiple purchase orders.

Line Items may have multiple accounts.

Line items may have multiple copies if all order information (account, price,
location, etc.) is identical.

Multiple copies may be entered for multiple locations.
Different locations appear on different lines.

Line Items have an Acquisitions location.

Completed order remains in the system until archived.

Currency

If the currency selected for the order is not the default database currency then all
line items on the purchase order will use this currency.

The currency on the invoice may be different from the currency on the purchase
order.

The currency on the voucher must be the same as the currency on the invoice.
When the currency is updated in the Profiler, you must update the Encumbrance
tab to update all existing purchase orders that are not yet invoiced and paid.

Accounts

Accounts are filtered by login location. Once the accounts are created, only those
users that have permission to connect to that login location may view the account
summary.

Billing and Shipping Locations

One Acquisitions library must be linked to a main library location.
Acquisitions Libraries may be linked to multiple billing and shipping locations.

Receipts

Line Item Status, Condition, Date, etc., may be changed for each copy at the
Receipt stage.

Credits

Credits may be entered in the system at any time provided at least one invoice
exists for the vendor. There are three types of credits. When using an Internal

Credit, you must have an account linked. Then any future internal credit will go
back to that account.
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Printed formats

Claim letters may be generated at any time based on the maximum number of
claims set in the vendor record.

Cancellation letters can be generated for sending later.

Purchase orders that are printed may have vendor notes to display.

Using the Job Scheduler

You can schedule the AutoClaim script to run so that daily claims do not have to
be transmitted. You can schedule this for Serials or Acquisitions and it can be
run by Institution. Please consult the Profiler documentation for managing
scheduled jobs.
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Acquisitions Fund Accounting

Recommended Explanation
Workflow
Virtua is designed to support an efficient, flexible way to
Create budget, encumber, expend, and monitor funds and to allow
Management for maximum reporting options. Acquisitions Accounts are
linked to the location where they are created. It is
recommended that one primary location, for example,
Add “Technical Services” is set up and the location is used to
create all accounts. This ensures that permissions can be
Accounts . S
restricted more closely for Account Summary Viewing.
Two basic types of accounts exist:
View, Modify Management Accounts — A management account must
and Delete exist at the highest level - the "root" level - and
Accounts represents the entire budget amount. Additional
management accounts may be added as needed.

v Spending Accounts — Spending accounts are the lowest
Allocate level accounts. Funds can only be expended from
New Money spending accounts.

Summary

v e Recognize management and spending accounts
Transfer e Understand the relationship between parent and child
Funds accounts

Key Terms

e Audit Trail

e Available Balance

e Child Accounts

e Encumbrance

e Fiscal Year

e Fiscal Year Rollover

e Free Balance

e Fund Allocation

e Fund Expenditure

e Fund Transfer

e Management Accounts

e Parent Accounts

e Spending Accounts
Acquisitions Workflow-Based Reference Guide Last Revised: October 2017
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Explanation (cont.)

Key Terms (cont.)

Deposit Account Replenish

Deposit Replenish Total

Deposit Account

Deposit Account Threshold

Deposit

% of Fund Depletion Due to Encumbrance
% of Fund Depletion Due to Expenditure
Vendor

Vendor Customer Account

Note: Fiscal Year Rollover allows you to retain accounts
and/or balances from the preceding year.
Profiler Parameters

Sort Accounts Alphabetically: If selected, on the Accounts
Management window, accounts will be sorted
alphabetically.

Account Management Rules:
There must be at least one root account

The higher levels of accounts are considered
management accounts, allowing for groups of
accounts.

There is no limit to the hierarchical levels for each
fiscal year.

The lowest level accounts are spending accounts and
are displayed in the purchase order pull down menus.

Virtua permissions must be granted to work from the
Account Management window.

The user ID and login location are logged when a user
logs in.

Accounts created at one location are not viewable at a
different login location.
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Explanation (cont.)

Virtua provides an Audit Trail to track financial
transactions:

e Fund Allocations

e Encumbrances/Disencumbrances

e Deposits, Currency Exchange Rate Changes
InfoStation Reports

Account Summaries: Generates a summary of each

Acquisitions account in the database.

Acquisitions Audit Trail: Generates a list of Acquisition
transactions that meet the fund account and date
range criteria specified for the report configuration.
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Understanding Accounts

The Acquisitions Fund Accounting module lets you monitor your library’s fund
allocations using a hierarchical account structure.

The Fund Accounting system in Virtua consists of two types of accounts:
Management Account(s) and Spending Account(s). These accounts exist in
parent/child relationships. Management accounts can be used for grouping
accounts and all funds are expended from the accounts at the lowest level of the
account hierarchy (spending accounts).

Each new year a new fiscal year must be created in the Virtua Profiler. The user
has an option of rolling over the account structure from the previous year or to
create a new set of accounts each year. Most users will “"RollOver” the structure
and transactions from the previous year. When using the fyRollover.exe the user
may choose to roll over account structures, funds, and outstanding transactions
from one fiscal year to the next.

To set up acquisitions accounts for the first time, select Acquisitions >
Accounts 2> Setup from the Virtua main menu.

X

W Account Management - phoenix Q@.

Fiscal Year: [2010-2011

b

PRRELELkE

Refresh

+|- 10LIB
+|- Marnie Meal

Fund Transfer

Expand Al

Close

The Account Management display is linked to the fiscal year. If you have been
using Acquisition for several years you can view the accounts by selecting the
year from the drop-down list at the top of the screen.

Note: The Account Management window displays accounts for all locations
when the Filter Acquisitions Records By Log-In Location setting in the Virtua
Profiler (Acquisitions Basic Options Parameter) is OFF.
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Profiler Tip: The Sort Accounts Alphabetically option controls whether, on the
Account Management window, accounts will be sorted alphabetically or display
in the order that they were entered into the system. See Working with the
Acquisitions Basic Options Parameter: Sort Accounts Alphabetically Option in the
Virtua Profiler/Acquisitions Parameters User’s Guide for more information.

Profiler Tip: The Fiscal Years parameter lets you define fiscal years for use
within the Acquisitions subsystem. The fiscal years that you set in this
parameter appear in the drop-down list of fiscal years available on the Account
Management window in the Virtua client. The fiscal year that you designate in
the parameter as “current year” will be the active fiscal year and will appear first
in the list in the Virtua client. See Working with the Fiscal Year Parameter in the
Virtua Profiler/Acquisitions Parameters User’s Guide for more information.

Management vs. Spending Accounts

¢ Management Accounts — There must be a management account at the highest
level-the root level-and this account must represent the entire budget amount.
Additional management accounts may be added as needed. If a management
account is collapsed, a + sign will appear next to its name indicating that there
are child accounts underneath it.

e Spending Accounts - Spending accounts are the lowest level accounts. Funds
can be expended from only spending accounts.

Note: You can add original funds to either a management account or a spending
account. When you add funds to a spending account, the system automatically
rolls the funds into all the parent accounts. You can have multiple “Root” accounts
that exist at the same highest level.

Parent vs. Child Accounts

e Root accounts are always the highest level accounts.
¢ As Management accounts are created below the Root level, these become
parent accounts.
e Spending accounts are always child accounts.
For example: Wilson Public Library is the child of Library Budget and the parent
of Wilson - Books.

Note: You may need to create 2 or more separate “"Root” Accounts. You would do
this any time you need to track more than one budget. You may also need to
track special accounts like Endowments. Keep in mind that when two Root
accounts are created there is no link between the two “Roots”.

Elements of the Account Management Window
¢ Fiscal Year: Displayed as YYYY
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e Refresh: Although only one user can add or modify a particular account at a
time, multiple users can work with fund accounts simultaneously. If one user
adds, modifies, or deletes account information while another user accesses the
same account structure, the two users cannot see each other’s changes on the
Account Management window until they click the Refresh button. Then any
additions, deletions, or revisions made by another user in a concurrent session
will appear on the window.

e Add: Adds a new account directly below the highlighted level.

e Delete: Deletes the account highlighted.

Allocate: Allocates new money to the highlighted account.

Note: Funds can be allocated to either management accounts or spending
accounts. Funds allocated directly to a spending account are not subtracted from
its parent management account. If funds are allocated to a spending account, the
amount allocated will automatically be added to the Allocation, Distribution, and
Free Balance of all of its parent accounts. This is to keep the full Allocation up to
date.

e Fund Transfer: Transfers funds from a source account to a target account.
e B The plus (+) sign will expand the full account structure.

Create Accounts

Create an account structure for a new fiscal year by first creating the Root and
then creating the hierarchy. After creating the first Management level, you can
add other Accounts at the same level or create child accounts at the next lowest
level. There is no limit to the number of accounts or to the number of levels in the
hierarchy.

Select Acquisitions > Accounts > Setup from the Virtua main menu. The
Account Management window appears.
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W Account Management - phoenix

/o

Fiscal Year: |2010-2011

L

+- 10LIB

(A

Refresh

Add

Delete

Modify

View

Allocate

Fund Transfer

Expand All

Close

Note: When an account is selected, the Delete, Modify, View, and Allocate

buttons are activated.

To display all the layers of the account hierarchy click Expand All.

W Account Management - phoenix

BEX

Fiscal Year: |2010-2011

L«

—|- 10LIB
-I-Business
BUAY
BUBK
—|- Education
EDAV
EDBK
-I-Fine Arts
FAAY
FABK
—|- Health & Movement
HMAY
HMBK
= Humanities
HUAY
HUBK.
—|- Library

>

(]

Refresh

Delete

Modify

View

Allocate

Hltp bl

Fund Transfer

_ g |

Close

Select a Fiscal Year from the drop-down list box.

Click Add to add an account. The Add Account window will display:

e If the account window is blank begin by adding a root level account.
e If the window displays an account, click the + to expand the account
structure and highlight the level above where you want to add an account.
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Add Accounts

- -,
W Add Account E]
Account Name: |
Account Number: |
Parent Account Mumber: |O.-5. 101 ﬂ
Fiscal Year: |
Fund Code: |
Status: |Enal:u|eu:| j
Base Currency: |United States Dollar uso -

|~ Deposit Account

Free Balance:

Available Balance:

Vendor: |Nune ﬂ
Vendor Customer Account: | J
Allocation: | £.00
Encumbrance: |
Expenditure: |
%% Over encumbrance: | 0 %
% Over expenditure; | 0%
Depaosit Account Replenish: |
Deposit Replenish Total:
%% of Fund Depletion Due to Encumbrance | 0,0000 %
%% of Fund Depletion Due to Expenditure | 0,0000 %
Deposit: |
Deposit Account Threshold: | £.00
Distribution: |

|

|

QK | Cancel

Enter account information as defined below. Note that some fields are required.
If required fields are not completed, the software will issue a warning.

Account Name (required): Can be alphanumeric and up to 35 characters. The
name of the account appears on all windows that access the fund accounts.
Account Number (required): Alphanumeric, up to 35 characters.

Parent Account Number (required): For root level accounts, no parent
account number will display. At child levels, the parent account number will be
displayed.
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Fiscal Year: Year is displayed. There are a variety of display formats, limited to
30 characters. All fiscal years are set up in the Virtua Profiler. For example it can
be FY2012 or Sept2012.

Fund Code: Specifies the alphanumeric fund code associated with this account.
The fund code is optional and cannot exceed 35 characters in length. The Fund
Code lets you group related accounts in an account hierarchy for use in reports.
Status: Account status is either Enabled or Disabled.

Base Currency (read-only): Default currency for the database is displayed.
Deposit Account check box: indicates whether this account is a deposit
account. The check box needs to be checked when originally allocating funds to
an account in order for the allocated amount to appear in the Deposit field.
Vendor: select a vendor from the drop-down list that has customer accounts
set up if you wish to link the fund account to a vendor customer account.
Vendor Customer Account: if you want to link specific accounts directly to a
specific vendor you will use the field in that account window. You may select the
accounts you want to link by selecting one of those customer accounts from the
drop-down menu.

Allocation: Allocation represents the amount of funds from the budget. Once
the allocation is added the only way to change this is to use Fund Transfer. Once
you start you use Acquisitions for ordering the allocation represents the total
amount of funds allocated for orders. Allocation can be entered and the display
of the costs accepts up to 10 digits to the left of the decimal point.
Encumbrance (read-only): This is calculated as account is used. Once orders
are placed against an account and have been approved, funds are encumbered
and the amount of committed funds displays in this window.

Expenditure (read-only): This is calculated as funds are used when payments
are processed.

% Over Encumbrance: Libraries may define by percentage what they are
willing to exceed total number of funds set aside for ordering. It is typical to set
this value as Libraries may want to order more than they have allocated for that
fund as not all orders are typically received.

% Over Expenditure: Libraries may define by percentage what they are
willing to exceed beyond the total expenditure (amount paid out) money from a
specific account. This is typically to make sure that when the invoice is received
the line item on the invoice may exceed the cost that was shown on the order. If
the cost is very different this is a way to limit the amount over the approved
cost.

Deposit Account Replenish (read-only): The threshold at which you will be
alerted that funds are low in this account. This field is only editable if the
Deposit Account check box is checked.

Deposit Replenish Total: The total amount that the account has been
replenished by since the account was created. This field is not editable.

%o of Fund Depletion Due to Encumbrance: The minimum percentage that
must remain in the account at the time funds are encumbered. When a
transaction would cause the threshold to be exceeded, Virtua will warn the user.
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%o of Fund Depletion Due to Expenditure: The minimum percentage that
must remain in the account at the time funds are expended. When a transaction
would cause the threshold to be exceeded, Virtua will warn the user.

Deposit (read-only): A library can specify the amount sent to the vendor in
advance to be used for future orders.

Deposit Account Threshold: Defines the amount at which Virtua displays an
alert to the staff user that the account is running low on funds.

Distribution (read-only): Reflects the sum of the allocations of all the linked
Spending Accounts. Once funds are transferred or allocated, an amount will
display in this field.

Free Balance (read-only): The amount of an account’s allocation that has not
been encumbered or expended. This is the amount of money that is available for
expending. That is, Free Balance = Allocation - Encumbrance - Expenditure.
Available Balance (read-only): The amount of money available for distribution
and fund transfers from this account to another. For Management Accounts,
Available Balance = Allocation — Distribution. For Spending Accounts, Available
Balance = Allocation — Encumbrance - Expenditure.

Click OK to add the account. The Account Management window is active.

To add more accounts, highlight a level and click on Add. The new account will be
added one level down.

View, Modify and Delete Accounts

Once an account exists, an authorized user with appropriate permissions can
modify the account. You can ONLY modify those accounts that are at the login
location.

The Filter by Login Location parameter allows your library to filter acquisitions
records by the user’s login location. When this parameter is enabled, only
accounts associated with the current login location will appear in the Accounts
drop-down list on the Order line editor window in the client. When filtering is
enabled, you cannot manipulate any Acquisitions records, such as orders,
invoices, receipts, credits or payments that belong to a location other than the
login location.

Note: If you enable the Filter by Log-In Location parameter, you should NOT
enable the Distributions Group parameter and vice versa. To do so will cause
problems in your system.

View Accounts
Select Acquisitions > Accounts > Setup from the Virtua main menu.

Select an account from the Account Management window.
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Click on the View tab at the right of the screen. The View Account window
appears. If the user has permission, they can click on the Modify button to
modify the account.

Click on Cancel to close the View Account window.

W View Account E] Cl

Account Name:

Account Mumber;

Parent Account Mumber:

Fiscal Year:

Fund Code:

Status:

Base Currency: |United States Dollar uso |

| Deposit Account

%% Over encumbrance:

% Over expenditure:

Vendor: | J
Vendor Customer Account: | J
Allocation: |
Encumbrance: |
Expenditure: |

|

|

|

Deposit Account Replenish:

Deposit Replenish Total:

%% of Fund Depletion Due to Encumbrance

%% of Fund Depletion Due to Expenditure

Deposit:

Distribution:

Free Balance:

|
|
|
Deposit Account Threshold: |
|
|
|

Available Balance:

Maodify

Profiler Tip: The Filter Acquisitions Records by Log-in Location option allows
your library to choose whether to filter acquisitions records by a user’s log-in
location. See Working with the Acquisitions Basic Options Parameter: Filter
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Acquisitions Records by Log-in Location in the Virtua Profiler/Acquisitions
Parameters User’s Guide for more information.

Modify Accounts

You can modify the Account Name, Fund Code, Status and Percentage of Over-
Encumbrance or Over-Expenditure.

Select Acquisitions - Accounts - Setup.
Select an account from the Account Management window.

Click on the Modify tab at the right of the screen. The Modify Account window
will appear.

Modify the information. Click OK to save the changes.

On the Account Management window, click on the Refresh button to see the
update displayed.

Note: Currently you cannot directly view the original account balances or any
information on the other accounts in that part of the hierarchy. The modification
generates an entry in the transaction log. The log records the transaction and
operator id and stamps the entry with a time and date.

Delete Accounts

Only users with permission to delete accounts may select an account and click on

the Delete button. The software displays an error message if the account is linked
to an outstanding transaction. An account cannot be deleted if child accounts are
linked to the account.

Note: You cannot delete accounts with: outstanding encumbrances or
expenditures; purchase orders, payments or non-internal credits; and purchase
order header fees.

Select Acquisitions > Accounts >Setup from the Virtua main menu.

Click to select an account from the Account Management window.

Click on the Delete tab at the right of the screen.

Deposit Accounts

Deposit Accounts are used when the Library needs to set up Pre-Payments. Some
vendors, for example, Government Printing Office (GPO), will require funds to be
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set up prior to handling any orders. Typically, funds are sent to the vendor and
they set up the Account, then the Library can start to send orders.

Using the Deposit Account workflow you send orders as normal and the orders are
fulfilled; when you receive the shipment there will be a packing slip and
statement. The statement will show amount paid, amount spent and remaining
balance in the Deposit Account. You can think of this as a “"Declining Balance”.
When using this work flow the user will generate the order, receive the order and
create the invoice for full cost; however, the user will not send the invoice to the
vendor.

In Virtua, the first transaction will be to create a Voucher without Invoice. This will
allow you to send the full amount of payment to use for all future orders to this
vendor. Next, the account must be created; you will select it as a Deposit
Account. Create the account with the full amount you have “Pre-Paid”. This will
establish the full amount for the Vendor linked to the Deposit Account. Use the
drop-down list to select the vendor and set the vendor customer account ID.

You will also need to set a “"Deposit Replenish Field” as this will provide an alert
when the balance drops below a threshold. When the alert is generated, the user
can be aware of the amount of remaining funds. A decision will be made to cease
orders for this Account or more funds will be sent to the Vendor to add more
funds to the Deposit Account.

W Depasit Account?

Vendor: |N|:une ﬂ
Vendor Customer Account: | J
Allocation: | £.00
Encumbrance: |

Expenditure; |

%% Over encumbrance: | 0 %
%o Over expenditure: | 0%
Deposit Account Replenish: | £.00

There is no limit to how many Deposit Accounts you might create for any fiscal
year.

Note: Please also see the section about handling Pre-Payments in Acquisitions.

Allocate New Money
Money may be allocated to a parent account or a child account.

Select Acquisitions > Accounts > Setup from the Virtua main menu.
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Select an account from the Account Management window.
Click on Allocate. The Account Allocation window will appear.

rw Account Allocation - phoenix E]@ﬁ
Fiscal Year: |2III 12
Account Name: |F|Dwing Fountain Press
Account Number: |?41
Base Currency: |United States Dallar usp -
Current Allocation: | £ 10,040.00
Free Balance: | $10,010.00
Allocate Amount: | 2000.00

Remove Funds | Add Funds | Cancel

Modify the Allocate Amount.

Click the Add Funds button to update the account. This increases the allocation
for the account and the distribution amount for any parent account.

Click the Refresh button on the Account Management to see the allocation at
all levels.

Note: Updating an account will lock the account from use until the account
changes are saved.

Remove Funds
If your institution experiences budget cuts and funds need to be removed from an

account, users with the proper permissions may do so from the Account Allocation
window.
Select Acquisitions > Accounts = Setup.

Select an account from the Account Management window.

Click on Allocate. The Account Allocation window will appear.
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..
rW Account Allocation - phoenix g@
Fiscal Year: |ZD 12
Account Mame: |F|Dwing Fountain Press
Account Mumber: |I-"41
Base Currency: |Lnited States Dollar usp _-|
Current Allocation: | £12,040.00
Free Balance: | £12,010.00
Allocate Amount: | 500.00
Remove Funds ‘ Add Funds | Cancel

Enter an amount in the Allocate Amount text box.

Click the Remove Funds button.

Click OK in the Information window to acknowledge that the account has been
updated.

Information

jr) The account has been updated.

The Allocation account will be updated to reflect the removal of funds.

Note: The Remove Funds button is controlled by user permissions and can be
removed from the display. You may not remove the total account once it has been
used for payments.

Transfer Funds
Funds may be transferred from any account to any other account.

Select Acquisitions & Accounts = Fund Transfer. The Account Management
window will appear.

Select a fiscal year to see the appropriate accounts displayed.

Highlight the account you wish to take money from, and click on the Set as
Source button.

Highlight the account you wish to transfer money to, and click on the Set as
Target button.
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W Fund Transfer - phoenix

BE X

Fiscal Year:

|2012

Accounts:

+]- Europe Office

+- India Office
Office A
Office B
Office C

Source Account Info
Fiscal Year:

Target Account Info
Fiscal Year:

Account Mame:

Account Mame:

Account ID:

Account ID:

Current Allocation:

Current Allocation:

+- US Dffice

| 5.00 |

Available Balance:
| §.00 |

Available Balance:

$.00

Base Currency: |United States Dollar  UsD - |

Transfer Amount: | £.00

Enter the amount to transfer.

Click Save to update the account. If the source account has insufficient funds,
the software issues a warning: “Transaction failed: Insufficient funds in the
source account.” The original Fund transfer window remains open.

It is possible to transfer fund from one fiscal year to the next fiscal year. This is
only possible it the old fiscal year has not be closed.

Click on the Cancel button to cancel the fund transfer activity.

Fiscal Year Rollover

There is an executable called fyRollover.exe that is used from the command line
to provide the questions that must be answered to start the rollover process.

It is important to review the questions to understand the impact of choices before
the rollover process is started.

Options for “Rolling Over” your accounts:

You can 1) transfer the existing account structure and existing allocations from
one fiscal year to another, and 2) transfer encumbrances and outstanding orders
from on fiscal year to another.
fyRollover.exe is the utility that lets you move outstanding acquisitions
transactions from one fiscal year to the next. This program rolls over
outstanding orders, partially paid invoices, and credits that have not been fully
used. The program records the rollover of encumbrance and disencumbrance
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transactions separately. Transactions are recorded in the acquisitions audit trail
as '‘Encumbrance Rolled In” and ‘Encumbrance Rolled Out’ respectively.
fyRollover.log logs the rollover process, including the user id, date and time,
and any errors that may have occurred. If, for example, the program finds that
a purchase order has encumbrances in a fiscal year other than the fiscal year
you are rolling over, the log reports this in an error message. See the System
Management: Acquisitions Users Guide for more details.

Fund Accounts and Purchase Orders

When you create a new purchase order, you will have the option of selecting from
the Account Information tab of the Order Line Editor window.

W Order Line Editor - phoenix
Order Info/Distribution I Bibliographic Information
The Mick Adams stories, Pref, by Philip Young.
Line Item Header Information ] Locations  Account Information l
Account: |Bonks Ledger j Amount: & 15,00
Books Ledger e
Fiscal Year: ColumbiaLaw-Books I Percent: 100,00 %
Electronic Media Ledger
- Flowing Fountain Press
Fiscal Year Marc Order | Percent | Amourt |
2012 Office A R | 100 |5 15.00
Office B l
Office C [
Fund Code: BKLOD101 Delete Account ‘ Add Account |

Motes | Save | Cancel |

The Account information is also seen in the Account Summaries Report, which
can be run from InfoStation.
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Parent ‘Wilson Account YL - Reference
Account Library Name Collection
Mame

Account 14
Number

2002 Summary

Allocation

Distribution

Encumbrance
Expenditure
Free Balance

Encumbrance
Total

Expenditure
Total

Free Balance
Total

50,000.00

0,00

Report on
000 |¢— Spending

209 (Account

50,000,00

UsD 2,199.08

Ush 724,88

Ush
100,047,092,04

Acquisitions Workflow-Based Reference Guide
*Updated to 16.1

Last Revised: October 2017



Managing Vendor Records

Recommended Explanation
Workflow
Search The vendor record format in Virtua uses a field-based
OPAC for format. Using the Vendor Editor, users will be able to
Existing view, add, edit, and delete vendors.
v Summary
Add New * Add new ven.dors . — . .
Vendor e Add contact information, acquisitions information,
EDIFACT information, and any vendor notes
l e Save vendor records
Enter e Open and edit vendor information
Contact e Delete vendor records
Key Terms
I e EDI
Enter e EDIFACT
Acquisitions * Vendor ID
Info e Vendor Notes
e Vendor Record
v InfoStation Reports
Enter Vendor List: Generates a report with contact
EDIFACT information for all vendors in the database.
¢ Vendor Performance: Generates statistical
information on the performance of vendors in the
Add database.
Vendor
Notes
v
Edit
Vendor
Records
'
Delete
Vendor
Records
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Search the OPAC

As there are no controls for duplicate vendor records, it is necessary to first
search for existing vendor records before you add a new vendor. The Browse
search will display both the primary and alternate corporate names so the same
record may display multiple times in the list.

Select Acquisitions > Vendor Search from the Virtua main menu. The Browse
Search window will appear.

W Virtua - Headquarters - phoenix g@
File Search Circulaton =~ Acguisiions Cataloging Options Tools Window Help
W @O || O LAk eE iBE
Receipts 3
Default connection: phoeniX — Tnyvoices 'St connection: phoenix - staff
Vouchers 3
Credits k
Reminders. ..
Accounts k
Claims 3

Purchase Request List ¥
SICI Chedk-In

EDIFACT Tracker

Vendor Search

Mew Vendor...

Search Acquisitions
Transactions 4

Enter the vendor name and click the Search button.

W Search - phoenix
Browse lHeading l Keyword ] Control Mumber | Holdings Keyword ] Fatron ]
|1.l'en|:||:ur j |O'Cunne|| Publishing ﬂ
To begin a browse search of the library catalog, |

1. Choase the type of search by didking the arrow in the first box.

2. Then dick in the empty box.

3. Type a whole or partial last name, subject, title, call number or
other entry appropriate to the type of search you are doing.

4, Click the Search buttan or press the EMTER key on your keyboard.

LIBRARY MOTICE
Put your customized library message here and on every other tab . |
of the Search window. To do this, edit the appropriate Help strings ]
Collection Groups | | Location | | Search | Cancel

Alternately, if the Vendor ID is known, a Control Number search may be
performed. Vendor ID numbers are system generated. For a list of all vendor ID
numbers, run the Vendor List report in InfoStation.
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o 1
W Search - phoenix E
Browse I Heading I Keyword Control Number |Huldings Keywaord I Patron I

Auth ID =l =l

OCLC Mumber ~

Patron Barcode

ol number,

gilfs;-%aetfﬁ:?:tani?;;g?E humber by dicking on the arrow in

Pazsport Mumber =

.P . Il.lj} b want to search.

It?amDFd M'ESS the ENTER key on your keyboard.

Location I | Search I Cancel
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If the vendor record exists in the database, the View Vendor window will display
to the user.

7 View Vendor - ID 438 - DEF - phoenix

l Acquisitions Info ] EDIFACT] Motes l Customer Account | Serial Order Renewal Reminders ]

MName

Primary: |

Alternates: | cponting Bird Press
Plum Island Publications
Burning Bush Press

Hii

Edit alternate: |

URL: |

Order Address lCIaim Address ] Payment Address ] Returns Address ] Other Address ] Default Address

Contact: | Email:l
Address: |
|
|
City: | County/parish: |
State/province: | Postal/zip: |
Country: | Telephone: | Fax:
v Delete | Edit ‘ Close

Create Vendor Record

If the vendor does not exist in the database, a nhew vendor record can be added
containing the following:

Contact information

Acquisitions information

EDIFACT information

Vendor notes

Select Acquisitions > New Vendor from the Virtua main menu. By default,

the Create New Vendor window will open to the Contact Info tab, which

contains Name and Addresses fields.

Enter the vendor contact information -- Primary Name, Vendor Default Address.
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Check the Active checkbox to allow transactions against this vendor.

W Create New Vendor - Customer Support Library

] Acquisitions Info] EDIFACT] Notes ] Custorner Account | Serial Order Renewal Reminders]

Mame

Primary:

Delete

J

Alternates:
MNew

Save

i

Edit alternate: |

URL: |

Order Address l Claim Address | Payment Address | Returns Address ] Other Address | Default Address

Contact: | Email:l
Address: |
|
|
City: | County/parish: |
State/province: | Postalfzip: |
Country: Telephone: | Fax:

[~ Create Multiple Vendor Records

[# Active | Save ‘ Close |

Note: The Active checkbox indicates whether the vendor is active or not. An
inactive vendor still exists in the system, but users may not create new orders for
the inactive vendor. It is possible, however, to complete any existing orders for
that vendor.

Name

The Name area of the Contact Info tab of the Vendor record contains the
following information:

e Primary Name: The vendor’s primary name, which will always display when
viewing acquisitions data (orders, etc.) with vendors attached. This field is
required.

e Alternates: The list of alternate vendor names. This allows users to specify
common alternate names, or abbreviations, which make the vendor easier to
locate in browse search results or dropdown lists. The software will always
display the primary vendor name, regardless of which alternate name the user
selected.

o Edit Alternate: Allows the user to edit an alternate name. If the user selects
an alternate from the list, they may edit it here.

e URL: URL for the vendor’s web page, if any.
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o Delete button: Deletes the selected alternate name and selects the next name
in the list if there is one, or the previous name if there is no next name.

e New button: Unselects any alternate names, clears the Edit alternate box, and
places the cursor there, so the user may enter a new alternate name.

e Save button: Saves the alternate name in the Edit Alternate box. The new
name overwrites the selected alternate name. If there is no name selected
(because the user has pressed New) it will add a new one. The user may also
press the Enter key in the Edit Alternate box to save the name.

Addresses

The tabs at the bottom of the Contact Info tab of the Vendor record allow the
user to enter multiple vendor contact addresses.

The address types available are:
Order Address: Address used when printing order letters
Claim Address: Address used when printing claim letters.
Payment Address: Address used when printing vouchers.
Returns Address: Address used for returns. Currently this address is not used
by Virtua but is provided for user’s benefit.
e Other Address: Address use is unspecified but may be used as an alternate
address by the customer.
o Default Address: Address to be used if one of the other addresses is missing.
For example, if the Order address is missing, order letters will print with this
address. Note: All address fields are optional.

Each address has the following fields:

e Contact: Contact person at the address used for the “Attention:” mailing
address line.

e Email: E-mail address corresponding to this mailing address. Used for
electronic transmission of information in Virtua.
Address: Up to three main mailing address lines.
City: City of the mailing address.
County/parish: County or parish of the mailing address.
State/province: State or province of the mailing address.
Postal/zip: Postal code or U.S. zip code of the mailing address.
Country: Country of the mailing address.
Telephone: Voice telephone number.
Fax: Fax telephone number.

Add Acquisitions Information

The Acquisitions Info tab contains values that are relevant to acquisitions
workflows. These fields are organized in the following areas:

Orders
Claims
Other

Blocks
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Vendor Policies

W Create New Vendor - Customer Support Library

l EDIFACT] Motes ] Customer Accu:-unt] Serial Order Renewal Reminders]

Orders

Transmission method: |Print ﬂ Lead time: 30 i
Cancel Transmit Method |Print ﬂ Cancellation period: 45 i
Order currency: United States Dollar  USD - | PO Discount: 0.00 %
Claims
Transmission method: |Print j Maximum daims: 15 i

Claim interval: 30 ﬁ
Historical Claim Count: i}

Redaim interval: 45 j
Other
Invoice Discount: 0.00 % Invoice currency: |United States Dollar uso x|
Language: eng Payment currency: |United States Dollar uso _-|
[~ Exchange Order
[T Contract

Other ID:

Blocks Vendor policies
[~ Too many daims Back order if:
I Poor performance |n0 palicy j

[~ Ordering denied

[ Funds limit reached =
a
[~ Other block =

Minimum number of items per order:

[ Create Multiple Vendor Records

¥ Active ‘ Save Close

Orders
The Orders area contains order-related fields:

Transmission Method: The method of transmitting orders used for this
vendor:

Print: Print a purchase order letter (default).

Email: E-mail the purchase order letter.

EDIFACT via FTP: Prepares an EDIFACT file for FTP to the vendor and stores it
on a server in a library-specified directory.

EDIFACT and Print: Prepares an EDIFACT file for FTP and stores it on the
server, and prints a letter.

Lead Time: Number of days after the order date that the order is expected to
arrive. A number between 0 and 999. The default is 30. The software uses this
field to calculate the order due date.

Cancellation Period: Number of days after the order date that the vendor will
cancel the order if it isn't filled. A number between 0 and 999. Zero means the
vendor will never cancel the order. The default is 45. Note: This field is
currently not used by the software.
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Order Currency: Default currency used by orders for this vendor. Selected
from the currency list set up in the Virtua Profiler. The default value is the
system currency.

PO Discount: Discount rate, as a percentage, which the system applies to all
orders for this vendor. The default is zero.

Claims
The Claims area contains claim-related fields:

Transmission Method: Method of transmitting claims for this vendor. The
default is Print, which is currently the only method of transmission available.
Maximum Claims: Maximum number (between 0 and 99) of claims the vendor
can have. The default is 15.

Claim Interval: Number of days (between 0 and 999) after the due date that
an order should be claimed for the vendor. The default is 30.

Historical Claim Count: Total number of claims placed against the vendor.
This is for statistical purposes and may not be edited.

Reclaim Interval: Number of days (between 0 and 99) after a claim that a
reclaim should be issued. Zero means that a reclaim should never be issued.
The default is 45.

Other
The Other area contains other miscellaneous fields:

Invoice Discount: Discount rate, as a percentage, which the system applies to
all invoices for this vendor. The default is zero.
Invoice Currency: Default currency used by invoices for this vendor. The
default value is the system currency, which is set in the Virtua Profiler.
Language: Three-character language code for the vendor’s language. The
default is ‘eng’ (English). This field determines the language template file to use
when printing order and claim letters.
Note: If you include language, which specifies the preferred language of the
vendor, then you must use the correct three-character html code to generate the
correct language for notices, reports, etc. Codes can be found at:
http://www.oasis-open.org/cover/ iso639a.html
Payment Currency: Currency used by payments for this vendor. The default
value is the system currency, which is set in the Virtua Profiler. Note: Payment
currency has not yet been implemented.
Exchange Order: Select this check box if you want Virtua to automatically flag
as Exchange orders any orders created for this vendor using the Import MARC
Orders/Requests Tool.
Contract: This check box indicates if contract limitations require orders to be
limited to certain fund accounts. Select this check box to force the user to select
a customer account before the user can add lines to a purchase order. This
check box is automatically selected if the Contract sub-tab of the Customer
Account tab is populated in the Vendor record. The user will be able to choose
only those customer accounts configured on the Customer Account tab.
Other ID: Enter the six-character, alphanumeric Provider Code from Serials
Solutions® in this field. (For users of Serials Solutions® only.)
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Blocks

These fields are included for compatibility with Vendor records migrated from the
old Virtua Vendor format.

There are five possible blocks:
Too many claims
Poor performance
Ordering denied
Funds limit reached
Other block

While these blocks are not currently used by Virtua, the user may still set them if
they wish to convey information visually to someone viewing the record.

Vendor Policies

The Vendor policies area contains settings describing vendor order policies.
These settings are included to support fields migrated from the old Virtua Vendor
format records, and are not currently used by the software. However, the user
may still set them if they wish to convey information visually to someone viewing
the record.

Back order if: Describes the vendor’s automatic back order policy. Users can
specify that the vendor will back order items: never, if the item is not published,
if the item is out of stock, or if the item is out of stock or not published. Users
may also specify if the vendor has no policy.

Minimum number of items per order: Describes the minimum number of
items, using 0-999, on an order before the vendor will accept it.

Enter Orders information: transmission method; currency value; lead time; and
cancellation period.

Enter Claims information: transmission method; maximum claims; claims
interval; and reclaim interval.

Enter Other information: discount; language (3 letter code); invoice currency.

Enter Vendor policies: Backorder if and Minimum Number of Items per Order.

Add EDIFACT Information

The EDIFACT tab contains information needed for EDIFACT transmission and a
list of shipping methods for all vendors, not just those using EDIFACT.

Note: This tab is only applicable if you will use EDIFACT.
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W Create New Vendor - Customer Support Library

Contact Info ] Acquisitions Info EDIFACT ]N-:-tes ] Customer Account | Serial Order Renewal Reminders ]

Shipping Methods
Available shipping methods: Use shipping methods:

Rail express i MNo method specified
Truck

Road parcel express ﬂ ﬂ
Air freight

surface air lifting ﬂ ﬂ
Air express

Parcel post

Mail express

Surface mail

Accelerated surface mail

Air mail

Printed matter/book post |

EDIFACT Fields

Vendor type: |EDIFACT not supported ﬂ [~ |

| [ | | |
|

Preferred Work Flow
3 i

[ Create Multiple Vendor Records

¥ Active Save Close

Shipping Methods

The Shipping Methods group box contains the list of shipping methods used by the
vendor. The customer maintains a global list of available shipping methods in the
Virtua Profiler. For each vendor, the customer may select a set of shipping
methods available from that vendor.

Profiler Tip: The Shipping Methods parameter lets you define the shipping
methods that will be available for use in the Virtua client. The shipping methods
that you configure here will appear in the Available Shipping Methods list on the
EDIFACT tab of the Create New Vendor/View Vendor window. Then on the
Vendor window, you can choose those shipping methods that you want to
appear on the Order window for the specific vendor. See Working with the
Shipping Methods Parameter in the Virtua Profiler/Acquisitions Parameters
User’s Guide for more information.

Note: There must always be at least one shipping method assigned to a vendor.
By default, the vendor starts with shipping method 0, No method specified.
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¢ Available Shipping Methods: The list of all remaining shipping methods
defined in the profiler, minus the ones already placed in the Use Shipping
Methods list. This list is sorted by EDIFACT code.

e Use Shipping Methods: The list of shipping methods that this vendor can use,
whether they are EDIFACT vendors or not.

¢ Right Arrow: Adds the selected available shipping method to the end of the
Use Shipping Methods list. The user may also double-click methods in the
available list, or select them with the keyboard and press return.

e Left Arrow: Removes the selected method from the Use Shipping Methods list
and places it back in the available list. The user may also double-click methods
in the Use Shipping Methods list, or select them with the keyboard and press
return.

e Up/Down Arrows: Moves the selected method up or down in the Use Shipping
Methods list. The user may also select the method with the keyboard and press
Ctrl-Up Arrow or Ctrl-Down Arrow. The first shipping method is always the
default on a new order.

EDIFACT Fields

The EDIFACT Fields area contains fields that must be defined in order to transmit
orders by EDIFACT:

Vendor Type: the type of vendor for EDIFACT purposes. The default is EDIFACT
not supported. Values are:

e EDIFACT not supported: Vendor does not support EDIFACT. Users are not
allowed to transmit EDIFACT orders and claims for this vendor. If this value is
selected, the other fields in the EDIFACT fields group box are disabled.

¢ Normal EDIFACT: Vendor supports the generic EDIFACT format used by Virtua.

e Blackwell, Etc.: List of vendors who have specific EDIFACT requirements.

Transmit Method: Methods for transmitting EDIFACT orders and claims. Two
methods are available:

e EDIFACT via FTP (i.e., records are FTPed as EDIFACT files.)
e EDIFACT and print (i.e., records are FTPed as EDIFACT files and also sent as
printed order letters.)

FTP Address: The address of the vendor's server where files are placed for
transfer.

SAN: Vendor’s SAN (Standard Address Number). Required for all vendor types
except EDIFACT Not Supported. If the vendor has a SAN, select the check box
and type the number. If the vendor does not have a SAN, leave the check box

unchecked.

Agency: Agency that issued the SAN. If the SAN check box is checked, this field
is enabled; otherwise, it is disabled. When the field is enabled the drop-down list
box displays:
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9 - EAN

31B - US SBN Agency

91 - Assigned by supplier's agent
92 - Assigned by buyer

The Preferred Workflow settings on the EDIFACT tab are enabled only if the
value in the Vendor Type field is Blackwell. Blackwell supports workflows for both
MARC Orders and MARC Requests. Since Virtua cannot distinguish between a
MARC order and a MARC request on Blackwell’s FTP server, you need to choose
the workflow that your library prefers when MARC record files are retrieved. Virtua
will use the Preferred Workflow setting to determine how it will treat all the
records from Blackwell when they are imported into your database.

Working with the Configure EDIFACT Window

The Configure EDIFACT window lets you view, add, and edit information regarding
EDIFACT settings for the selected vendor.

To display the Configure EDIFACT window,

e On the EDIFACT tab of the Create New Vendor window, click the Configure
button.

The Configure EDIFACT window appears.

-,

7 Configure EDIFACT - VTLS Library M=

Yendor: Baker & Tavlor

File Transfer | MaRC File Transfer | MARC Orders | MARC Requests | Enriched Data |

[v Download Order Responses [v Upload Orders
Sub-Directory: |123VTL5-Dut Sub-Direckary: |123'-.-'TLS.in
Mot Scheduled Mot Scheduled
| Schedule | Schedule
[v Download Invoices [ Upload Claims
Sub-Directary: 123YTLS.in |

Mok Scheduled

| Schedule |

(0] 4 Close
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The Configure EDIFACT window displays the vendor’s name at the top of the
window. Below the name are the following tabs:

File Transfer

MARC File Transfer
MARC Orders
MARC Requests
Enriched Data

File Transfer Tab and MARC File Transfer Tab

The File Transfer tab and MARC File Transfer tab let you edit file transfer
information for each type of EDIFACT communication. On these tabs you can also
specify a schedule for Virtua to use to communicate information to and from the
vendor’s FTP server. If no schedule has been created, or if you need to initiate a
communication at an unscheduled time, you can use the Virtua EDIFACT Tracker.

File Transfer Tab

The File Transfer tab on the Configure EDIFACT window lets you enter and
edit file transfer data for EDIFACT orders, invoices, and claims. It also lets
you specify a schedule for Virtua to use to communicate EDIFACT
information to and from the vendor’s FTP server. Based on the schedules
you set on this tab, the Virtua Scheduler will try to...

e Download EDIFACT invoices from the vendor’s FTP site and then create
invoices in the Virtua database.

e Create EDIFACT order files for all the vendor’s unsent, approved orders that
have a transmission method of EDIFACT. Virtua will then try to upload them
to the vendor's FTP server.

e Create serial EDIFACT claim files for all the vendor’s unsent Serial claims
that have a transmission method of EDIFACT. Virtua will then try to upload
them to the vendor’s FTP server.

Note: If you do not want to create a schedule for Virtua to follow, you can use
the EDIFACT Tracker instead (see the System Management: Acquisitions User’s
Guide) to send and receive EDIFACT communications interactively.

To configure File Transfer data,

1. On the Configure EDIFACT window, click the File Transfer tab.
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W/ Configure EDIFACT - VTLS Library M=

Yendor:

File Transfer | MARC File Transfer | MARC Orders | MARC Requests | Enriched Data |

lv Download Order Responses |v Upload Orders
Sub-Directory: |123VTL5-Dut Sub-Directary: |123'u'TLS.in
Mok Scheduled Mot Scheduled
| Schedule | Schedule
[v Download Invoices [ Upload Claims
Sub-Directory: 123¥TLS.in

Mok Scheduled

Baker & Tavlor

| Schedule |

Close

The File Transfer tab displays four sections, each of which controls the schedule
for one of the following types of EDIFACT communications: order responses,
invoices, orders, and claims.

2.

For each type of file transfer that you want to configure, click the
associated check box. This enables the Subdirectory field and Schedule
button for each type of communication.

In the Download Order Responses field, type the subdirectory (or directory
path, in relation to the log-in directory) on the vendor’s FTP server from
which order response files will be transferred. If there is no subdirectory,
leave this field blank.

In the Download Invoices Subdirectory field, type the subdirectory (or
directory path, in relation to the log-in directory) on the vendor’s FTP
server from which invoice files will be transferred. If there is no
subdirectory, leave it blank.

. In the Upload Orders Subdirectory field, type the subdirectory (or directory

path, in relation to the log-in directory) on the vendor’s FTP server to which
orders will be transferred. If there is no subdirectory, leave it blank.

In the Upload Claims Subdirectory field, type the subdirectory (or directory
path, in relation to the log-in directory) on the vendor’s FTP server to which
Serial claims will be transferred. If there is no subdirectory, leave it blank.
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Note: In order for EDIFACT Serial claims to be created, Virtua requires the
following in the holdings record:
e Vendor’s subscription number in subfield $b of the 941 tag.
e Vendor’s customer account ID in subfield $a of the 942 tag. When a
Serial purchase order is created using an EDIFACT vendor, Virtua
automatically inserts the account ID in the 942 tag.

7. Schedule automatic transfers as needed (see the section “Scheduling
Automatic File and MARC File Transfers”).

MARC File Transfer Tab

The MARC File Transfer tab on the Configure EDIFACT window lets you
enter and edit MARC file transfer data for MARC orders and MARC requests.

MARC orders and MARC requests are MARC records from a vendor’s website
that are embedded with purchase order data. Once Virtua receives these
records, the software is programmed to convert the data in the records to
Virtua purchase orders:

e MARC orders are MARC records that contain data for items that have been
ordered through the vendor’s website.

e MARC requests are MARC records that contain order data for items that
have been requested through the vendor’s website but need to be ordered
through Virtua.

The MARC File Transfer tab also lets you specify a schedule for Virtua to use
to communicate EDIFACT information automatically from the vendor’s FTP
server. Based on the schedules you set on this tab, the Virtua Scheduler
will try to...

e Download MARC orders from the vendor’s FTP site and then create sent
orders in the Virtua database.

e Download MARC requests from the vendor’s FTP site and then create
unsent orders in the Virtua database

Note: If you do not want to create a schedule, you can use the EDIFACT
Tracker instead (see the System Management: Acquisitions User’s Guide)
to send and receive EDIFACT communications interactively.

To configure MARC File Transfer data,

1. On the Configure EDIFACT window, click the MARC File Transfer tab.
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W/ Configure EDIFACT - VTLS Library M=

Yendor: Baker & Tavlor

File Transfer MARC File Transfer | MARC Orders | MARC Requests | Enriched Data |

[ Download MARC Crders

[v Download MARC Requests
Mat Scheduled Sub-Direckary: |,|'h|:ume,l'l:uakErTayIDr,l'marc2

schedule

(n]4 Close

The MARC File Transfer tab displays two sections, one for downloading MARC
orders and one for downloading MARC requests.

2. For each type of file transfer that you want to configure, click the
associated check box. This enables the Subdirectory field and Schedule
button for each type of communication.

3. In the Subdirectory fields, type the subdirectory (or directory path, in
relation to the log-in directory) on the vendor’s FTP server from which files
will be transferred. If there is no subdirectory, leave it blank.

Note: For Baker & Taylor, Inc. only, specify a subdirectory (or directory path, in
relation to the log-in directory) on your library’s FTP server, which is assumed to
be the Virtua server.

4. Schedule automatic transfers as needed (see the section “"Scheduling
Automatic File and MARC File Transfers”).

Scheduling Automatic File and MARC File Transfers

Via the Virtua Scheduler, you can specify a schedule for Virtua to use when
automatically communicating information to and from the vendor’s FTP
server. You can do this for regular file transfers and for MARC file transfers.
In both cases, before scheduled transfers can take place automatically, the
following needs to happen:

Acquisitions Workflow-Based Reference Guide Last Revised: October 2017
*Updated to 16.1



44

An executable must be running in the background. The executable is
JobScheduler.exe, which will handle ALL scheduling for Virtua. It is
expected that your system administrator will run this executable at the
command line each time the database is brought up. The program runs in
the background and reads the database table that contains scheduling
information. For details about running JobScheduler.exe, see the System
Management: Acquisitions User’s Guide.

In addition, with regard to invoice file transfers, a parameter must be set in the
Virtua Profiler. The setting is called EDIFACT Invoice Processing, and it is part of
the Acquisitions Basic Options parameter.

To schedule automatic File Transfers or MARC File Transfers,

1. On either the File Transfer tab or the MARC File Transfer tab, make sure the

desired transfer is selected and configured.

2. Click the Schedule button associated with the transfer.

The Scheduler window appears.

¥ Scheduler - VTLS Library g

Scheduling: MaRC Crder/Request

Stark: | 2:16:19PM=H | 7/ 9/2015 |

Ewvery | |H|:n.|rs ﬂ

Between the hours of

12:00:00 A~ and |12:EIEI:EIEI A=

i

™ Monday [ Friday
[ Tuesday [ Saturday
[ Wednesday [ sunday
[ Thursday

Matification

Tries Before Library Motification: ] :II

Email;

K | Cancel |

3. Set the various elements on the window. Each group box lets you define

specific scheduling information:

e Start time and start date for transfers.
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e Frequency of the transfer (requires you to type a number and then
choose a period).

e Hours between which transfers are to take place.

e Days on which transfers are to take place.

e Tries Before Library Notification: The number of unsuccessful scheduled
upload/download attempts the system will make before sending a
generic notification regarding the problem.

e E-mail address of the person to be notified.

4. Click the OK button.
5. Repeat steps 1-3 for other file transfers as required.
After you finish scheduling automatic transfers...
e A description of each schedule that you set will appear on the Transfer tab

(see the example below).
e The Un-Schedule button associated with each schedule will be enabled.

File Transfer IMARC File Transfer I MARC Orders | Mat

|v Download Order Responses

Sub-Directory: [123vTLS.out

Start: 7/9/2014 2:17:18 PM, Every 1 Hours
Between 12:00:00 AM And 12:00:00 AM On
Monday, Wednesday, Friday

....................................

Un-Schedule | |i Schedule

....................................

To delete the schedule for an EDIFACT communication,
e Click the appropriate Un-Schedule button.

Virtua will ask for a confirmation of the deletion. Click Yes, and the automatic
transfer feature will be disabled for this communication.

To edit an existing schedule for an EDIFACT communication,
1. Click the appropriate Schedule button.

2. Edit the values on the Scheduler window.
3. Click the OK button.

MARC Orders Tab

The MARC Orders tab on the Configure EDIFACT window lists all the elements of a
purchase order and maps each element to a tag/subfield combination in a MARC
order record that your library receives from the vendor. The MARC Orders tab
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displays a set of default tags and subfields, which your library can modify to
satisfy local requirements as well as the vendor’s requirements.

Note: It's important that you contact each of your vendors to discuss the

appropriate mapping of information into tags and subfields to be used for MARC
orders/requests.

Virtua uses the data mapped in MARC order records to create sent orders in the
Virtua database.

Note: If the account associated with the order is disabled or has insufficient
funds, the EDIFACT Tracker will display the status of the communication as
"Created With Errors."

.,

W/ Configure EDIFACT - VTLS Library M=

Yendor:

File Transfer ] MARC File Transfer MARC Orders | MARC Requests | Enriched Data

Ilse this kab ko sek up the MARC kags and subfiglds Far this wendar, Yendaor should supply this infarmation,

Tad: Subfield; Tag: Subfield;
Purchase COrder Mumber; El=r k Quankity: ElLsla] 0
Customet Account: 261 rm Price: 260 s
Crder Date: 260 q Account Murmber: 260 |
Currency Code: G0 Z Motes to Vendor: ELD1 h
Location; G0 k Library Mokes: ELD1 d
Vendor Title I0: 951 i
[ Separate order For each line ikem, [ Auto Receive
Match/Merge Options R Options -
Ik, Close

Mapped Order Elements

Note: MARC fields on a vendor’s website may not correspond exactly to the MARC
fields on the MARC Orders tab of the Configure EDIFACT window. For example, on
the Baker & Taylor website, the MARC field labeled Agency Code maps to Virtua's
Location field, and the MARC field labeled Item Code maps to Virtua’s Account
Number field. Be sure to discuss the mapping of order elements with your vendor.
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The following mapped order elements appear on the MARC Orders tab of the
Configure EDIFACT window:

Purchase Order Number - The purchase order number, which is submitted at
the vendor’s website. If this data is missing in the MARC record, Virtua will
automatically assign a new order number.

Customer Account (required) — The customer account ID assigned by the
vendor. If this data is missing in the MARC record, Virtua will log an error in the
EDIFACT Tracker and will NOT create the order.

Order Date - The date the order was created at the vendor’s website. The
format should be yyyymmdd. If this data is missing or is in the wrong format,
Virtua will use the date the record was downloaded to the Virtua database.

Currency Code - The currency in which the order price is stated. If this data is
missing in the MARC record, Virtua will use the default currency specified in the
vendor record.

Location (required) — The circulation location for which the item is being
ordered. Virtua will use this location to set the location where the order was
created and to set the order line location. If this data is missing in the MARC
record, Virtua will log an error in the EDIFACT Tracker and will NOT create the
order.

Vendor Title ID - The unique identifier by which the vendor refers to this order
line. Virtua uses this element to match the EDIFACT invoice line with the order
line.

Quantity (required) — The number of copies of this item being ordered.
Price (required) — The estimated unit price of this item at the time of the order.

Account Number (required) — The number of the fund account from which this
item will be paid. If this data is missing or does not match any account in the
current fiscal year, Virtua will log an error in the EDIFACT Tracker.

Notes To Vendor - Notes for the attention of the vendor. For each occurrence
of this element, Virtua will create a priority line note with the Transmit to Vendor
check box selected.

Library Notes - Notes that are for internal library use only. For each
occurrence of this element, Virtua will create a priority line note with the
Transmit to Vendor check box unselected.
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Check Boxes

The following check boxes appear on the MARC Orders tab:

Separate Order for Each Line Item check box - Indicates the method by
which the order line items in incoming MARC order records should be grouped on
a purchase order

e If a purchase order number is provided in the incoming MARC records,
the line items in the records will be grouped by the purchase order
number.

e If a purchase order number is NOT provided in the incoming MARC
records, the state of the Separate Order for Each Line Item check box
will be used to group the items.

+ If the check box is not checked, the line items in all the records
will be put into the same purchase order.

+ If the check box is checked, a new purchase order will be created
for each line item in each record.

e If a purchase order number is provided for some, but not all, of the
incoming MARC records, those that have the same purchase order
number will be grouped on the same order. The other records will be
grouped according to the state of the Separate Order for Each Line Item
check box.

Auto Receive check box - Indicates if the order line item should be received
automatically when the MARC order record is downloaded. If this check box is
selected, Virtua will automatically create a receipt for the line item as it is reading
the MARC record.

Match/Merge Options

The following match and merge options appear on the MARC Orders tab:

Match/Merge Options field - Specifies how Virtua should handle the incoming
MARC record if a similar record already exists in the Virtua database. If the
Preferred Workflow as specified on the vendor record is MARC Orders, this field is
mandatory.

Options button - Displays the MARC Orders Load Options window where you can
specify the match and merge rules to use when downloading MARC orders from
the vendor.
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-

% MARC Orders Load Options E]@-\

[ Merges

[ Character Set; | j

Other Options: |

[ Load Options File: | =

ok | Cancel |

The MARC Orders Load Options window gives you options for specifying rules for
duplicate record processing and merging. Many of these options are also available
on the Bibliographic tab, Authority tab, and Patron tab of the Load Options
window in the client. For a detailed discussion of using these options for setting up
duplicate tests and merge rules, see the Virtua Record Loading User’s Guide.

Character Set

If an EDIFACT vendor uses a character set that is different from the one you use
at your library, select the Character Set check box and select a character set from
the drop-down list. When this is configured, Virtua will map downloaded MARC
orders and/or requests from the character set you specify into your library’s
character set. This is useful if your library uses UTF-8 (Virtua’s default), and you
download from OCLC, who uses MARC-8.
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Other Options

The Other Options field displays load options that are not otherwise configurable
in this window. In most cases, the options in this field come from a load options
file that has been uploaded to the server.

You can edit these options as desired, but Virtua will not validate the options
when you save them.

MARC Requests Tab

The MARC Requests tab on the Configure EDIFACT window lists all the elements of
a purchase order and maps each element to a tag/subfield combination in a MARC
order request record that your library receives from the vendor. For most
vendors, the mapping on the MARC Request tab will match the mapping on the
MARC Orders tab, but for some vendors the mapping will need to be different.

Virtua uses the data mapped in MARC order request records to create unsent
orders in the Virtua database.

.,

W/ Configure EDIFACT - VTLS Library M=

Yendor: Baker & Taylor

File Transfer | MARC File Transfer | MARC Orders MARC Reguests | Enriched Data

Ilse this kab ko sek up the MARC kags and subfiglds Far this wendar, Yendor shauld supply this information,

—

ag: Subfield;

—

a; Subfield;
Purchase COrder Mumber; Quankity:
Cusktomer Sccount: Price:

Crder Date; Account Number:

REEN
T

Currency Code: Motes to Vendor:

REEEL
T

Location; Library Mokes: ELD1
Vendor Title I0: 951
[ Separate order For each line ikem, [ COrder Immediakely
MatchMerge Cptions | Cptions
Ik, Close
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The elements on the MARC Requests tab match those of the MARC Orders tab
except for the following:

Order Immediately checkbox: Indicates if the order line item should be
ordered immediately.
e If the check box is selected, Virtua will give the order line item a status of
Approved and will encumber it. If the vendor supports EDIFACT orders, the
order will be sent at the next scheduled time for uploading EDIFACT orders.

Note: If the account associated with the order is disabled or has insufficient funds, the
EDIFACT Tracker will display the status of the communication as "Created With Errors."

e If the check box is not selected, Virtua will give the order line item a status
of Needs Approval and will not encumber the order line item.

Enriched Data Tab

The Enriched Data tab on the Configure EDIFACT window (Error! Reference
source not found.) lists the enriched data fields defined by the Enriched Data
Fields setting on the Acquisitions Basic Options window in the Virtua Profiler. Left
and right arrows allow you to select and de-select enriched data fields to send to
the vendor along with your orders. The enriched data for each order can be
configured on the Order Line Editor (see the Virtua Acquisitions User’s Guide.)

Note: For information about configuring the Enriched Data Fields setting in the
Virtua Profiler, see the Virtua Profiler/Acquisitions Parameters User’s Guide.
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W Configure EDIFACT - Virtua Library E]@

=,

Vend

or:

Custamer Accounts ] File Transfer ] M&RC File Transfer | MARC Orders | MARC Requests  Enriched Data }

Edifact Test

Available Enriched Data Fields Configured Enriched Data Fields Selected Configuration
Stock Cakegory Fund Allocation Code Tag: Subfield:
Location Code 960 b

Apply

[+ [v

(04 | Close

The Enriched Data tab consists of . . .

Available Enriched Data Fields - List of all of the enriched data fields
that are configured in the Enriched Data Fields parameter in the Profiler,
minus the fields in the Configured Enriched Data Fields list.

Configured Enriched Data Fields - List of enriched data fields that will
be included when sending enriched data to the EDIFACT vendor.

Selected Configuration - The tag and subfield of the selected enriched
data field.

To move an enriched data field from one list to another, use the right or left

arrow.

To change the tag or subfield assigned to an enriched data field,
1.

2.

3.

Select the field you would like to change from the Configured Enriched Data
Fields area.

Make your desired changes in the Selected Configuration area. If the tag or
subfield fields are left blank, Virtua will not include any information on the
purchase order for this data field.

Click the Apply button.

After making changes, click the OK button to save your configuration.

Acquisitions Workflow-Based Reference Guide Last Revised: October 2017
*Updated to 16.1



53

Add Vendor Notes

The Notes tab contains vendor notes and additional user-defined fields.

¥ Create New Vendor - Customer Support Library
Contact Info ] Acquisitions Info ] EDIFACT MNotes | Customer Account | Serial Order Renewal Reminders ]
Motes
Type Print | Alert | Public | Note
Type: Order ~| | Printnote [ Public Delete | New |
[~ Alert

MNote: | Save

Additional fields

Label Field

Label: ,— Delete | New |
Field: | Save

[ Create Multiple Vendor Records

¥ Active | Save | Close |

The Notes area allows you to add Vendor notes and contains the following:

Type: This determines where the note will appear in the acquisitions process.
Possible types are Order, Claim, Return, Invoice, Payment, Receipt, Credit, or
General.

Print Note checkbox: If checked, the note will be printed during the appropriate
print operation for the following types: Order, Claim, Payment, and Receipt.
Currently, Virtua does not support printing for the remaining types.

Public checkbox: If checked, the note is displayed to the public. Not
implemented.

Alert checkbox: If checked, the note will “pop up” in an alert at the appropriate
time, depending on the type. Virtua currently supports pop alert up activity for:
PO, receipt, invoice, payment, claim and credit notes.

Delete button: Deletes the note and highlights the previous one in the list, or
the next one if there is no previous note.

New button: Clears the note box for the user to enter a new one and deselects
any selected note. Places the cursor in the note box so the user may begin
entering the new note. Resets the note type and flags.

Save button (Notes Group box): Pressing this button saves the note. If a note
is selected in the list, the new note will save over the selected note. If there is

Acquisitions Workflow-Based Reference Guide Last Revised: October 2017
*Updated to 16.1



54

no note selected (for instance, after pressing New) it adds a new note. (When
adding a new note, the user may also press the Enter key to save.)

Adding a Note

Click the New button.

Select the type of note from the Type dropdown menu.
Select Print, Alert, or Public.

Type the note in the Notes text box

Click the Save button to save the note. It will appear in the Notes list box.

Additional Fields

The Additional Fields area contains extra fields for the vendor. An extra field
consists of a label and field text. This serves two purposes:

If users want to attach locally defined attributes to the vendor, they may use
this feature.

When migrating from the old MARC-like Vendor format, the software placed all
un-migrated MARC fields in this list.

Additional fields are easily accessible by InfoStation, so that users may write or
request reports that use these fields. The Additional Fields group box contains the
following:
Delete button: Deletes the selected field and selects the previous one in the list
or the next one if there is no previous method.
New button: Unselects any selected field and clears the label and field boxes for
the user to enter a new one. Places the cursor in the label box so the user may
begin typing.
Label: User edits the field label here.
Field: User edits the field text here.
Save button: Saves the field. If a field is selected in the list, it saves over the
selected field. If there is no field selected (for instance, after pressing New) it
adds a new one. The user may also press the Enter key in either box to save.

Add Customer Account Information

The Customer Account tab on the Vendor record lists all the customer accounts
and contains the following sub-tabs, which can be disabled for individual users:
Contract, EDIFACT, and Account Summary. The Customer Account ID and
Customer Account Name fields appear on the Customer Account tab, visible
regardless of which sub-tab is open.
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W Create New Vendor - Customer Support Library

Contact Info | Acquisitions Info | EDIFACT | Notes Customer Account | Serial Order Renewal Reminders |

Account Setup

Account ID | Account Name |

Account Mame: | Dizable ‘ Enable ‘

Account ID: | Delete Mew ‘ Save |

] EDIFACT | Account Summary

Contract Number: |

Surcharge Discounts
I li I ’7
I Ii ™ ,7

[~ Create Multiple Vendor Records

[ Active Save Close

Account Setup

The Account Setup area allows you to setup one or more accounts by adding a
library-defined customer account name and a vendor-assigned customer account
ID and clicking the Save button. To add another account, select the New button.
You can also disable an account, enable an account that has been disabled or
delete an account.

Contract Tab

The Contract sub-tab contains contract details—such as contract number,
surcharge, and discounts—that are specific to that particular customer account.
Filling in information on this sub-tab of the Customer Account tab will
automatically check the Contract check box on the Acquisitions Info tab.

EDIFACT Tab
The EDIFACT sub-tab contains the following fields:

FTP User ID - The ID used by this customer account to log into the vendor’s FTP
server.

Password - The password used by this customer account to log in to the
vendor’s FTP server.
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Confirm Password - The password for this customer account re-entered here for
confirmation.

Billing Sent To - The default billing address for this customer account. (Used
only for MARC orders and MARC requests.)

Shipping Sent To - The default shipping address for this customer account.
(Used only for MARC orders and MARC requests.)

Account Summary Tab

The Account Summary sub-tab displays the total commitment figures for all
fund accounts associated with the customer account.

Add Serials Order Renewal Reminders Information

Enter in information in the following fields, to be used when renewing serials
subscriptions from the Reminders window.

Serial Renewal Alert Interval - The number of days before the subscription’s
end date that the library should be alerted to renew the order.

Serial Price Increase % - The percentage that subscription prices are
expected to increase by each year.

Subscription Period - The period of time that subscriptions with this vendor
are usually for. Used to increment the subscription end date when batch
renewing subscriptions.

Subscription Period Type - The type of units (Years, Months, Weeks, Days)
the period above is specified in.

Note: The Serials Order Renewal Reminders is only for Order type= serial.
This is to allow the user to filter the Reminders search by Vendors as needed.
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W Create Mew Vendor - Customer Support Library

Contact Inf‘cu] Acquisitions Info ] EDIFACT] Motes ] Customer Account  Serial Order Renewal Reminders ]

Renewal Alert Interval: |0 :II Price Increase %! 0.0000 %

Subscription Period: |D j | j

[~ Create Multiple Vendor Records

¥ Active Save Close

Save Vendor Record

Press the Save button to save vendor information to the database. If the vendor
is new, the system will assign a vendor ID at this point.

The Virtua Client must be restarted for the new vendor to appear in the "Add PO
Request" drop-down list.

Modifying Vendor Records

Search the OPAC to retrieve the vendor record.
Click on View to display the View Vendor window.

Click on the Edit button to display the Edit Vendor window. The Edit button will
change to Save when the window is in edit mode.

Edit the vendor record.
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To save changes made in the Name Group box, click the Save button there to
save those changes.

Click the Save button at the footer to save all changes. Click the Close button to
close the window.

When saving an edited vendor record, the system will perform the following
validation checks:

If the user attempts to delete a shipping method that is in use, save is not
permitted, with the error Cannot delete a shipping method in use.

If the user attempts to delete a customer account that is linked to an order, the
save is not permitted, with the error Cannot delete a customer account in use.

Note: If you edit the vendor name, the edited vendor name will not appear in the
Add PO Request window until you restart the Client.

Deleting Vendor Records
Search the OPAC to retrieve the vendor record.

Click on View to display the View Vendor screen.

Click the Delete button. The user may press Delete in view or edit mode.
Note: When deleting a vendor, the system will first determine if the vendor is
linked to any existing acquisitions orders. If so, the deletion fails with the error:

The vendor is in use and cannot be deleted. Deactivate the vendor if you do not
wish to use it again.

Copying Vendor Records
Search the OPAC to Retrieve the Vendor Record

Click on View to display the View Vendor window.

Click on Copy to copy the vendor record into a Create New Vendor window.
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W/ View Vendor - ID 438 - DEF - phoenix

| Acquisitions Info | EDIFACTI Motes | Customer Account | Serial Order Renewal Remindersl

—Mame
Primary: I
Alternates: | ~hanting Bird Press Delete |
Plum Island Publications
Burning Bush Press o
Save |
Edit alternate: I
URL: |

Order Address | Claim Address | Payment Address | Returns Address I Other Address | Default Address

Contact: I Ernail:l
Address: I
|
|
City: I County/parish: I
State/province: I Postal/zip: I
Country: I Telephone: I Fax: I

¥ &ctive Copy | Delete | Edit | Close |

Note: All information from the original vendor record is copied with the exception
of the information from the Configure EDIFACT window and on the EDIFACT sub-
tab of the Customer Account tab.

Make any changes or add additional information to the vendor record (such as
EDIFACT information if applicable).

Click the Save button when you are finished.
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Acquisitions Searching

Recommended
Workflow

Explanation

Acquisitions
Search Window

Enter Search
Query

Conduct
Search

Manipulate
Search

Related
Functionality

Merge
Purchase

l

Cancel
Purchase

Virtua Acquisitions offers a search functionality that
lets the user search acquisitions records in the Client.

Introduction

Searching is comprehensive and once you have orders
and vendor records and receipt, etc. you can search for
much related data. The Acquisitions data is all keyword
indexed so searches will work to pull all data together
for any acquisitions transactions.
Summary

Search acquisitions records

Manipulate search results

Merge purchase orders

Cancel purchase orders
Key Terms

Acquisitions Searching

Merging purchase orders

Canceling purchase orders
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Acquisitions Searching

Access Search Acquisitions Window

Access the Acquisitions Search window by clicking the ~ " | icon on the
Acquisitions toolbar or by selecting Acquisitions > Search Acquisitions on
the Virtua main menu.

W Virtua - Headquarters - phoenix E]@

File Search Circulation ~Acquisiions Cataloging Options Tools Window Help

W @O || O '1BmE N - 9P E (&

Receipts ]
Default connection: phoeni¥  Iryvoices

nnection: phoenix - staff

*
Vouchers »
Credits 4
Reminders. ..

Accounts 4
Claims 4
Purchase Request List
SICI Check-In
EDIFACT Tracker
Vendor Search

-

Mew Vendor...
Search Acquisitions
Transactions 4

Note: The Acquisitions Search window may also be accessed via a right-click
option on the main windows for purchase requests, purchase orders, receipts and
invoices.

The Search Acquisitions window opens.

On the Search Acquisitions window, you can select a check box at the top of the
window to perform a search for Purchase Orders, Receipts, Invoices, Payments,
Accounts, and/or Purchase Requests. Then you can select a keyword category and
search operator to apply to the keyword(s) you type in the keyword field.

In addition, you can restrict the results of your search by using numerous filters
available on two tabs at the bottom of the Search Acquisitions window.

The Purchase Order tab offers a wide selection of filters, some of which are
drop-down lists and some free-text fields, to apply to your search of purchase
orders.
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W Search Acquisitions - phoenix

- | E
[~ Purchase Order I Receipts [~ Invoices I~ Payments [~ Account I~ Purchase Request
Keyword -
Seart!
| = = -
| =l | = = Gear |
| = = =l
Caneel |
| || = | =
| = | =
Filters

Purchase Order |Oﬁ"|er I

rPurchase Order
[~ Order Type

[~ Currency
[~ Payment Type
[~ Fiscal Year

[~ Subject Code

[~ Order State Status
[~ Order Status

[~ Ship To Location
[~ Material Type:

[~ Collection Code

Last Modified Date Due Date Order Date
Start Date Start Date Start Date

[ 3 yo12 =] [ 3 yo12 =] BRI
Stop Date Stop Date Stop Date

| 3/ g0z 7] | 3/ y012 7] EREERE

I~ Order Prefix

I~ al

[~ Line Number

I~ Enumeration/Chronclogy I

I~ Frequency I
I~ Price I:: LI I
I~ Order Quantity I : LI I

Subscription Cancellation Date
Start Date Start Date

|3y =] [ 3 yo12 =
Stop Date Stop Date

| 3 y012 5] | 3/ 1202 7]

Note: When Using the Frequency search field, Virtua will search for the
frequency according to the 310 tag subfield $a.

The Other tab offers a selection of filters to apply to acquisitions searches other

than purchase order searches.
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W Search Acquisitions - phoenix

= o
I Purchase Order [~ Receipts ™ Invoices [~ Payments ™ Account I Purchase Request
Keyword
|| = = =
| =i 3 | r aer |
| =i = | =
| = | =l 5| ==
| = =
Filters

Purchase Order  Other |

Accounts

urchase Order Request

eceipt

|~ Fiscal Year 005 [~ Group [~ Condition Code
[~ Fund Code I [~ Reguest Status [~ Receipt Status d as Duplic
[~ Category [~ Receipt Quantity I v” 0
rInvoice
[~ Invoice State [~ Currency [~ Price I vl I 0.00
[~ Quantity I vl I 0
[~ Invoice Status
Create Date Invoice from Vendor Date Approval Date
Start Date Start Date x Start Date
Stop Date Stop Date — Stop Date

Enter Search Query

Enter the search query for the acquisitions records you wish to search (e.g.
Vendor ID: 438, limited to purchase orders).
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W Search Acquisitions - phoenix - @m
¥ Purchase Order I~ Receipts [~ Invoices [~ Payments [~ Account [~ Purchase Request
—Keyword
Search
I\n'endor Id LI |438 LI I LI
| = = =] cear |
| = | = =
Cancel
| = = | = _ et |
| = | =l
Filters
Purchase Order Other |

Accounts urchase Order Request eceipt

[~ Fiscal Year D [~ Group Bellef [~ Condition Code

[~ Fund Code I [~ Request Status |~ Receipt Status Accepted as Duplic

[~ Category |~ Receipt Quantity I: Y” :
Invoice
[~ Invoice State I~ Currency [~ Price I vl I 0.00
I~ Quantity I: vl I i
[ Invoice Status
Create Date — Invoice from Vendor Date Approval Date
StartDate [ 5 12010 StartDate | 3/ 1/2012 x StartDate [ 5, 1010
StopDate | 5/ /2012 Stop Date 3 1/2012 = StopDate [ -

Click the Search button to conduct the search.

Manipulate the Search Results

Once you click the Search button on the Search Acquisitions menu, the
Acquisitions Search Results window appears.
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W Acquisitions Search Results - phoenix g@
POId | Line ... | Tite | pate | status Vendor | quan... | Price e |
6141 1 Poetry. 10/21... Ordered O'Connell Publis... 1 $.00 usD |
6151 1 La canzone del natale ; storia di spiri...  10/25... Ordered O'Connell Publis... 1 £20.00 usD T
6153 1 Spark Notes The Catcher in the Rye 10/25... Ordered O'Connell Publis... 1 £10.00 usD
6361 1 The lottery : and other stories / Shirl...  2/19/...  Ordered O'Connell Publis... 2 £ 5.00 usD
6369 1 The Megro speaks of rivers fLangst...  2/21f...  Ordered O'Connell Publis... 1 $5.00 usD
6371 1 The man in the brown suit / Agatha ... 2/21f... Ordered O'Connell Publis... 1 £5.00 usD
6372 1 The man in the brown suit / Agatha ...  2/21f... Ordered O'Connell Publis... 1 £5.00 usD
6372 2 Death on the Nile [ Agatha Christie. 2/21f...  Ordered O'Connell Publis... 2 £ 5.00 usD
6373 1 The man in the brown suit / Agatha ...  2/22f... Ordered O'Connell Publis... 1 $5.00 usD
6373 2 Death on the Nile / Agatha Christie. 2/22f... Ordered O'Connell Publis... 2 $5.00 usD
6374 1 The haunting of Hill House f Shirley J...  2/22f...  Ordered O'Connell Publis... 2 £5.00 usD
6403 1 Cat among the pigeons : a Hercule P...  8/18/...  Ordered O'Connell Publis... 1 £ 15.00 usD
6405 1 Travels in the scriptorium § Paul Aust...  8/18f... Ordered O'Connell Publis... 1 $10.00 usD
6410 1 Hercule Poirot's Christmas : a Hercul...  8/19/...  Ordered O'Connell Publis... 1 $10.00 UsD
6410 2 Black coffee : a new Hercule Poirot ... 8/19/...  Ordered O'Connell Publis... 1 £10.00 usD
6411 1 The Brooklyn follies / Paul Auster, 8/19/... ToBeCan... O'Connell Publis... 1 £ 10.00 usD
6413 1 The Brooklyn follies / Paul Auster. 8f19/...  Approved O'Connell Publis... 1 $10.00 usD
6413 2 Hammond world atlas / Hammond W...  8/19/...  Approved O'Connell Publis... 1 $20.00 usD
6414 1 Hammond world atlas [ Hammond W...  8/19/... Ordered O'Connell Publis... 1 £15.00 usD
6414 2 Geography and cartography : arefe...  8/19/... Ordered O'Connell Publis... 1 £ 10.00 usD
6146 1 Graphic dassics : Edgar Allan Poe je... 10/25... Approved O'Connell Publis... 1 $10.00 usD vl

Page Up | Page Down |
Vendor Id: 438
Close

The Acquisitions Search Results window contains a tab for each type of
acquisitions record for which results are displayed. For example, a search for
purchase orders produces a list of orders on the Purchase Orders tab that meet
the search criteria, where each row displays the following information: PO
number, PO line number, title of the item ordered, date ordered, status of the
order, vendor, quantity ordered, unit price, and order currency.

For easy reference, the filters used to launch the search and the terms searched
are displayed at the bottom of the Acquisitions Search Results window in an
information box.

Right-click on a record and you have additional options, such as navigating to the
bibliographic record, viewing the purchase order, updating the purchase order, or
viewing the vendor records.

The access points that are available from the Acquisitions Search Results
window are dependent on what type of records are in the search results. For
example, in the screenshot below, the records are all purchase orders, which is
why you can view the purchase order and update the purchase order from those
search results, and if you were dealing with invoices in the search results, you
would have different options.
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W Acquisitions Search Results - phoenix g@
Purchase Orders
POId Line ... | Title | pate | status | vender | quan... | Price lc... |
6141 1 Foetry. 10/21... Crdered C'Connell Publis... 1 $.00 USD | s
6151 1 La canzone del natale ; storia di spiri...  10/25... Ordered C'Connell Publis.., 1 £ 20,00 usD
6153 1 Spark Motes The Catcher in the Rye 10/25... Ordered O'Connell Publis... 1 5 10.00 ush
6361 1 The lottery : and other stories [ Shirl...  2/13/...  Ordered O'Connell Publis... 2 $5.00 (Bzin]
6365 1 The Megro speaks of rivers fLangst...  2/21/... Ordered O'Connell Publis... 1 $5.00 UsD
68371 1 The man in the brown suit / Agatha ...  2/21f... Ordered O'Connell Publis... 1 5 5.00 ush
6372 1 The man in the brown suit [ Agatha ...  2/21/... Ordered O'Connell Publis... 1 $5.00 usb |
68372 2 Death on the Nile [ Agatha Christie, 221/... Crdered O'Connell Publis... 2 $5.00 usD | =
68373 1 The man in the brown suit / Agatha ...  2/22f... Ordered O'Connell Publis... 1 $5.00 usD
6373 2 Death on the Mile f Agatha Christie. 2(23{... Ordered O'Connell Publis... 2 $5.00 usD
68374 1 The haunting of Hill House f Shirley 1...  2/22/... Ordered O'Connell Publis... 2 $5.00 UsD
5408 1 Cat among the pigeons @ & Hercule P... | 8/18/... Ordered O'Connell Publis... 1 & 15,00 uso
5409 1 Travels in the scriptorium / Paul Aust...  8/18/... Ordery  What's This? 10,00 1sp
6410 1 Hercule Poirot's Christmas : a Hercul...  &/19/...  Ordere Biblioaraphic Record $10.00 usD
68410 2 Black coffee : & new Hercule Poirotn...  8/19/...  Orderq £ 10,00 usD
5411 1 The Brooklyn follies / Paul Auster. 8/19/... Toge| UpdatePurchase Order $10.00 UsD
6413 1 The Brooklyn folles / Paul Auster, 8/18/... Appro| YiEw Purchase Order §10.00 UsD
8413 2 Hammond world atlas /Hammond W...  8/19/...  Approl Cancel Purchase Order(s) £ 20,00 usD
6414 1 Hammond world atlas f Hammond W...  8/19/...  Ordere $15.00 usD
6414 i Geography and cartography : arefe...  &/1%/... Ordere  vendor $10.00 (Bzin]
6146 1 Graphic dassics : Edgar Allan Poe fe... 10/25... Approved O'ConnellPublis. 1 $ 10,00 UsD [v]
Cancel POs Page Up | Page Down |

Vendor Id: 438

Close

Save Search Results

From the Acquisitions Search Results screen, you can save the search results
as a comma-separated value file (*.csv).

While viewing the search results you wish to save, right-click on the results and
select Save as CSV from the right-click menu.
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-~

W Acquisitions Search Results - VTLS Home Library

Purchase Orders
PO Id Line ... | Title ) _ |pate s
BETT z Love alwaws [soond recordinn £ K-Ci... 80107, O
EE04 2 Ciby by the  #What's This? ... O
Be0s £ Romandng  gibliagraphic Recard 1. O
Ba10 1 Russia [ Ol ... A
E650 1 Surviving 4 IUpdate Purchase Qrder 4. D
540 i Surviving £ Wiew Purchase Order 4. Di
] 1 Heart of t: 3
6736 2 The Smiths Aloooow
6737 2 Heart of kg Wendor 7l W
6743 1 Chicka chic Save as CSY ... O
6747 1 The Engliskrm SIS
6747 3 W' is For wasted | Sue Grafton, 1%7,1‘. oo
=7EA 1 The tnmre = im inkibks TRME A s LRy "

When you select the Save as CSV menu option, Windows displays a dialog box
for you to select the file location.

Save Records

Save in: I ) Virtua LI & E3~
(C)Backup () New Files
) Catalog [)Motices
| ) CirculationBackupFiles |_Z)%DBTable:
[C)DBTables FiBug 1767
() Help ﬁjsearch.pc
[L2)Mew Acquisitions Files Thitele_depz
ram @)
n—_—
Save as type: Icsv LI Cancel |

Navigate to your desired target location, type the name you would like to call the
file, and click Save. The file will be saved to the location you specify.
Hint: Type .csv after the filename to ensure that Windows can recognize the file.

A CSV file can be opened with a number of programs, including spreadsheet
programs such as Microsoft Excel.
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file.cs rosoft Excel

Page Layout Formulas Data Review

S=lnsert v - ﬂ [%
I Delete = | §]~

Sort & Find &

1 [le]] PO Line Title Date Status Vendor Quantity Price Currency

2 ?010_ 1 The English Girl 5/7/2014 Ordered ANMAZON 5 $27.99 USD
3 7010 3 Wis for wasted / Sue Grafton. 5/7/2014 Ordered AMAZON 10 S$28.95 UsD
4 6911 1 Planet Earth. The complete series. Disc 3 [DVD vide 2/27/2014 Ordered EDIFACT Vendor 12 $5.00 USD
o A9NR 3 Wariations Isound recardinel / Maozart. 2/21/2014 Waitine Tn EA.R. PRUITT 3 S4.00 1SN

From Excel or a similar program, you can sort and/or modify the file. You can also
print the file from within the program, or send the file as an attachment to an
email.

Merge Purchase Orders

From the Acquisitions Search Results screen, you can merge multiple purchase
orders into one purchase order.

Select the purchase orders you wish to merge together using the Shift or Ctrl
buttons on your keyboard.
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W Acquisitions Search Results - VTILS Home Library g@
Purchase Orders

PO Id Ling ... | Title: | Date | Skatus | Yendor | Quan, .. | Price | Cao |
6443 1 Ultimate Santana [sound recording]. 71912...  Approved ARE HOME WIDED 8§ 5, 00HK HED ||
BS77 2 i Love always [sound recarding] § K-Ci. I IWhat'; Tllwis? T z $z2.00 sk
6604 Z City by the sea [videorecording] § Fr... 9 [Tt 3 $5.00 s
6605 z Romancing the ordinary @ avearof 5., 9 o 3 §4.00 s
Ba10 1 Russia J Oleq Torchinsky, Angela Bla... 9] ] 16 $5.00 usC
65639 1 Surviving Antarctica : realiby TV 208... 1) 5 1 $3.00 Ush
BE640 1 Surviving antarctica ; reality TV 208,., 11 5 1 $5.00 Ushr
6729 1 Heart of tarct : an intuitive approac... 811 Merge Purchase Orders HoUS.. 5 $3.00 usk
5736 z The Smithsonian. el HOoUs... 3 $15.00 Ush

BT 37 z Heart of tarot ; an intuitive approac,., 9 HoUs.., 3 $15.00 Ushr
6743 1 Chicka chicka boom boom [sound rec... 10 Save as C5Y [T S $4.00 ush
5747 1 The English Girl 11f7f... Ordered WORLDBOOK ... 5 $27.99 Ush
6747 3 W is for wasted [ Sue Grafton. 11§7)...  Ordered WORLD BOOK ... 10 § 25,95 ush
6751 1 The woman in white [DYD videorecor...  11/21..,  Crdered GEMEALOGICAL... 5 $25.00 s
6306 1 Hollywood wives the new generation...  2/14/...  Approved WILLTAM L BYRD 1 $1.00 s
6907 1 ‘Will wee miss them? @ endangered spe...  2/14/... Approved WILLOW BEND ... 1 § .00 ush
6905 3 ‘ariations [sound recording] J Mozart,  2/21)... ‘Waiting To... A.B. PRUITT 3 $4.00 s
6305 Z ‘ariations [sound recording] J Mozart,  2/21)... ‘Waiting To... A.E. PRUITT Z $4.00 s
6911 1 Planet Earth. The complete series, D...  2/27)...  Ordered EDIFACT Yendaor 12 $5.00 st
Fo10 1 The English Girl 5/712...  Crdered AMAZON 5 $27.99 Ush
7010 3 W is for wasted | Sue Grafton. 5/712...  Crdered AMAZON 10 $ 26,95 s -

Merge POs Page Up | Page Down |
Order Type: Monograph and Crder State: Needs Approval or Approved or To Be Canceled or Partially Received or Partially Invoiced
Close

Click the Merge POs button or right-click and select Merge Purchase Orders.
The purchase orders that you are merging must use the same currency and order

type.

After you click Merge POs or use the right-click option Merge Purchase Orders
for the selected purchase orders, it will bring up the Merge PO Request window.
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rw Merge PO Request g [ w
Order Prefix: — |
Order Number: |
Order Type:
|M-:nc.graph |
Payment Type:
|standard |
Vendor:

IBurning Bush Press =l
Location:
IHeadquarters =

[~ Exchange Order

Retrieve I Cancel

Input the fields on the Merge PO Request window as desired and click Retrieve.

The purchase orders are now combined into a new purchase order window.

W/ Add Order =Jo&d

Order Mumber: 6539 Order Type: Monograph
Vendor: O'Connell Publishing Payment Type: Standard
Exchange Order: N

Order Header Information |Bi||ir|g / Shipping Information |

Status: Approved Currency Type: |Unihed States Dollar usD ;I Total Price: £20.00
Order Date: I 3/ 2j2012 LI Print File: Iengmonprintpo.utf LI Total Quantity: 2
Line Items
Mumber | endor Title ID | Status | Title | Price | Qty. | Total | Discount | Fee |
1 Approved Hercule Poirot's Christmas @ a Hercul... 10,00 1 £10.00 £.00 £.00
2 Approved Black coffee : & new Hercule Poirotn...  §10.00 i £10.00 £.00 £.00

CreateBrieFBibl Copy Item | Insert Item | Delete Item | Edit Item |

hen Saving. ..
’—W {* Exit This Window {~ Repeat This Function {~ Immediately Proceed To Invoices {~ Immediately Proceed To Receipts ‘

I Rush Order I~ Auto Receive Motes | Claims | Save I Cancel |

Finish modifying the purchase order as necessary and save the purchase order.
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Cancel Purchase Orders

From the Acquisitions Search Results screen, you can cancel purchase orders

as well.

Find the order(s) you wish to cancel.

W Acquisitions Search Results - phoenix

BEX

Purchase Orders

PO 1d Line ... | Title | pate | Status Vendor | quan.... | Price le..|
6141 1 Poetry. 10/21... Ordered O'Conrell Publis... 1 5.00 UsSD |
6151 1 La canzone del natale ; storia di spiri...  10/25... Ordered O'Conrell Publis... 1 $20.00 uso | |
6153 1 Spark Motes The Catcher in the Rye 10/25...  Crdered O'Conrell Publis... 1 $10.00 usD
8361 1 The lottery : and other stories [ Shirl...  2/18/...  Ordered C'Conrell Publis... 2 £ 5.00 ush
6369 1 The Megro speaks of rivers fLangst...  2/21f... Ordered O'Connell Publis... 1 5 5.00 ush
6371 il The man in the brown suit [ Agatha ...  2/21/...  Ordered O nmemoll Bbbia 1 % 5.00 usD
68372 . 1 The man in the brown suit [ Agatha ...  2/21/... Ordered What's This? 5,00 uso |
68372 2 Death on the Nile [ Agatha Christie. 2(21{...  Ordered Bibliographic Record 5.00 usD | =
6373 1 The man in the brown suit [ Agatha ... 22{...  Ordered 5.00 usb
6373 2 Death on the Mile J’Agamafchg:istie. iffziff .. Ordered Update Purchase Order 5.00 usD
View Purchase Crder
8374 1 The haunting of Hill House f Shirley J...  2/22f...  Ordered Cancel Purchase Order(s) 5.00 ush
6403 1 Cat among the pigeons : a Hercule P...  8/18f... Ordered 15.00 ush
6405 1 Travels in the scriptorium / Paul Aust...  &/18/...  Ordered 10,00 UsD
8410 1 Hercule Poirot's Christmas : aHercul...  8/19/...  Ordered vendar 10,00 uso
68410 2 Black coffee : a new Hercule Poirotn...  8/18/...  Ordered CO'Connell Publis... 1 S 10,00 ush
6411 1 The Brooklyn follies f Paul Auster. 8/19/... ToBeCan... O'Connell Publis... 1 $10.00 usD
6413 1 The Brooklyn follies  Paul Auster. 8f13/...  Approved O'Conrell Publis... 1 $10.00 usD
8413 2 Hammond world atlas / Hammond W...  8/19/...  Approved C'Connell Publis... 1 £ 20,00 ush
6414 1 Hammond world atlas / Hammond W...  8/13f... Ordered O'Connell Publis... 1 5 15.00 ush
6414 2 Geography and cartography : arefe...  &/13/...  Ordered O'Conrell Publis... 1 £ 10.00 UsD
6146 1 Graphic classics : Edgar Allan Poe /e... 10/25... Approved O'Conrell Publis... 1 £ 10,00 usD ™
Cancel POs Page Up | Page Down |

Vendor Id: 438

Close

Click the Cancel POs button or right-click and select the Cancel Purchase

Order(s) option.

This brings up the Canceled Orders Summary screen, where you receive
notification of whether or not the order cancellation was successful.
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¥ Canceled Orders Summary - phoenix

M=%

POID | PO Line #

| oty canceled | status

| Bib Requestor

| Purchase Requestor | Error

6371 1

Printing Invoices

The Print Invoice option was added to the right-click menu available from the
Invoices tab of the Acquisitions Search Results window. Selecting this option lets
you select a template to use for printing selected invoice(s).

=
W/ Acquisitions Search Results - phoenix g@
Invoices |
Vendor Mame | Invoice Id | PO Id PO Li... | Title | Date | Status | Price | Quan... | Curr... |
O'Connell Publis... 8642 5410 1 Hercule Poirot's Christmas :...  8/19/... Vald forP... §10.00 1 usD
O'Connell Publis.,. 8642 6410 2 Black coffee : a new Hercul...  8/19/... Vvalid for ... 510,00 1 usDo
O'Connell Publis... 701 5555 1 ell tnarme {Froest © 3014f,,, Valid for P...  §15.00 1 ush
O'Connell Publis... 701 &555 2 What's This? ... ValidforP... &15.00 1 USD
O'Connell Publis... 1222 6532 1 Bibliographic Record 2... ValdforP... $15.00 1 usD
O'Connell Publis... 1222 6532 2 p . 2... Valdforp... $15.00 1 uso
O'Connell Publis,,. 523 5414 1 ﬁ_p "';E Invioice fo. ValidforP...  §15.00 1 UsD
O'Connell Publis... 529 5414 2 = TVOICE J... ValidforP... &10.00 1 UsD
. . Print Invoice )
O'Connell Publis... 702 6580 1 ... ValidforP... $20.00 1 usD
O'Connell Publis... 705 6571 1 View Purchase Order f... valdforP... $25.00 1 uso
View Receipt
Vendor
Page Up | Page Down |
vendor Id: 433
Close |
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Create Bibliographic Records for
Orders

Recommended Explanation
Workflow
: A bibliographic record must exist in the database
Creating a before an item can be ordered. A bibliographic record
Brief can be obtained by:
record e Using an existing record
l e Creating a brief record
e Importing a full record
Importing a Summary
Full Record e Create a MARC record o
e Recognize the default workforms by their file names
e Edit Fixed Field Data (006, 007, & 008 tags)
Key Terms
l e Bibliographic Record
e Fixed Fields
Save e MARC Editor
Record to e Workforms
Database List of Available Workforms
No labels Labeled Type of workform
book.wfm booklab.wfm Bib Record - Book
comp.wfm complab.wfm Bib Record - Computer
file
map.wfm maplab.wfm Bib Record - Map
mixed.wfm mixedlab.wfm Bib Record - Mixed Mat.
music.wfm musiclab.wfm Bib Record - Music
vis.wfm  vislab.wfm Bib Record - Visual Mat.
seril.wfm serillab.wfm Bib Record - Serials
record
holds.wfm holdslab.wfm Serials Holdings record
patron.wfm patrnlab.wfm Patron record
comm.wfmcommlab.wfm Community Info Record
110au.wfm110aulab.wfm Authority record
circfly.wfm Circ-on-the-fly
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Create a Brief Bibliographic Record

If the bibliographic record does not exist in the OPAC, use a workform to create a
brief MARC record that can be replaced with a full MARC record after the item is
received.

Open a Workform in the Editor

Go to Options - Cataloging Options. Be sure that Use MARC Labels is checked.

Select File > Records - Create Record from the Menu Bar. Select a workform

from the list of workforms in the Create Record window. The labeled workform

for books is booklab.wfm. These files should be located in your Virtua directory.
(c:/Program Files/VTLS/Virtua/Catalog/book.wfm)

The MARC Editor window appears, displaying the Acquisitions workform. Enter
the necessary data.
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/{1 MARC Editor - phoenix mE x|

Fixed length data elements ‘ B51215r1995192%nyu 000 1eng
d

1sen [_| [ ][068480 1463 (pbk.) :
ISBN terms of availability [£30.50

Local control number l:l l:l [ocm32620387
Original cataloging agency l:l l:l | Baker & Taylor
Transcribing agency | Baker & Taylor

Dewey classification number EI | 813/.52

Dewey edition [20
Tag 099, Subfield a l:l l:l | F
Tag 099, Subfield a [HEMINGWAY

Author, Personal name (PN) l:l | Hemingway, Ernest,

Dates associated with PN | 1899-1961.
Title | A farewell to arms [
Title statement of responsibility | Ernest Hemingway.

Edition l:l l:l | 1st Scribner Paperback Fiction ed.

Place of publication/distribution l:l l:l | Mew York :

Name of publisher/distributor | Scribner Paperback Fiction,

Date of publication/distribution | 1995, c1929,
Physical extent [ |[|[332p. ;
Physical dimensions [21em.
Originally published: Mew York :

General note l:l l:l
Scribner, 1929,

Tag 501, Subfield a [__| [ ][MARCIVE 03/01/06

Subject-add.-ent. top./geo. name l:l El | World War, 1914-1918

Tag 655, Subfield a l:l | War stories,
Tag 913, Subfield a [0 | [0 | [HEMFTARS7000

|
|
Tag 650, Subfield v [ Fiction, |
|
|

|(a) Language material L|(m) Monograph,Ttem j [~ Masked
< | = MARC 21 Bib: Book OPAC
WOPALCT

Note: Virtua provides preset workforms for Bibliographic, Authority, Holdings, and
Community Information MARC formats; Patron format, and Circ-on-the-fly
records. These may be modified and/or others created by your library. For
additional information please refer to the Cataloging Users Guide.

Save the Record
Save the record by pressing the F11 key, using the File>Save to Database

option from the Virtua main menu or the icon on the cataloging toolbar.
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The saved record reappears and then the View Record window appears,
displaying the brief bibliographic record you created.

Copy Record from Another Database

Configure a Connection

To close the existing connection, select File > Close Connection from the Virtua
main menu.

Note: You cannot configure a connection when connected to a database. You
must close all connections first.

Click on File > New Connection.

To add databases to the connection list, click on the Setup button to display the
Server Setup dialog box.

Click the New button to create a new connection.
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o =1
—
W Server Setup
Frofile: Profile name: INEW
Description: I
Database: fDEFALLT
rRecord Characteristics
Preferred Record Syntax: I
T Delete Default Load Character Set: IUTF'B ;I
[~ Connect as a generic Z39.50 Client (requires Guest login)
Address Attribute Configuration
Hostname: search Type | Attribute | Name | Delete |
TCP/IP Fort:
IZIEI [~ Use 35L
Color ~New Attribute
i) u u ' u u r Search Type: Attribute: Mame:
® [o [o [ [s [o [+ |HIRNNEL =
Automatic Login
{+ Disabled " Username only Username: I
™ Guest login " Username and Password Password: I
(6] 4 | Cancel | Apply |

Type in the Profile name, Description (name appears in the Connection List box),
Host name or IP address of the database, and enter the port number of the

database.

Note: The default database textbox should either be empty or contain the name
of the database provided by the library or bibliographic utility.

Click Save and then OK to return to the Connect to Server window.
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Obtain Record from Z239.50 Database

Select File > New Connection on the Virtua menu bar to connect to your local
database.

Select File > New Connection on the Virtua menu bar to connect to a Z39.50
database.

Note: You may repeat this process to open more databases.
Set as the default, the Z39.50 database you wish to obtain records from by
selecting File > Connection List from the main menu. The connection List

window will appear.

Highlight the database to set as the default and click the Set Default button. This
should be the database from which you wish to obtain records.

FW List of Connections - phoenix W

VEnuUs33
phoenix (DEFALLT)

Set Default Close

Click Close to exit out of the List of Connections window.

Search the OPAC for the desired record.

Save to Local Database

Open the record in the MARC Editor. Click the Save Copy to Database
icon.

If two connections are open Virtua will automatically save the record into the
other database. If more than two connections are open, Virtua will display the
following window:
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= =

Choose Connection - Library of Co...

It is not obvious which connection to send the
record copy to. Please choose the desired
destination connection:

|'!phoenix j

Ok | Cancel |

From the dropdown menu, chose the Virtua database to which you wish to add
the record.

Click OK to save the copied record.
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Preparing Book Orders

Recommended Explanation
Workflow
The monograph purchase order type is for an item or
Create group of items that are not necessarily related except
Purchase that they are available from the same vendor and the
library has bibliographic information for creating at
least a brief MARC record. This lesson will cover the
Obtai monograph purchase order workflow from creating the
ain s
Bibliographic purchase order through transmitting the order.
Summary
e Add a Purchase Order
e Obtain a Bibliographic Record
Insert e Insert line items into the Purchase Order
Line Items e Edit Line Items
e Save the Purchase Order
v e Send the Purchase Order
Edit e Print the Purchase Order
Line Ttems e Confirm Transmission
e Cancel an order
e Claim an order
A 4 Key Terms
Save e Bibliographic Record
Purchase e Currency Code
e Line Item
v e Order Type
e Payment Type
ﬁspcdhase . Purchas_e Qrder
e Transmission of order
e Vendor
\ 4 Currency Rule
Print If a currency is selected for the order that is not the
Purchase default database currency, all items on the order will
use that currency.
\4
Confirm

Transmissio
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Profiler Parameters
Currencies: Determines display format of each
currency available in the ISI-4217 standard and its
relative value to the home (base) currency.

Filter by Log-in Location: If set to Yes the user will
only be able to select from a list of accounts for the
current login location.

Fiscal Years: Contains the fiscal years in which
orders are outstanding.

Source of Selection: Allows you to define names of
the source of information about a new publication.
Optional.

Statuses (Purchase Order): Contains statuses
associated with Purchase Orders.

Subject Codes: Contains subject definitions that
are used to define purchase order line items.
Optional.

Allow Ordering for Multiple Locations (Acquisitions
Basic Options)

InfoStation Reports
Titles on Order: Reviews all outstanding,
transmitted purchase orders and generates a list
of all line items with a status of "Ordered”.

Order Status: Produces a list of purchase order line
items that meet the order status, location, and
order type criteria set in the report configuration.
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Add a Purchase Order

Select Acquisitions > Orders > Add from the Virtua main menu or the icon
from the Acquisitions menu bar.

- -
W Virtua - Headquarters - phoenix g@
File Search Circulation = Acquisiions Cataloging Options Tools  Window Help
26| @ i © || NTod= B = zl e
Receipts k View...

Default connection: phoeni¥  [rvaices v Update... v
Vouchers ¥ Delete. ..
Credits » Cancel...
Reminders. .. REenew...
Accounts 4
Claims p OBy
Purchase Request List Send Orders...
SICI Check-In
EDIFACT Tracker Search By Vendor
Vendor Search
Mew Vendor...

Search Acguisitions
Transactions 4

The Add PO Request window will open.

W Add PO Request M=
Order Prefix: |—| ;I
Order Mumber: I
Order Type:

IMu:unugraph ;I
Payment Type:

IStandard LI
Vendar:

L+

IBurning Bush Press

Location:

IHeadquarters

L+

[~ Exchange Order

Retrieve I Cancel

Enter the following information:
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Order number: May be up to 75 bytes and contain alphanumeric and special
characters, except the #. If no order number is entered, the system will assign
the order number.
Order prefix: If the database uses order prefixes, as defined in the Profiler,
users may select one at this point.
Order type: Virtua supports six order types:
Monograph: An order for a single item or group of items.
Serial: An order for a serial lets you enter enumeration and chronology
information.
Standing Order: for multi-volume series
Monographic Set: An order for a set of volumes that do not all arrive at the
same time
Planned Order: An order for an approval plan
Multi-Volume: An order for a publication that consists of multiple volumes or
parts such as an encyclopedia
Payment type: Virtua supports 5 payment types:
Standard: Allows you to receive, invoice, and pay individual line items.
Prepaid: Allows you to create an invoice and voucher for payment before you
receive the item.
Donation: Allows you to report on purchase order items that have been donated.
Prepaid- Special: Allows you to create an order where zero shows as the default
quantity received. When you create an order with the payment type of Prepaid-
Special, you can proceed immediately to invoices to find that the value in the
Receive Quantity field on the Invoice Line Item window is 0. No receipt is added.
Vendor Deposit: Allows you to report on purchase order items that have been
deposited.
Vendor: Displays vendor name and any alternative names defined in the vendor
record.

Click the Retrieve button to open the Add Order Window.

Complete the PO information

The Add Order window contains the following elements:

Order Header information: Non-editable header information that contains the
information that was filled out in the Add PO Request dialog box.

Order Header tab: Allows you to select a currency type, purchase order form,
and change the order date.

Billing/Shipping Information tab: Allows you to select billing and shipping
options.

Line Items list box: Displays items to be ordered

When Saving options: Allows you to choose between a variety of options for
the next step in your workflow.
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W Add Order E]@
Order Mumber: 6556 Order Type: Monograph
Vendor: O'Connell Publishing Payment Type: Standard
Exchange Order: -
Order Header Information lBilling / Shipping Information ]
Status: Approved Currency Type: |United States Dollar usD j Total Price: $.00
Order Date: 3/12j2012 - Print File: |engm0nprintpo.utf j Total Quantity:
Line Items
Mumber | Vendor Title ID | Status Title Price | Qty. | Total Discount: Fee
Create Brief Bib Copy Item | Insert Item | Delete Item | Edit Item |
When Saving. ..
% Exit This Window " Repeat This Function " Immediately Proceed To Invoices " Immediately Proceed To Receipts
[ Rush Order [T Auto Receive Motes | | Save | Cancel |

Complete the information on the Order Header Information tab.

Order Header Information Tab:

e Status: Defined by the system and based on the status of line items. There are
six pre-defined statuses for purchase orders and purchase order line items,
which are set in the Profiler. You cannot edit these statuses but you can define
your own statuses. You can also set a default status.

Profiler Tip: Purchase Order Statuses determine which statuses appear in the
drop-down list of purchase order statuses on the Line Item Header Information
tab of the Order Line Editor window in the Virtua client. In the following table,
we list the system-defined Purchase Order Statuses used in Virtua. See Working
with the Acquisitions Statuses: About Purchase Order Statuses in the Virtua
Profiler/Acquisitions Parameters User’s Guide for more information.

e Total: Total value of the purchase order in the selected currency of the order.
To see the equivalent value of the total in the base, or home currency, move the
mouse cursor over the value. A tool tip will appear, displaying the home
currency value.

e Order Date: Defaults to the current date but can be edited
Currency Type: Can be selected from drop-down list. If you change a currency
rate in the Virtua Profiler, the software will update encumbrances and
derivatives of encumbrances, such as free balance, only if you answer Yes to the
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Profiler prompt that asks if you want to save changes and re-encumber
accounts. You will not be able to perform Acquisitions transactions until
Acquisitions data is updated to reflect the change.

Profiler Tip: Whenever the conversion factors of non-Home currencies are
modified, you will need to update your Acquisitions data to reflect the new
exchange rates. If you do not update your Acquisitions data, the system will not
let you save any purchase orders or invoices to the database. See Working with
the Currencies Parameter: Re-encumbering Accounts After Currency Updates in
the Virtua Profiler/Global Settings User’s Guide for more information.

Print File: If your library has not created other print files of the same type in
different languages, no other choices will be available in the drop-down list in
this field.

Complete the information on the Billing/Shipping Information tab.

7 Add Order (=[5

Order Mumber: 6556 Order Type: Monograph

Vendor: O'Connell Publishing Payment Type: Standard
Exchange Order: r

Order Header Information  Billing / Shipping Information l

Biling Method: |courier | Shipping Method: [No method specified -]

Biling Sent To: |HEEdCILIBI'tEI'S Library/Technical Services j Shipping Sent To: |Headquarters Library /Technical Services j

Trans, Method: |Print ﬂ Vendor Customer Account: |ND customer account specified ﬂ

Billing/Shipping Information Tab

Billing Method: List of options for sending the bill.

Billing Sent To: List of acquisitions library locations set in the Profiler. The
address for the selected location will appear on the transmitted PO.

Trans. Method: Method used to transmit order information to the vendor;
currently, print and e-mail are the only options available. This is set in the
Acquisitions Info tab of the vendor record.

Shipping Method: Method in which items are sent from vendor to the
customer. This is set on the EDIFACT tab of the Vendor record. Note: The ability
to select shipping methods applies to all vendors, not just vendors using
EDIFACT.

Shipping Sent To: List of acquisitions library locations set in the Profiler. The
address for the selected location will appear on the transmitted PO.

Vendor Customer Account: If the Contract check box is checked on the
Acquisitions Info tab of the vendor record, the client will force you to select a
Vendor Customer Account before editing line items. Note: Selecting a Vendor
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Customer Account when the vendor Contract check box is checked will limit the
fund accounts that you can pick from.

Profiler Tip: The Acquisitions Addresses parameter deals with acquisitions
address records and works in conjunction with the flag for filtering by log-in
location. This parameter controls the linking of specific addresses to one or more
location names for the purposes of billing and shipping purchase orders. Names
associated with acquisitions addresses will appear in the Billing Sent To and
Shipping Sent To drop-down lists on the Add Order window and in the
Shipping Sent To drop-down list on the Order Line Editor window. See
Working with the Acquisitions Addresses Parameter in the Virtua
Profiler/Acquisitions Parameters User’s Guide for more information.

Add a Line Item

A bibliographic record must exist in the database before an item can be ordered.
A bibliographic record can be obtained by:

e Searching the OPAC for an existing record
e Creating a brief record
¢ Importing a full record

Search the OPAC

From the Add Order window, click on the Insert Item button to add a title to
the purchase order. The OPAC Search window will appear with the Browse tab
active.
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W
Order Mumber: 6556 Order Type: Monograph
Vendor: O'Connell Publishing Payment Type: Standard
Exchange Order: -
1
Order Header Information  Biling / Shipping In®
W/ Search - phoenix
Billing Method: Courier method specified j
Brawse ]Heading ] Keyword ] Control Mumber | Holdings Keyword ] Patron ]
Biling Sent To: Headquarters Librar adquarters Library/Technical Services j
Trans. Method: Print |Auﬂ10r j | j customer account specified j
Line Ttems To begin a browse search of the library catalog, ~
1. Choose the type of search by dicking the arrow in the first box. |
MNumber | Vendor Title ID | Status 2. Then dick in the empty box. | Discount Fee |

3. Type a whole or partial last name, subject, title, call number or
other entry appropriate to the type of search you are doing.
4, Click the Search button or press the ENTER key on your keyboard.

LIBRARY NOTICE

Put your customized library message here and on every other tab
of the Search window. To do this, edit the appropriate Help strings |

Collection Groups | | Location | | Search | Cancel |

Create Brief Bib Copy Item | Insert Item | Delete Item | Edit Item |

When Saving. ..
% Exit This Window " Repeat This Function ™ Immediately Proceed To Invoices " Immediately Proceed To Receipts

[ Rush Order [7 Auto Receive Motes | | Save | Cancel |

Search the OPAC to obtain the bibliographic record.

If the record exists you will see either the List of Titles window or the View
Record window. If you see the list of titles window, select the appropriate record
and click View to open the record in the View Bibliographic Record window.

Insert Purchase Order Line Items

Place your cursor in the area of the bibliographic information on either the Full or
the MARC tab of the View Records window.

With both the Add Order and the View Bibliographic Record windows open,
drag and drop from the bibliographic information in the view record window to the
Line Items area of the Add Order window. The line item information for the
record will be displayed on the purchase order.
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% Add Order =1 |
Corclir Baurmibaer £556 Circhar Type: Merngragh
e iCsnrl Pulskshing Prayrrecs Typa: 5Ll d
G
i View Bibliographic Recard - phoenlx o
Cirder Headar I |&
| z]=im
Stahes: Aporc
ocecaw:  [3i| ma [BEme e |
Fain Enry: Hemingwary, Emest, -~ Shahu Sl
it The snows of Klimanjaro and other stories [ Emest M., :_"ﬁgm g Ehﬂn::: g
e | 5B DEBAENHA4], (pik ) = mdmutlz-' o D’“"“_ : a N
m Pubbcaton: Mew Fork 1 Soribrer Paperbads Fichon, [1988], 1595, '
| Descrintion: 154p. : Z1om, — Total Ihems: z Unsabisfied Requests: O
Total Requests: a
Farmat [ Location [ Cal Posricar | Earcese [units [ stats |
ook F HEMINGWAY 317EUMB5TI0E Ayaiable
Book vorth Regonsl F HEMINGWAY JTEI01TZEAS0T Bysiale
Cuerent Selection:
Create Bned Bib 12 Shaow Group | ] Vi Trmm | Disdete [1=m ] Rsquest Iram ] J
Vehen Saving...
o Exit Th Wz I Maseaed Agency Reg ¥ Edit | Rsouest Bb | Agdd Ttem | Refresh | Close |
[~ Russy rcder [ futs Recene hats | | Garew | Careel |

Note: If your cursor is over a hyperlink when performing the drag and drop, an
error message will result.

Edit Purchase Order Line Items

Each line item on the purchase order must be edited before the purchase order
can be saved. This allows the user to link a location and specific fund information
directly to each line item.

Highlight the line item and then click on the Edit Item button or double-click on
the item to open the Order Line Editor window.

Complete the Line Item Header Information tab of the Order Line Editor window.
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W Order Line Editor - phoenix

Order Info,Distribution ]Bibliographic Information ]

The snows of Kiimanjaro and other stories [ Ernest Hemingway.

Line Item Header Information lLocations ] Account Information
Unit Price: | §15.00 Subject Code: |RF j
Copies: | Status: |approved ~|
Total Price: §30.00 Shipping Sent Ta: | =l
Due Date: | 41112012 | Location: | =1
Collection Code: | ------- j Source of Selection: | ------- j
Material: | ------- j Surcharge Amount: | $.00
Discount Amount: | 5.00 Music Mumber: |
Vendor Title ID: |
Reguestor Barcode; |

Motes | | Save | Cancel

The Line Item Header Information Tab

Unit Price: Default unit price of 0 appears.

Copies: Default value of 1 appears.

Total Price: Total price of unit(s).

Due Date: Due date is the current date + lead-time as defined in the
Acquisitions Info tab of the vendor record.

Collection Code: Optional. Select a collection code, defined in the Virtua
Profiler.

Profiler Tip: The Collection Code parameter is an optional parameter that can
be used to help you keep track of items in your collection. See Configuring
Collection Codes in the Virtua Profiler/Cataloging Parameters User’s Guide for
more information.

Material: Optional. Select a material type from the options in the drop-down
list.

Discount Amount: The discount amount will be calculated automatically and
filled in using the discount amount and percent from the Customer Account
tab on the Vendor window. If the customer account has no default discount
assigned, the discount (if specified) from the Acquisitions tab of the vendor
record will be used instead.

Vendor Title ID: Optional. Records the title ID the vendor has assigned to the
item.
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Subject Code: Optional. Select a subject code; defined in the Virtua Profiler.

Profiler Tip: The Subject Codes parameter contains codes that are used to
define purchase order line items. Subjects are not mandatory in Virtua, but your
library may wish to use them to keep track of orders related to a particular part
of your collection. In addition, Virtua offers a special feature that lets your
library use subject codes to identify Serial orders whose payment type is either
Deposit or Donation. See Working with Acquisitions Codes: Working with Subject
Codes in the Virtua Profiler/Acquisitions Parameters User’s Guide for more
information.

Status: Default status is set in the Virtua Profiler.

Profiler Tip: Purchase Order Statuses determine which statuses appear in the
drop-down list of purchase order statuses on the Line Item Header Information
tab of the Order Line Editor window in the Virtua client. See Working with
Acquisitions Statuses: About Acquisitions Statuses in the Virtua
Profiler/Acquisitions Parameters User’s Guide for more information.

Shipping Sent To: For any one line item, you can assign only one location.

Location: For all orders except serial orders, you can choose an empty (----- )
sub location. For serial orders, a sub location must be specified. The sub-location
identifies the holdings location, (852 tag, subfield \b of the holdings record).

Profiler Tip: The Location Names parameter lets you define library locations
and represent the physical and/or virtual locations of library materials. Library
locations and their codes reside in the Location Names parameter. Using the
Location Names parameter, you can set up both main locations and
sublocations. See Setting Up Locations in the Virtua Profiler/Global Settings
User’s Guide for more information.

Source of Selection: Optional. Select a source of selection, defined in the
Virtua Profiler.

Profiler Tip: The Source of Selection parameter lets you define source of
selection values that can be assigned to purchase order line items in the client.
The Source of Selection is defined as the source of information about a new
publication. The Source of Selection values that you configure will appear in the
Source of Selection list on the Order Line Editor window and on the
Add/Update Purchase Request window. See Working with the Source of
Selection Parameter in the Virtua Profiler/Acquisitions Parameters User’s Guide
for more information.
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e Surcharge Amount: The default surcharge, if specified on the Customer
Account tab, will be applied to the invoice line as a Miscellaneous Servicing line

fee

indicator of 0, 2 or 3 will display in this field if present

fails, will display an error message.

Enter Account Information

The Account Information tab lets you assign the account that is to be
encumbered by the amount of the line item.

Click on the Account Information tab of the Order Line Editor window.

Note: Once the status of the purchase order is Ordered, To Be Canceled, or

Canceled, you cannot edit any account distribution information.

Music Number: The music number pulled from musical sound recording bib
records, tag 024 $a with first indicator of 0 or 2; or tag 028 $a with first

Requestor Barcode: Patron barcode of the patron who initiated the request for
purchase. Upon saving, the validity of the barcode is checked, and if the check

W Order Line Editor - phoenix

Order Info/Distribution ] Eibliographic Information ]
The snows of Kiimanjaro and other stories [ Ernest Hemingway.

Line Item Header Information ] Locations Account Information l

Fund Code: BKLOO101

Account: |Books Ledger j Amount: & 30,00
Fiscal Year: |2012 ﬂ Percent: 100,00 %
Fiscal Year | Account ID | Percent | Amount

2012 |BKLOD1 [100 /& 30.00

Delete Account | Add Account |

Motes

| Save | Cancel

On the Account Information tab, the default fiscal year set in the Profiler will

appear automatically.
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From the Account dropdown menu, select the account responsible for the
purchase

If you wish to fund the item from more than one account, click the Add Account
button.

Enter either the percentage of funds or the amount to be taken from the account
for this item. If you add several accounts and enter an amount for each account,
Virtua will calculate the percentage based on the price. The percentages from all
accounts must add up to 100%.

Use the Delete Account and Add Accounts buttons to populate the Account
Information window as needed.

Note: During the line item edit process the software will alert the user if the
information is not completed fully. After each successive line item is edited and
saved, the purchase order can be saved.

Repeat until all line items are edited.

Edit Locations Tab

If the Allow Ordering for Multiple Locations flag in the Virtua Profiler is
enabled, an additional Locations tab will appear in the Order Line Editor, where
information can be entered for all of the locations that are ordering the line item.

Profiler Tip: The Allow Ordering for Multiple Locations setting lets you specify
whether ordering for multiple locations will be allowed. If you want to allow
users to assign multiple locations and ship to addresses to a single purchase
order line, select this check box. In the Virtua client, a Locations tab will appear
on the Order Line Editor window. On this tab, you will be able to view and edit
the ship to addresses and locations to the purchase order line. See Working with
the Acquisitions Basic Options Parameter in the Virtua Profiler/Acquisitions
Parameters User’s Guide for more information.

Navigate to the Locations tab of the Order Line Editor.
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¥ Order Line Editor - phoenix

Order Info/Distribution | Bibliographic Information ]
The snows of Kiimanjaro and other stories / Ernest Hemingway.

Line Item Header Information  Locations l Account Information ]

Ship to Address |L0cah’0n | Order Quantity |
|Headquarhers Library/Technical Services j 2

CSC/AAD Room 234
Headgquarters Library/Technical Services

HR/FO Room 123
Mew Delhi

Order Total: 2

Add | Delete |

Motes | | Save | Cancel |

To add the first ship-to address on the Locations tab, click in the Ship to
Address column to see a drop-down list of ship-to addresses.

Note: The Ship to Address field may be populated with a default value if the
Ship To Addresses parameter in the Virtua Profiler has been configured. See the
Virtua Profiler: Acquisitions Parameters User’s Guide for more information.

Select an address that will receive copies of the current order line item and then
select a location and specify the order quantity. To add another ship-to address,
click the Add button, and the drop-down list will appear.

Specify the Ship to Address, Location, and Order Quantity for each location
that is ordering a copy of the material.

Note: When the order is for serials items, holdings records will be created for the
item for each of the locations specified on the Locations tab.
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¥ Order Line Editor - phoenix

Order Info/Distribution | Bibliographic Information ]

The snows of Kiimanjaro and other stories / Ernest Hemingway.

Line Item Header Information  Locations l Account Information ]
Ship to Address |L0cah’0n | Order Quantity |
Headquarters Library,Technical Services : Headquarters 2
CSC/AAD Room 234 Audio Center 1

Order Total: 3
add | peete |
Motes | Save | Cancel |

Save the Purchase Order

Verify that the information in the Add Order window is complete.

Note: The purchase order cannot be transmitted until the purchase order status is
set to Approved. The purchase order status is set to Approved when all line items
are at the status Approved.

You may check one of two options Order Level checkboxes.

e Rush Order: Checking Rush Order designates the current purchase order as a
rush order. When you send a purchase order via the Send Orders function, you
can transmit rush orders separately from non-rush orders. If only some of the
items on your purchase order need to be rushed, create a separate rush order
for just those items.

e Auto Receive: Checking Auto Receive on the add order window will
automatically set the order status to Ordered and receive the items thereby
skipping the receipt stage for purchase orders. As long as the purchase order
has not been transmitted, this option is available in Add or Update mode on the
Order window.
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Note: Auto Receive is designed to save steps in managing Approval Plan and
Standing orders but can also be used with orders that are transmitted outside of
the Virtua software, for example, orders placed via the Internet.

Note: If the Alert if Purchase Order Contains More Than One Fund Account
flag in Acquisitions Basic Options in the Profiler is enabled, if multiple fund
accounts have been used in the order, an alert will appear upon saving the order.

To save a purchase order, first select the procedure to follow saving from the
When Saving... options at the bottom of the Add Order window:

e Exit this window: Saves current purchase order and closed the Add Order
window.

e Repeat this function: Saves current purchase order and open a request dialog
box so that you can request a new purchase order.

¢ Immediately proceed to Invoices: Monograph and Serial Orders only. Saves
current purchase order, transmits the order, and opens the Add Invoice window
with all purchase order line item information displayed in the Invoice Order Line
Information grid. This allows the user to skip directly to invoicing the purchase
order line items, bypassing the “normal” workflow of manually transmitting the
purchase order and then using the Receipts window to receive line items.
Grayed out if Auto-receive is enabled.

¢ Immediately proceed to Receipts: Monograph and Serial Orders only. Saves the
current purchase order, transmits it, and automatically opens the Receipt
window with data fields complete. Grayed out if Auto-receive is enabled.

Click the Save button. Virtua will perform the following actions:

e Checks for duplicate purchase order number. Prompts for another PO number if
it finds a duplicate.

Order Number Request - p...

Key Error: Document already exists
Enter & new order ID or leave it blank to
let the server assign one to you.

Order Mumber:

Cancel |

e Checks if the appropriate fund accounts have enough free balance. If not, the
software displays an error message and will not save the order.
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W Messages - phoenix g@

Order ID:6557

Line Mo.:2

Account:Flowing Fountain Press
Reasaon For Failure:Insuffident Funds
Amount Needed: $ 8.00

e If the purchase order saves correctly, displays message that the purchase order
was added successfully.

L o

Information

\ij) Purchase order added: 6556

e Adds a Statuses tab to the bibliographic record. The Statuses tab on the View
Bibliographic Record window of the OPAC displays Acquisitions status data
linked to the bibliographic record and allows you to access individual acquisitions
records for viewing or updating.

W View Bibliographic Record - phoenix E]@

a3 VR

Ful | Items | maRC |

Order ID/Line Pairs: Receipt Status Information: Payment Status Information:
|6532 -2 j Status: Request for Replacement
) Quantity: 1
Order Status Information: Condition: Wrong Edition
Order ID: 6532 Date: 3f5/2012
Order Type: Manograph
AddfUpdate View
Payment Type: Standard [Upda e | J J Q J J
Line Mumber; 2
E;TSEFL;LEJFS: Ordered Invoice Status Information: Credit Status Information:
Quantity: il Invoice ID: 123
Location: Headquarters Library/Technic | | Status: Valid for Payment
Vendor: O'Connell Publishing QL_‘a"'t'b‘“ 1
Price: £ 15,00 Price: £ 15.00
Date: 3."5."2[3 12 Date: 3;’6;20 12
Update | View | Update | View | | |

[ Masked Agency Reg | ‘ Edit ‘ Reguest Bib | Add Ttem | Refresh ‘ Close ‘
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Update Purchase Orders

It is often necessary to modify purchase orders prior to transmitting them to the
vendor.
If You Do Not Know The Purchase Order Number

Search by Vendor allows you to view all the purchase orders associated with a
vendor and filter by status and/or dates.

To view all order associated with a vendor, on the Virtua menu bar, click
Acquisitions, choose Orders, and then choose Search by Vendor.

The PO by Vendor Request dialog box appears.

FW PD By Vendor Request For... g@“

Vendor:

|O'C|:unnell Publishing j

Status

Il |

[ By Date
=l
=l
=l
Search | Cancel |

Choose the name of the vendor you want to search.
Choose a particular purchase order status by which to filter, or accept All.

If you want to filter by date, select the By Date check box, and complete the date
fields.

Click the Search button.

The PO by Vendor window displays all the purchase orders that meet the criteria
you specified.
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W PO By Vendor - phoenix - 0'Connell Publishing

BE]

PO ID | Lines | Ordered By | Date | curr... | Total Status |
5140 0 staff 10/21/2010 Ordered -
6141 1 staff 10/21f2010  USD £.00 Ordered

5143 1 staff 10/22/2010  USD £ 5,00 Approved

5145 1 staff 10/22/2010 USD £ 2,00 Approved =
5146 1 staff 10/25/2010  USD £10.00  Approved

5151 1 staff 10/25/2010  UsSD 5 20.00 Ordered

5152 1 staff 10/25/2010  USD £ 15.00 Ordered

5153 1 staff 10/25/2010  USD £ 10,00 Ordered

03ol 1 staff 2f19/2011 UsD £ 10,00 Ordered

53a9 1 staff 2f21/2011 UsD £ 5.00 Ordered

6371 1 staff 2f21j2011  UsD £ 5.00 To Be Canceled

6372 2 staff 2/21/2011  UsD £15.00 Ordered, Received

AT 7 et I IINAA (W= n] o 16 Nn Pirdarad [V]

Double-click the row displaying the desired purchase order to display the View
Order window for any purchase order on the PO by Vendor window.

Search for Items on Order

To find a purchase order if you don’t know the vendor, search the OPAC for one of

the items on order.

Click on the Statuses tab. The Order ID/Line Pairs contains the purchase order

information.
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W View Bibliographic Record - phoenix g@

ﬂﬂ 34/ 78

Ful | Ttems | MARC Statuses |

Order ID/Line Pairs: Receipt Status Information: Payment Status Information:
l5531-1 | | status:
Quantity:
Order Status Information: Condition:
Order ID: 6531 Date:
Order Type: Monograph
add/Update
Payment Type: Standard WL | | JJ 4 JJ
Line Mumber: 1
C;EeruSr;:Jrs: Ordered Invoice Status Information: Credit Status Information:
Quantity: 1
Location: Headguarters Library/Technic
Vendar: O'Connell Publishing
Price: % 15.00
Date: 312012
Update View | < | | | | 4|

™ Macked Agency Req | | Edit | Request Bib | Add Item | Refresh | Close ‘

Note: Using the Orders/Update function for a transmitted order, you can also
view reminders and user-defined reminders, or edit existing reminders. (See
Reminders and Claims Management.)

Click on the Update button to open the purchase order in the View Purchase
Order window.

If You Know the Purchase Order Number

Select Acquisitions > Orders > Update from the Virtua Main menu.
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W Virtua - Headquarters - phoenix

File Search Circulation = Acquisiions Cataloging Opfions Tools Window Help

0] @ ot © | niFoues
Receipts
Default connection: phoeniy  [ryaices
Vouchers
Credits
Reminders...
Accounts
Claims
Purchase Reguest List # Send Orders...
SICI Check-In
EDIFACT Tracker
Vendor Search
MNew Vendor...
Search Acquisitions
Transactons

» View...

¥ Update...

4 Delete...

4 Cancel...
Renew...

»

N Copy...

Search By Vendor

»

The Update PO Request window will appear.

rw Update PO Request

BE]

Order Mumber:

Retrieve I Cancel |

3 Add... E | d‘lﬂ @

Enter the purchase order number and click Retrieve. The Update Order window

appears.
W Update Order u m| m
Order Mumber: 6567 Order Type: Monograph
‘endor: 0O'Connell Publishing Payment Type: Standard
Ordered By: staff Exchange Order: In|
Order Header Information |Bi||ing / Shipping Information I
Status: Approved Currency Type: |United States Dollar usD ;I Total Price: £ 50.00
Order Date: I 3/12j2012 LI Print File: Iengmonprintpo.utf LI Total Quantity: 3
rLine Items
Mumber | endor Title ID | Status | Title | Price | Qty. | Total | Discount | Fee |
1 Approved The dangerous summer / Ermest He...  § 15.00 2 £30.00 £.00 £.00
2 Approved Richard Brautigan's Trout fishing in A... §20.00 1 £20.00 £.00 £.00
Create Brief Bib | Ttem Reminder | Copy Item | Insert Item | Delete Item | Edit Item |
hen Saving...
{* Exit This Window {~ Repeat This Function (" Immediately Proceed To Invoices {~ Immediately Proceed To Receipts ‘
[~ Rush Order [~ Auto Receive Reminders | Copy Motes | Claims | Save I Cancel |
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Note: For any line item on a Purchase Order, you can view the bibliographic
record with a right click on the line item or by using the View Order menu on the
Virtua main menu.

Send Purchase Orders

Virtua provides a way of transmitting a purchase order automatically from the
Order window.

To Send a Purchase Order from the Order Window

On the Add Order window, select the radio button Immediately Proceed to
Receipts or Immediately Proceed to Invoices at the bottom of the window.

Click the Save button. The order will be transmitted.
To Send a Purchase Order Using the Send Orders Function

Select Acquisitions > Orders > Send from the Virtua Menu Bar. The Send
Orders window will appear.

rW Send Orders - phoenix g -\

2

All Qutstanding |

(™ Single Order

" By Vendor

" By User |

(" By Date |

[ Filter by Location

" Rush Orders

K S K B K B K

Report Send Cancel |

[ Transmit Canceled Qrders

| [

Select an Option from the left hand menu (see descriptions below).

¢ All Outstanding: Checks all orders pending. Orders that have a status of
Approved will print and their status will change to Transmitted.
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Single Order: The PO Number box will become active. The order entered will
print and their status will change to Transmitted.

Rush Order: All approved rush orders flagged during order creation will print
and their status will change to Transmitted. All rush orders will be printed first
By Vendors: The vendor box will become active. Approved orders for a specific
vendor will print and their status will change to Transmitted.

By User: Sends all approved orders associated with the ID of the user logged
in.

By Date: The date box will be become active. Approved orders whose order
dates fall within the user defined range will print and their status will change to
Transmitted.

By Log-on Location: The Log-on location box will become active. Approved
orders for the log-on location will print and their status will change to
transmitted.
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Click the Report button to preview the list of orders you are about to send. The
Report Order Summary window will open.

i Sy
W Report Order Summary - phoenix B
po ry-p
Transmit | Order Number | Vendaor Currency | Order Total | Default Currency | Mess... | .
v 6231 HERITAGE BOOKS s £ 10.00 £ 10.00 ||
v G235 HERITAGE BOOKS s 5 5.00 5 5.00
‘( 5837 IMSTRUCTIOMAL s 5.299.78 §299.78
VIDEC
o 0493 WORLD BOOK s 5.00 5.00
EMCYCLOPEDIA
5491 WORLD BOOK s £.00 £.00
i SCHOOL & LIBRARY
ACC# 0170522
e 6324 Ebsco Subscription sD £ 25,00 £ 25.00
Services
+ 2 AMAZOM LSO £6.00 5£6.00
+ 5922 AMAZOM s 537049 5370.49
v 5823 AMAZOMN s 510,99 510,99 (g
v
Select Al DeselectAll | |{ Transmt [ Cance

The Transmit column indicates the status of the transmission about to take
place.

e A check mark in the Transmit column means that the order will be
transmitted.

¢ A circle with a line through it in the Transmit column means that the order
will NOT be transmitted due to an error that is described in the Message
column. Orders listed with this symbol cannot be selected or de-selected until
they are fixed.

To change the Transmit status of an order, do one of the following:
e If you do not want to transmit an order in the list, click the check mark to de-
select the order.
e If you do not want to transmit any order in the list, click the Deselect All
button. All the check marks will be removed.

To E-mail Purchase Orders

If the vendor record specifies e-mail transmission, a pop-up box appears during
the transmission process prompting you to enter an email address and subject.
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-
W E-mail Records - phoenix
Record Information Range
(&
Format: Order j -

[ Map to IS0-8859-1
[~ Map to ISO-8859-15
[~ Send as Attachment

Message information

Send To: |Dcnnne||e@\rﬂs.cnm

Subject: |

oK | Cancel

Note: If an e-mail address is entered in the Contact Information of the vendor
record, the e-mail address of the vendor will populate the Send To field of the E-
mail Records window.

To Print Purchase Orders

Currently, Virtua automatically displays a Print dialog box after you transmit a
purchase order via the Send Orders function.

Print - Phoenix (2J&d

Printing

Order ﬂ

Copies

Mumber of copies: 1 ﬂ

OK | Cancel |

Select the Print in Background check box on the Print dialog box to allow all
normal Acquisitions functions to be performed while large numbers of records are
being printed.

Note: To print purchase order letters to display right-to-left language data, see
Editing Virtua Acquisitions Text Files: Edit Text File.
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Click OK to print the purchase order. After the order is sent to the printer, the
Send Orders Summary window appears.

rw Send Orders Summary - phoenix g@-\

All orders have been sent. If any printable orders have failed to print, please indicate this below by
un-checking them. Press QK to mark all checked printable orders as 'Ordered'.

Success | Order Mumber | Vendor Transmission Message
6559 O'Connell Print
v Publishing

QK

If any order(s) did not print correctly, the checkbox next to the order number
should be cleared so that the order status remains at Approved and the order can
be retransmitted.

Click the OK button to set all checked purchase orders to ordered. Line items
from these orders can now be received.

Note: Five additional fields may be added to the letter that is generated when
purchase orders are printed:

Added Author - From tag 700 $a or 710 $%a.

Music Number - From tag 024 $a with first indicator of 0 or 2; or tag 028 $a
with first indicator of 0, 2 or 3.

Source of Selection - From the Source of Selection field on the Order Line Editor
window.

Type of Library Material - From the Type of Material field on the Order Line
Editor window.

Binding - From tag 563 $a.
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Acquisitions Cancellation Notices

To send cancellation notices to vendors in the language of the purchase order
being canceled, select the Transmit Canceled Orders check box on the Send
Orders window, to enable a drop-down list containing all notice template files
that have been configured.

W Send Orders - phoenix

=)

1

{+ Al Qutstanding |

" Single Order

(" By Vendor

(" By User

™ By Date |

[ Filter by Location

(" Rush Orders

I Transmit Canceled Orders

|Nnne| j

Repaort

| send | Cancel

K0 S K I K3 B Kl

Mone
engcogprintcancelpo.utf
engmonprintcancelpo, utf

engserprintcancelpao. utf

Choose the notice template that will be used when you send cancellation notices.

If you do not select a template file, Virtua generates notices using the template
file that corresponds to the language of the purchase order, if one is available.

Three default template files are provided in the Virtua directory of your client
installation:

engcogcancelpo.utf (for use when transmitting cancellation notices for COG
orders)
engmoncancelpo.utf (for use when transmitting cancellation notices for

monograph orders)

engsercancelpo.utf (for use when transmitting cancellation notices for serial
orders)
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Note: You can add templates for different languages by translating the template
files and replacing "eng" in the file names with the language code for the
appropriate language.

Exporting Acquisitions

Enhancements to Ad Hoc views make it possible for purchase requests and
purchase orders to be exported in their entirety to various file formats (comma
separated values, text, excel, etc.) using an Ad Hoc reporting tool, such as Crystal
Reports. An Ad Hoc view will be created for purchase requests. This view will be
named Purchase_Request_V.

To make purchase orders easier to export, the following fields will be added to the
Po_Detail_V Ad Hoc view:

Author - Author of the item being ordered. Optional.

Title - Title of the item being ordered. Optional.

Publisher - Publisher of the item being ordered. Optional.

Publication_Place - The place where the item being ordered was published.
Optional.

Publication_Date - The date that the item being ordered was published.
Optional.

Music_Number - The music number of the item being ordered. From subfield
$a of tag 024 with a first indicator of 0 or 2 or tag 028 with a first indicator of O,
2, or 3. Optional.

Source_Of_Selection - Text indicating the order line’s source of selection.
Optional.

Type of Library Material - Text indicating the type of library material associated
with the order line. Optional.

Internal_Line_Id - Internal system ID assigned to the order line. This field will
make it easier to link data in the Po_Detail_V view with data from other views
that contain order line data. Required.
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Understanding Record Masking

Recommended
Workflow

Explanation

Record Masking

Masking
Records

\4

Displaying
Masked
Records

Comprehensive record masking can be used to hide
records that have been added to selection lists or are
on order. Bibliographic and holdings records can be
masked.

Masked records are not visible in the public OPAC.
The ability to view and/or create masked records is
set in the Profiler.
Optional setting in profiler: Masking is removed when
items are received.

Summary
Mask a Record
Display Masked Records

Key Terms
Masked Record

Related Topics
Users
Permissions

Record Masking Parameters
Acquisitions Basic Options: Automatically unmask
records on receipt.
Operational Security: Permissions can be set to
allow users to View, and/or Edit masked records.
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Record Masking

Creating Masked Records

Bibliographic records may be masked so that they are not visible in the public
OPAC, or to staff members without permission to see masked records.

Bibliographic Records can be masked from several places in the Virtua Client:

View Bibliographic Record Window
MARC Editor Window

Item Information Window

View Holdings Record Window

Add Purchase Request Window
Import to Purchase Request Window

From the View Bibliographic Record window by placing a check in the Masked
checkbox:

W View Bibliographic Record - phoenix E]@
<[] srm
Ful  Ttems |MaRc | Statuses |
Main Enfry: Hemingway, Ernest, Status Counts
Title: The Mick Adams stories. Pref. by Philip Young, Chef:kEd Qut: 0 On Reserve: .
— e Available: 2 Reguested: 0
' On Hold: 0 Cther: 0
Publication: Mew York, Scribner [1972]
Description: 263 p. 24 cm. Total Items: 2 Unsatisfied Requests: 0
Total Requests: 0
Format Location Call Mumber Barcode | Units | Status
Book Headquarters F Hemingway 31781001657921 Available
Book Cliffdale F Hemingway 31781001657913 Available
Current Selection: _
12 Show Group | | View Item | Delete Item | Request Item |
[ Masked, Agency Reg Edit | Reguest Bib | Add Ttem | Refresh ‘ Close |
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From the MARC Editor window by placing a check in the Masked checkbox:

% MARC Editor - phoenix M==
[] [72040351972 nyu b _00D01eng |
[fowe J[ ][] [a77-1se7se |
[ J[ozo [ ][] [eoss412a858 |
[] (1] [esres |
[ [eas ][ J[ ] [weoss4124858 |
[] [ ][] [‘eB0RD e [3 178100165 73971 5107 F1 oF Hemingway] \c [13 1781 00165 79051 107 f1 cF

Hemingway] Ya EUTW Yo [13 1781 00165 7913! 5107 f1 cF Hemingway] ‘& HQ** \c ['3 1781

00165 7921! 107 f1 cF Hemingway]
[ [o#2 ][ ][] [eBORD 2 EUTW \a HQ™" |
[[Jos2 [ ][] [essspe |
[] [1][ ] [&Hemingway, Ermest, \d 1895-1361. |
I:I 245 III | \a The Midk Adams stories, \c Pref, by Philip Young. |
I:I I:I I:I | ‘a Mew York, 'b Scribner \c [1972] |
[ (300 ][ ][] [w288p.\c24cm. |
I:I I:I I:I | \a Eight of these stories never befare published. |
[] [ 1] [w&marciveo3/oijos |
I:I I:I I:I | \a Biblioaraphy: p. 7. |
[ [s1z ][o][o] [w&HEMNASTSS000 |
|[a) Language material L| (m) Monograph,/Ttem j [ Masked
g MARC 21 Bib: Book OPAC

WOPACT f

From the Item Information window by placing a check in the Masked
checkbox:
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r@ Item Information - phoenix M

Item Elements ISE:tistics I Other Elements I
Bibliographic Information

T
]
1
=]
s
[
m
i
||

Location:

I Edit |
1 Preservation and Conservation

Code:
Mumber of Pieces: I'- Hv Circulate Pieces: = I ;I

Price:

Author: Hemingway, Ernest, 1899-1961.
Title: The Mick Adams stories. Pref, by Fhilip Young.
Publisher: Mew York, Scribner [1972]
rTtem Information Call Mumber
Item ID: 168611 Copy! I
Barcode: 3178 1001657921 call = [F remingriay
Barcode Type: I-“\e; ar j 2nd Call #: I
Item Class: I"C" ;I
Units
Reserves Item Class: I T3 mpms Tas
Item URL: I £~ Enurmetation and Chranology
I = MNone

Shelving Location:

Irl:
i
%1
Ll

i
[
[
L

T Mon-Patameterized Shelf Location

Location: I ;I

EPM Mumber:

rCirculation Rules

% Ilse Matrix

= Use Loan Period: I: Ev

allow Reguest: W

AV Accession Number:

|
|
Accession Number: I
|
Collection Code: I

Delete | Edit | Refresh | Close |

From the View Holdings Record window by placing a check in the Masked
checkbox:
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W View Holdings Record - phoenix =Joed

Ful | 1tems | MaRc |

Title: Scientific American.

URL: http: {fcdl library. cornell. edufmoa/browse . journals fsca. hitml
URL: http: {www . sdam.com/

Frequency: Monthly, Now. 1921-

Location: Headquarters

Motes: Headquarters retains current year + 1 year.

Acg. Status:

Acg. Method:

Public notes: Test

Retention note:

vol, 298 2008

val, 299 no. 1-vol. 299 no. 4 July 2008-Oct. 2008

--Test
vol, 300 2009
vol, 301 no. 1-vol, 301no. 4 July 2009-Cct. 2009

Request Holdingl Edit | Claims | Add Item | Refresh | Close |

From the Add Purchase Request window by placing a check in the Masked
checkbox:

% Add Purchase Request ﬂ

Requestor Barcode:

*Category:

= Title:

Author: Rejection Reason:

Publisher Name:

Publication Date:

Publication Place:

MNotes:

endor: Music Pub. Num.: I I~ Rush Order

ISBN: |

|
Source of Selection: I
|

(K1 EN KT

*Material: 155N |

Quantity: Il Price: I 5.00

Group Name: IDEfEIJ‘t Group Price Currency  |United States Dollar ~ USD = |

Lol L

Location: I

Fiscal Year: I ;I Fund Account: ;I

Repeat Save Cancel
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From the Import to Purchase Requests window by placing a check in the

Masked checkbox:

W Import To Purchase Requests -... E] Ol

File Name

| =

Character Set
| [~

Add To Purchase Requests if Recard:

[~ Is New. [ Owverwrites Existing Record.
[~ Is Discarded. [~ IsPlaced in Error State.
Vendor:

| [

Category:
| Fiction | ¥ MaskRecords:

Status

0 Teotal Records Found in Source File
0 Failed Validity Checks

0 Database Errors

0 Successfully Imported

Import Cancel
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Permission to View Masked Records

Permission to view Masked Records is enabled in the Virtua Profiler under the
Operational Security tab of the User Permissions.

Modify User Staff User @
IUzer Information  Permizsions lAdd'rtiu:unal Information Autherrticatiu:unr.ﬂ\uthorization]
Circulation | General | OPAC | Profiler | Reports  Operational Security ]State Permissions | L
+ 2SR )

+- ¥ Circulstion Permissions
- ¥] Record Access
Copy Specific Mote Records
v Authority Records
¥ Bibliographic Record
Haldings Recaords
¥] Patron Records
v] ‘Bibliographic Record Masking:
Alter Masking of Bibliographic Records
¥ i WMasked Bibliographic Records
- ] Holdings Record Masking
Alter Masking of Holdings Records
W] “iew WMasked Holdings Records
= ] tem Record Maszking
Alter Masking of kem Records
W] “iew Masked tem Records
W] wiew tems with Masked Statuzes
+ Patron Information
+- ] tem Information .
+-- Wl e Riblinarankic Reeord .v.

e [ [

Disakle Al Enable Al Inkerit Al | Print | Help ‘

Templates | Frirt Save | Cancel ‘

Lazthodified ot 121472010 12:41:39 Ph by Root User
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Display of Masked Records

A user with permission to view masked records will see the following results of a
browse search.

Example: War and Peace is a masked record.

W Browse - Phoenix E] O

Title: War and Peace

Hits | Terms

War and peace [sound recording] / Leo Tolstoy. -
War and peace [videorecording] / produced by Dino de Laurentiis ; directed by King
Vidar,

War and peace.

War and peace [ Leo Tolstoy ; translated by Constance Garnett.

War and peace [Leo Tolstoy ; translated by Louise and Aylmer Maude.

War and peace [ Leo Tolstoy ; translated by Constance Garnett ; introduction by A.N.
Wilsan,

War and peace [Leo Tolstoy ; translated from the Russian by Constance Garnett ;
with an introduction by Joseph Frank ; notes by Lena Lencek.

War and peace [ Leo Tolstoy ; translated from the Russian by Richard Pevear and
Larissa Volokhonsky.

War and peace [sound recording] / by Leo Tolstoy ; [translated by Constance
Garnett].

War and peace [electronic resource] / Leo Tolstoy ; Frederick Davidson,

ki

[y

[

—

[

Title: War and Peace
View | Fage Up | Fage Down | Skip | Delete |

A user without permission to view masked records will see the following results
of a browse search.

W Browse - Phoenix E] [

Title: War and Peace

Hits | Terms

War and peace.

War and peace  Leo Tolstoy ; translated by Constance Garnett.

War and peace [ Leo Tolstoy ; translated by Louise and Aylmer Maude.

War and peace / Leo Tolstoy ; translated by Constance Garnett ; intraduction by A.M.
Wilson.

War and peace / Leo Tolstoy ; translated from the Russian by Constance Garnett ;
with an introduction by Joseph Frank ; notes by Lena Lencek,

War and peace [ Leo Tolstoy ; translated from the Russian by Richard Pevear and
Larissa Yolokhonsky.

War and peace [sound recording] /by Leo Tolstoy ; [translated by Constance
Garnett].

War and peace in the nudear age [ John MNewhouse.

War and peace [electronic resource] : notes ... [ by Marianne Sturman.

o R e

Title: War and Peace
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Using Purchase Request
Management

Recommended
Workflow Explanation
Users may create purchase requests for titles that may
need to be ordered. Adding a title to the purchase
Purchase request list will automatically create a brief
Requests bibliographic record. Titles may be added to a purchase
request list in several ways:
Create a
Selection e Individually by patrons through Chamo
Record e Individually by staff through the Virtua Client
e Batch loading of bibliographic records in the Virtua
Client

Y Summary
Import to e Create a Purchase Request
a e Import to a Purchase Request List

Key Terms

l e Purchase Request
Modify Purchase Request Parameters
Selection e Purchase Request Categories: Allows the user to
List define categories for selections.

e Purchase Request Users Roles: Allows libraries to
define which users are allowed to add titles to which
purchase request list categories. Staff with Reviewer
enabled may modify the status of titles on purchase
request lists.

e Purchase Request Groups: Allows you to define
groups, which are required when placing Purchase
Requests in the Virtua client.
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Adding Titles to a Purchase Request List

From the Acquisitions menu in the Virtua Client, select Purchase Request List.
Select Add. The Add Purchase Request window will appear.

W Virtua - Headquarters - phoenix E]@
File Search Circulation | Acquisiions Cataloging Options Tools Window Help
= T S b =
@O R At leoE AaBE
eceip
Default connection: phoeni¥  nygices Current connection: phoenix - staff

Vouchers
Credits
Reminders. ..

Accounts 3

Claims »

Purchase Request List » Add...

SICI Chedk-In Search Purchase Reguests
EDIFACT Tracker r

Vendor Search

New Vendor...

Search Acquisitions

Transactions 4

From Add Purchase Request window enter the information for a title to be
added to the Request List or drag and drop information from a bibliographic
record into the Add Purchase Request window. If you drag and drop
information from a bibliographic record into a Purchase Request List, the
bibliographic information cannot be modified. Fields annotated with an asterisk
are required.

Note: Category is defined in the Virtua Profiler and categories that appear are
based on the User logged in.

Profiler Tip: The Purchase Request Categories parameter lets your library set
up “categories” for organizing the titles requested for purchase. On the Add
Purchase Request window in the Virtua client, you are required to select a
category from the Categories drop-down list. The categories you define in this
parameter will appear in that list. See Working with the Purchase Request
Parameters: Working with the Purchase Request Categories Parameter in the
Virtua Profiler/Acquisitions Parameters User’s Guide for more information.

Profiler Tip: The Purchase Request List User Roles parameter lets your library
define the roles, or permissions, for each library user for performing operations
on the Purchase Request Management window, which contains a list of titles
requested for purchase. See Working with the Purchase Request Parameters:
Working with the Purchase Request List User Roles Parameter in the Virtua
Profiler/Acquisitions Parameters User’s Guide for more information.

Profiler Tip: The Purchase Request Groups parameter lets your library define
request groups, which may be designated global or not global, in which case the
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group must be associated with a location. You can define multiple purchase
request groups for a single location or an institution. The request groups you
define here will populate the Group Name drop-down list on the Add Purchase
Request window and will be available as filters on the Purchase Request
Search window in the Virtua client. See Working with the Purchase Request
Parameters: Working with the Purchase Request Groups Parameter in the Virtua
Profiler/Acquisitions Parameters User’s Guide for more information.

W Add Purchase Request

Reguestor Barcode: |
* Category: | j
*Title: |
Auther: | Rejection Reason:
Publisher Name: |
Publication Date: |
Publication Place: |
MNotes:
Vendor: | j Music Pub, Mum.: | [~ Rush Order
Source of Selection: | j ISBMN: |
* Material: | ~| s |
Quantity: |1 Price: | $.00
Group Name: |Defau|t Group ﬂ Price Currency  |United States Dollar ~ USD = |
Location: | j

Fiscal Year: | j Fund Account: J
[~ Masked

Repeat | Save | Cancel |

Click the Repeat button to add another title to the purchase request management
list.

Click the Save button to save the record and exit the Purchase Request

window.

Purchase Requests Via Chamo
To request that the library purchase an item via Chamo:

Select the Request for Purchase link.
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Reserves Search Search History Request For Purchase Clear Session

Search Advanced Search Search Other Content

Click the Library policy regarding purchase requests link. Read the policy
and select the checkbox to indicate acceptance of the policy.

Request for purchase

Library policy regarding purchase requests

[]1 understand and will comply with the library policies regarding purchase requests.

Edit as many fields as possible on the Request for Purchase screen. The fields
marked with an asterisk (*) are required fields. The Notes field should contain
the reason for requesting the title.

Click the Submit button.
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Request for purchase
Library policy regarding purchase requests
D I understand and will compdy with the library polioes regardng purchase requests.

futhor

Tithe*

Material Type®

Choose One |8

Flace al Publication

Fear al Publicalion

Fublisher Nams

Muasic Publication Mumbar

Most Frequently Visited Branch®

Chaose One ]

Where dud yvou learn of this item?
Choose One (s

Your Contact Information

Tithe (Hr., Ms., Miss, etc.)

Telephone Humber

E-mail Address

[ Please notify me by e-mail if this item is purchased

Submit | Reset |

Acquisitions Workflow-Based Reference Guide Last Revised: October 2017
*Updated to 16.1



122

Purchase Requests Via iPortal
To request that the library purchase an item via iPortal:

The Purchase Request feature lets patrons submit a purchase request for a title.
You can access the Purchase Request screen two different ways, depending on
how the interface is configured. Note: Access to the Purchase Request screen
may be password protected.

To access the Purchase Request screen:

Click an “Ask the library to add a book” link, which may appear on any screen.
-OR-

Click a “Purchase Request” button on the Full Record screen.

The Purchase Request screen appears.

Title:
=
=
Author:
ISBM:
| =
Publisher Mame:
-]
=
Motes:
]
=l
Material: Category:
| Book ;l |Adventure ;]
Resetl Close Window |

After you complete the fields on the form and submit it, a confirmation message
or
error message will appear on a result screen.

Reviewing Request Lists

To review the Request List, select Acquisitions > Purchase Request List > Search
Purchase Requests. The Purchase Request Search window will open.
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W Virtua - Headquarters - phoenix [__“E]H

File Search Circulation | Acquisiions Cataloging Options Tools Window Help

|20 | @ i@ |p Orde sk |lecE BB

Receipts

Vouchers
Credits
Reminders, ..

b

Default connection: phoeni¥  nygices » Current connection: phoenix - staff
b
»

Accounts 4
Claims k
Purchase Reguest List » Add...

SICI Check-In Search Purchase Requests
EDIFACT Tradker

Vendor Search

Mew Vendor...

Search Acquisitions
Transactions 3

From the Purchase Request Search window, perform a search using any of the
search fields or a combination of them. The Purchase Request Management
window will then display.

¥ Purchase Request Search - phoenix [._] [} E
Title: 1T Use Accounts
Fiscal Year: I j
Author:
Account: -
Publisher: I _I
ISEN: Date Range

ISSN:

[~ End Date | =]

Music Publication Number:

Requestor Barcode:

Place of Publication:

|
|
|
|
I [~ StartDate I vl
|
|
|
|

Publication Date:

[ Quantity I LI I
™ Location [~ Material Type
™ vendor [ Staff Requestor

|l Reguest Status [~ Purchase Request Group

I™ category [~ Source of Selection:

el Bl Bisl @i

pEl Bzl Biml B

I~ Indude non-purchase request bibliographic records Search I Clear | Cancel

From the Purchase Request Management window you can click on a column
heading to sort by that column.

Acquisitions Workflow-Based Reference Guide Last Revised: October 2017
*Updated to 16.1



124

T e
M

Cateqgor: Title: Authar ik Requestor Status Publisher Yendar Group Mame Pub. Place Pub. Year TSBM/TSSM Request Date | Motes
Fiction Precious @ anov,.. MNovack, Sa.. 1 staff Review Random Ho. .. Default Group  Mew Vork : 2009, 9FE1400066... 12/23(2010..,
Fiction The lovely bone...  Sebold, Alice 1 staff Review Back Bay Bo... Default Group MewYork: 2007, c2002.  9780316001... 12/23/2010...
Dotz | add | Uptete | Creatcorer | pefresh | e |

Staff with permission to review request lists can modify the status of an item on
the list. Select a title and right mouse click to change the status of a title.

Click the Add button to add additional titles to the request list. The Add
Purchase Request window will appear.

A .. Ppin G B,
Akl . Puit St e

Tt [
dthon: | Reje:ben Beawr:
Fubhihar hisras: |
Fubdcabon Dale: |
Fubdator e |

i
L

Versdar: «|  wmcrm om0 [ GushOrde
Sourcm of talecsar: | e —

= pabaria - j=- 8 I—

bty 1 Prea: [ sm

Locater: =

e Aedacmnt [ ]

™ Mmsond

Acquisitions Workflow-Based Reference Guide Last Revised: October 2017
*Updated to 16.1



125

Use the Repeat button to enter another title. Use the Save button to add the last
title and exit the Add Purchase Request window.

Once you have added all necessary titles, click the Refresh button to display the
titles in the Purchase Request Management window.

To Update titles from the Purchase Request Management window, select the
title, or use the control or Shift keys to select multiple titles, and then click the
Update button. The Update Purchase Request window appears. Some fields
will be grayed out, as they cannot be modified. Make the needed changes to the
record and then click Save. The record is updated.

W Purchase Request Management - phoenix [Z]@
Category | Title ‘ Author | Qty ‘ Requestor | Status ‘ Publisher | ven... | Group Name | Pub. Place ‘ Pub. Year | ISBM/ISSN | Request Date | Currency | Notes |
Adult ... Patti Smith: Ca...  Patti Smith 1 staff Review Default Group 1/5/20129... USD
Adult... Patti Smith: Ca... PattiSmith 1 staff Rejected Hope Mills 1/5/20129... USD
Delete Add Update Create Order Refresh Close
Acquisitions Workflow-Based Reference Guide Last Revised: October 2017

*Updated to 16.1




126

W Update Purchase Request
Date Created: 1/5/2012 9:40:52 AM Date Modified: 1/5/2012 9:42:27 AM
Requestor Barcode: I Requestor:
Staff Creator: staff

* Category: |Adult Literature =
*Title: |Patti Smith: Camera Solo Status: Review =]
Author: I':'ﬂt'j Smith Rejection Reason:
Publisher Name: I
Publication Date: I
Publication Place: I
Motes:
Vendor: I j Music Pub, Num.: I [~ Rush Order
Source of Selection: IReader's suggestion j ISBN: I
*Material: Bocks | mssw |
Quantity: |1 Price: I S.00
Group Mame: IDEfEIU|t Group j Price Currency  |United States Dollar  USD = |
Location: I LI

Fiscal Year: I j Fund Account: I ﬂ
[~ Masked [~ E-mail [~ Hold

Copy Repeat | Save | Cancel

To create a duplicate of the purchase request, on the Update Purchase Request
window click the Copy button. The Copy button opens a new Add Purchase
Request window that is pre-populated with non-editable information from the
current Purchase Request.
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W Add Purchase Request

Requestor Barcode: |
*Category: |Adult Literature j
*Title: |Patti Smith: Camera solo
Author: |F'E'tti Smith Rejection Reason:
Publisher Name: |
Publication Date: |
Publication Place: |
Motes:
Vendor: | j Music Pub. Num.: | [~ Rush Order
Source of Selection:  |Reader's suggestion ~| =B [
*Material: |pocks . |
Quantity: |1 Price: | $.00
Group Name: [pefauit Group | Pricecurrency [Umited States Dollar UsD =
Location: | j

Fiscal Year: | j Fund Account: J
[ Masked

Save | Cancel |

To Delete titles from the Purchase Request Management window, select the
title, or use the control or Shift keys to select multiple titles, then click the Delete
button. You will be prompted with a warning message asking, “"Delete associated
bibliographic record and any other associated purchase requests?” If you select
“Yes”, the title will be deleted from the Purchase Request Management list and the
associated bibliographic MARC record will be deleted as well. If you select "No”,
the title will be deleted from the Purchase Request Management list, but the
associated bibliographic MARC record will not be deleted. If you select “Cancel”,
neither the title not the bibliographic MARC record will be deleted.

Creating Purchase Orders from Purchase Request Lists

Staff with permission to create purchase orders may select items from the
Purchase Request Management window and create a purchase order.

To create a purchase order from the Purchase Request Management window,
select the title, or use the control or Shift keys to select multiple titles.

Note: The titles must have a status of Approved before you can create an order.
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W Purchase Request Management - Phoenix99 g@
Category | Title | authar | ory | Requestar Status Publisher Vendor Group Mame | Pub. Place | Pub. Year | ISBM[ISSM | Request Date | Notes [
Fiction The lovely bone... _Sebold, dlice 1 staff Approved Back Bay Ba... Default Group Mew York: 2007, c7002,  9780316001... 12/23/2010,.,

Fiction The bind side i 1v.. - Lewis, Ficheys 1 B ‘pproved ., flarton BiefaulE Group  Hew York s Ly, c200e, S7E03EA06 1, 12(3502010 ;s
Fiction Cinderella mant... 1 stait Rejected Universal Fic. . Default Group  [Universal Ci... 2005, EIA1701E... 12232010 ...
Dot | add | uptee | ceseorder | mefreh | dose |

Click the Create Order button. The Add PO Request window will appear.

W Add PO Request BE x|

Crder Prefix: | ------- ﬂ

Cirder Mumber: ||

Qrder Type:

|Mnnogra|:|h ﬂ
Payment Tyvpe:

|5tandard ﬂ
Yendor:

|, PRUTTT ~|

[~ Exchange Order

Retrigve | Cancel |

Enter a purchase order number or click the Retrieve button to have Virtua
automatically assign the next purchase order number.

The Add Order window will open with the Line Item window populated with the
titles from the purchase request list.
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W Add Order {_][g]i;f

COrder Mumber: 6294 Order Type: Monograph
Vendor: a.6, PRUITT Payment Type: Standard
Exchange Order: 'l

Crder Header Information |Eii||ing | Shipping Information |

Status: Approved Tokal: $.00
Crder Dake: |12,|'23,|'2010 ;I Currency Type: |United States Dollar 1sD ;I
Print File: Iengmonprintpo.utF ;l
rLine Ikem
Tumber | ‘endor Title 1D Skatus | Title | Price | Cuankit | Total |
1 Approved The lovely bones | alice Sebaold, § .00 1 $.00
2 Approved The blind side : evalution of a game | Michael § .00 1 $.00
Lewis,

Create Brief Bib | Copy Item | Insert Tkem | Delete Tkem | Edit Ttem |

—When Saving. ..
" Exit This Window {~ Repeat This Function " Immediately Proceed To Invoices {* Immediately Proceed To Receipts

[~ Rush Order [~ Auto Receive Motes | (laims | Save I Cancel |
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Managing Order Receipts

Recommended Explanation
Workflow
A receipt records the arrival of ordered material and is attached
Obtain the to a purchase order. The Receipts function lets you add, save,
PO Number view, update, and delete receipts that are directly related to one
purchase order. This lesson covers creating and modifying
receipts.
E;ecaetigtthe Virtua provides three ways to receive items:
e A receipt window to receive shipments that are partial or not
received when ordering
e An Auto Receive button on the Purchase order window that is
Receive normally used with Approval plans or monographic sets but
Items can be used with monograph and serials orders as well. This
will receive satisfactorily all items on the purchase Order.

v e An “Immediately Proceed to Invoices” option when saving a
Save Purchase order. This will receive satisfactorily all items on the
Receipt purchase Order.

Note: Virtua also supports repetitive and integrated workflows
for those staff members who perform only one step repeatedly
Summary
e Create a Receipt
Auto. e Receive line items individually
Receive e Receive line items using Express Receive
e Receive line items using the Expand feature
e Replacement Notices
e Modify a Receipt
e Delete a Receipt
Proceed to e Save Receipt
Invoices e Create item records upon receipt
e Understand Repetitive Workflows
Key Terms
e Expand
e Express Receive
e New Book List
e Receipt
e Statuses Tab
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Introduction (cont.)

Profiler Parameters
Condition Codes: Specifies the different types of conditions in
which material is received.

Item Creation Flag: Controls whether an item record will be
created upon receipt of the item.
InfoStation Reports

New Books List: Generates a list of records added to the New
Books List during a specified date range or if no date range is
specified, records on the New Books List at the time you run the
report.

Items Received by Month: Generates a count and calculation
of all items received through the Acquisitions subsystem in the
specified date range.

Received Items List: Generates a list of all items received
through the Acquisitions subsystem that fall within the specified
date range.
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Obtain the Purchase Order Number

You must have the PO number in order to receive items associated with the
purchase order.

If you do not know the PO number, perform an OPAC search for one of the items
in the order.

Click the Statuses tab of the View Bibliographic Record window.

Note: After a purchase order is saved, a Statuses tab appears in the View
Bibliographic Record window for each bibliographic record with ordering
information. This Statuses tab shows all acquisitions activity as the order moves
through the acquisitions cycle.

Look for the Purchase Order number in the Order ID of the Order Status
Information box.

W View Bibliographic Record - phoenix g@
VR

Full

Order ID/Line Pairs: Receipt Status Information: Payment Status Information:

Bo14-1 ~| | status:

Quantity:
Order Status Information: Condition:
Crder ID: 6014 Date:
COrder Type: Manograph
Add/Update
Payment Type: Standard fUpda | | JJ 4 JJ
Line Mumber: 1 ; . : )
order Siates Drdered Invoice Status Information: Credit Status Information:
Quantity: 1
Location: Headquarters Library /Technic
Vendor: A.B. PRUITT
Price: $12.00
Date: 5/4/2010
Update | View | | | | | AI
[~ Masked Agency Req ‘ ‘ Edit ‘ Request Bib | Add Item | Refresh | Close ‘

Note: The Status information is stored for each specific line item. In the Order
ID/Line Pairs list box, the user can see the order ID and which line item this
status display is for. If multiple orders exist for this title; there will be more than
one Order ID/Line pairs in the dropdown menu.

If you wish to receive only this title, click on the Add/Update button. The
Receipt window will open with the title listed.
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e If you wish to receive multiple titles associated with this purchase order, note
the purchase order number and then select Add/Update Receipt from the
Virtua Acquisitions menu.

Add Receipt

Click on the icon or select Acquisitions > Receipts > Add/Update
Receipts from the Virtua main menu to receive items associated with a purchase
order. The Add/Update Receipts Request window will appear.

\F Add/Update Receipts . =) O3
Order Mo:

Request | Cancel |

From the Add/Update Receipts window, enter the purchase order number. The
Receipts window will appear with the line items linked to the purchase order ID
entered.

Note: If you get an error when you enter the order ID, this means the purchase
order has not yet been set to Approved or transmitted. You must open the PO,
set all line items to approved, save, and send the order before you can receive
items.

Y receps s ooy D e

PQ Number: 24964
Vendor: Whitehots
PO Line Items:
Line | Notes | Vendor Title ID | STD Mo, | Title | Location | Ordered | Received | PO Line Status | Condition |

i1 9058230813  The mutable brain : dynamic and Harris Medical Library 3 Ordered o
plastic features of the developing

and mature brain [ edited by Joh H.

Kaas.

View Motes | Item Reminder | Expand | |
When Closing...
{(+ Exit This Window (" Repeat This Function (" Immediately Proceed To Invoices
Print all | | Reminders | 0K | Cancel |
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The PO Line Items Area of the Reciepts Window

e Line: Line number from the purchase order
Notes: Asterisk will display to alert user that a note is attached to a line item.
This is not the same as a receipt note in the vendor record.

e Vendor Title ID: Optional ID number entered in the purchase order, normally a
ID number that the vendor has assigned to the particular item. This can be a
catalog number, vendor item number, etc.

e STD No: Optional field for a standard number; this will be the ISSN in the 022
tag, the Publisher Number or Music Number from the 028 tag, or the value of
the 024 tag when the first indicator is 0, 1, 2, 7, or 8. When none of these
numbers are present, this field is blank.

e Title: Title of the line item ordered. If the Bibliograhic record does not contain
title informaiton, the software displays No Title Available.

e Location: Location for which the item/issue was ordered. If multiple copies
were ordered for multiple locations, each location appears on a separate line.

e Ordered: Number of copies ordered as indicated on the purchase order. Only
those items from the purchase order that qualify for receiving appear.

¢ Received: Number of copies received to date.

e PO Line Status: Status of the line item on the purchase order.

¢ Condition: Show the receipt conditions for each copy of a line item.

Profiler Tip: The Condition Codes parameter lets you define the different types
of conditions in which material is received. The codes that you define in this
parameter appear in the Virtua client in the drop-down list of Conditions in the
Edit Receipt Information dialog box, allowing you to assign a receipt condition
to a purchase order line item. See Working with Acquisitions Codes: Working
with Condition Codes in the Virtua Profiler/Acquisitions Parameters User’s Guide
for more information.

Command Buttons

Item Level Buttons

¢ Item Reminder: Displays reminders associated with an item.
e Expand: Displays all reciept information for a purchase order line item.
e Express Receive: Allows you to receive multiple line items simultaneously.

Receipt Level Buttons

Print All: Prints receipt slips for all received copies. (Receipt must be saved.)
View PO Notes: Is active only if the Purchase Order note is a priority note.
Reminders: Displays the Reminders window for receipt record as a whole.
Save: Saves the receipts information to the database.

Cancel: Cancels any data entries and closes the receipts window.
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Receive Items

Virtua provides two ways of receiving items:

Express Receive: Receive multiple items simultaneously using default statuses

set in the Profiler.

Expand: Receive line item with more than one status or condition (e.g. multiple
copies of an item in which one was damaged in shipping.

Express Receive

To receive more than one line item at a time, use Express Receive. All line
items on an order can be received at once, or just a few.

Multi-select all line items by clicking and dragging or by holding down the control

key, and clicking on each item.

Click on Express Receive. Virtua sets the receipt status and condition of the
item to the defaults set in the Profiler (usually Received Satisfactory and Correct

Item).

Expand

Sometimes multiple copies are ordered as one line item. If all copies are not
received, or if a copy is damaged, the Expand button can be used to record

receipts at the individual item level.

Highlight the line item and click Expand. The Line Item Receipt Information

window will appear.

W Line [tem Receipt Information - phoenix g@
Line Information l
PO Number: 6531 Quantity Ordered: 1
PO Line Number: il Quantity Received: 0
Title: The old man and the sea / Ernest Hemingway. Quantity Returned: 0
Quantity Expected: 1
Received Copies:
Print Replace Print Return P... | MBL | Received | Receipt Date | Condition | Status | Orde... | Print File
- (I l_ ] 1 3f6/2012 Correct Item Received Satisfactory 1

Note: The Notes button is disabled until the selected item has been received or

partially received.
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Edit the quantity received, the condition, status, etc. directly on the Line Item
Receipt Information window.

If an item should appear on the New Books List report, click to place a check mark
in the associated box.

If desired, you can print a receipt for each line item when you save a receipt.
Select the check box Print Receipt Slip When Saved. This is a persistent setting.

Specify a print file to be used for printing the receipt in the Print File column.
Specify a location in the Location column.

Note: If you have Allow Ordering for Multiple Locations enabled in the Virtua
Profiler and the order contains lines that were ordered for multiple locations, each

location will have a separate line in the receipt. Enter in the receipt information
for each location that ordered copies.

W Line Item Receipt Information - Venus88 EI@
Line Information 1 Enriched Data
PO Mumber: 1275 Quantity Ordered: 7
PO Line Number: 1 Quantity Received: [v]
Title: A new and complete concordance or verbal index to words, phrases, and - Quantity Returned: a
passages in the dramatic works of Shakespeare, with a supplementary il Quantity Expected: 7
Received Copies:

Print Replace Print Return P... |NBL | Received | Receipt Date | Condition Status | Orde... | Ship to Address Location Print File

r ]— r 7 0 7{27{2011 CorrectItem  Received 5... 2 HK Central Hong Kong Central ...

(I r (N " 0 Tf27f2011 CorrectItem  Received 5., 5 ACQ Group Aberdeen (501000...

Notes | Add | Delete |
Save Cancel |

Specify an address the material should be shipped to in the Ship to Address
column.

Profiler Tip: The Acquisitions Addresses parameter deals with acquisitions
address records and works in conjunction with the flag for filtering by log-in
location. This parameter controls the linking of specific addresses to one or more
location names for the purposes of billing and shipping purchase orders. See
Working with the Acquisitions Addresses Parameter in the Virtua
Profiler/Acquisitions Parameters User’s Guide for more information.

Specify whether or not you wish to print a replacement notice by checking the
Replace Print checkbox. This will print a replacement notice when you save the
receipt using the customizable template replacementnotice.utf.

Specify whether or not a return notice should be printed upon saving the receipt
by checking the Return Print checkbox. This will print a return notice when the
receipt is saved, using the customizable template returnnotice.utf.
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All editing functions can be performed on the Line Item Receipt Information
window. To edit information, click in the column of data that you wish to change,
modify the information for each copy and/or condition, and click Save to add the
information.

W Line ltem Receipt Information - phoenix g@
Line Information l
PO Number: 6532 Quantity Ordered: 1
PO Line Mumber: 1 Quantity Received: 0
Title: The torrents of spring; @ romantic novel in honor of the passing of a ~ Quantity Returned: 0
greatrace. — Quantity Expected: 1
Received Copies:
Print Replace Print  Return P... |NBL | Received | Receipt Date | Condition | Status | Orde... | Print File
(] r r W1 3/6/2012 |pamaged Ttem _v| Returned 1
Correct Item
Damaged Item
Duplicate
Other Problem
Test
Wrong Edition
Wrong Title
Wrong Yolume Tssue
MNotes | Add | Delete |
Save | Cancel |

Note: You can set the Invoice Line Item Display in the Profiler to display only
received purchase order line items on the Add Invoice window.

Request for Replacement Notices

When an unacceptable item is received from a vendor, you can print a Request
for Replacement notice via the Replace Print check box or a Return of Item
notice via the Return Print check box on the Line Item Receipt Information
window.

Note: Virtua prints the notices using the customizable replacementnotice.utf
and returnnotice.utf as appropriate.

Select either the Return Print or Replacement Print check box.

Acquisitions Workflow-Based Reference Guide Last Revised: October 2017
*Updated to 16.1



138

%/ Line Item Receipt Information - phoenix

B[=1%)

Line Information |

PO Mumber: 6532 Quantity Ordered: i
PO Line Number: i Quantity Received: 1]
Title: The torrents of spring; & romantic novel in honor of the passing of a Quantity Returned: 0
greatrace. Quantity Expected: 1

Received Copies:

Print | Replace Print ReturnP... |MBL | Received | ReceiptDate | Condition | status | orde... | PrintFile

O O 1 3fef2012 Damaged Item | i1

Motes | Add | Delete |

Save I Cancel |

To specify the return reason or request for replacement reason, use the

Acquisitions Notes feature.

Click Notes to open the Acquisitions Notes window.

¥ Acquisitions Notes - phoenix
r—Family Priority Motes:
Date | Mote Type | Motes Text
—Motes:
Priority | Date | Motes Text
Add eat |
Save |

Click Add to open the Edit Note window.
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W Edit Note - phoenix

Mote Text:

[ Priority Mote

[ Transmit To Vendaor

Save Cancel

Note: A Transmit to Vendor check box is available on the Edit Note window as
long as either the Replace Print check box or Return Print check box is
selected AND the status is Returned or Returned and Requested Replacement on
the Line Item Receipt Information window.

Type note and click Save.

The note is added to the Acquisitions Notes window.

[ S
W Acquisitions Motes - phoenix E]@
Family Priarity Motes:
Date | Mote Type | Motes Text |
Motes:
Priarity | Date | Motes Text | Transmit
372012 Damaged item; returned to vendor immediately, NO

Edit ‘ Delete ‘

Save | Cancel |

Click Save.

The Notes button on the window has an asterisk to indicate an acquisitions note.
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W/ Line Item Receipt Information - phoenix

==

Line Information |

6532
i

PO Number:
PO Line Number:

Quantity Ordered:
Quantity Received:

The torrents of spring; a romantic novel in honor of the passing of a

Quantity Returned:

H O O

O O 1

Tithe: [1]
greatrace. M Quantity Expected:
Received Copies:
Print | Replace Print ReturnP... | NBL | Received | ReceiptDate | Condition | Status | orde... | PrintFile
3fef2012 Damaged Item Returned i

add | peke |

Save | Cancel |

Click in the Print File column and select
then click Save.

A confirmation displays:

«

The receipts have been updated.

-

Information

S

a print file type (ex. Returnnotice.utf);

The Print window opens. Select a printing format and click OK.

-

Print - phoenix

-,

2

Printing

IRf:placanmt Motice ;I

Farmat:

[~ Print In Background

—Range opies
Al
* Selected Records

) Selected with Chid Records

Mumber of copies:

—

Printer Setup |

Save Receipt

The receipt is attached to the purchase order. If the purchase order is only
partially received, additional items may be received at a later date.
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Complete receipt information for all received titles.
Click on Save to save the receipt.

As with purchase orders, Receipts has three options when saving in order to
support repetitive and integrated workflows. If your library assigns a staff
member to perform only one step repeatedly in the receipts process, Virtua can
accommodate your setup. These workflows expedite the acquisitions process by
eliminating the need to re-key data from one stage to another and by providing a
way to skip the receipt stage altogether.

You have three choices upon saving a receipt:

Exit This Window: Saved the receipt and closes the Add Order window.
Repeat This Function: Saves the receipt and displays the Receipts Request
dialog box, allowing you to retrieve another Purchase Order for receiving.
Immediately Proceed To Invoices: Saves the receipt and opens the Invoice
window.

Note: The option you choose will be used in future receipt functions until you
change it.

Note: If the Alert if Number of Copies Received Does Not Equal Number of
Copies Ordered flag in Acquisitions Basic Options in the Profiler is enabled, if
the number of copies received does not equal the number of copies ordered, an
alert message will appear upon saving the receipt.

Automatic Creation of Item Records

You can set an option in the Virtua Profiler to automatically create items records
attached to bibliographic or holdings records when receiving items. The default
settings for item creation are taken from the default Loan Period, Item Class, and
Loan rules set on the Virtua Profiler Main Location window.

Profiler Tip: Using the Location Names parameter, you can set the Create
Received Items flag for each main location. The setting you choose for a main
location is used by all its sublocations. The Create Received Items flag lets you
specify whether item records should be created automatically for purchase order
line items that are received for a given location. See Setting up Locations:
Configuring Settings for Library Locations: Setting the Create Received Items
Flag in the Virtua Profiler/Global Settings User’s Guide for more information.

To create an item record, the Location field on the Line Item Header
Information tab of the Order Line Editor window, must have been set to the
location (or a sub-location of that location) that you enabled in the Virtua Profiler
for item creation.
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W7 Order Line Editor - phoenix ﬁ]
Order Info/Distribution | Bibkographic Information |
The Mack Adams stories, Pref, by Philp Young.
Line Item Header Information | Locations | Account Information |
Unit Price: | §15.00 Subject Code: Rr =]
Copies: | Status: [Aporaved =
Total Price: #1500 Shipping Sent To: |Hesdquaners LibraryTechnical S= » |
Due Date: | spzsp2012 - Location: |Hesdauzners |
Collecton Code: | ] Source of Selection: [ |
Material: — -] Surcharge Amount: | 5.00
Discount Amount: | $.00 Music Number |
Vendor Tle ID: |
Requestor Barcade: |
Notes | | sve | cacel |

Set the receipt status to "Received Satisfactorily" or "Accepted As Duplicate". Any
other status will not create items.

Profiler Tip: Receipt Statuses determine which statuses appear in the drop-
down list of statuses available in the Edit Receipt Information dialog box in the
Virtua client. See Working with Acquisitions Statuses: About Receipt Statuses in
the Virtua Profiler/Acquisitions Parameters User’s Guide for more information.

After saving the receipt, navigate to the View Record window. The item will be
attached to the bib record (or holdings record if it was a serial order).
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W Item Information - phoenix g [ ﬁ

Item Elements | Notes | Statistics | Status | Acquisitions | Other Blements
rBibliographic Information

Authar: Hemingway, Ernest, 1899-1961,
Title: The Mick Adams stories. Pref. by Philip Young.
Publisher: Mew York, Scribner [1972]
—Item Infarmation —Call Mumber
Item ID: 1121495 Copy: I
Barcode: I Call #: I
Barcode Type: IF'-EEIU|EI' j 2nd Call #: I
Item Class: IBUUk ;I
nits
Reserves Item Class: I ¢ Free Text
Ttem URL: I = Enumeration and Chronology
% MNone
Location: IHeadquarters ;I
| Edit |
Shelving Location: IHeadquarters ;I

1 Preservation and Conservation

Code: -
Mumber of Pieces: |1 vﬂ Circulate Pieces: I I —I

Price: £.00 T Non-Parameterized Shelf Location

Location: I j

EPM Mumber:

—Circulation Rules

i+ |se Matrix

{~ Use Loan Period: I? 3"

Allow Request: v

AV Accession Mumber:

|
|
Accession Mumber: I
|
|

Bl

Collection Code:

[~ Masked Delete | Save I Refresh | Close |

Edit the Item Record to add Barcode, Copy number and Item price information.
Also notice that the Acquisitions tab of the Item Record is now updated.

Hint: The Original Purchase Price field will be populated by default with
information from the Invoice Unit Price.
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?W Item Information - Virtua Home Lﬂiﬁq‘ L= e

Item Elements | Statistics | I Other Elements |
~Bibliographic Information
Title: Time; the weekly news-magazine.
Series: Current periodical series.
Description: v. ill. incl. ports.) 28 cm.
—Acquisitions Information
Purchase Order Id: |525 PO Line Number: |1
Receipt Date: [V Use Date: |10,’ 13/2014 ~ l Invoice Unit Price: $3.00
Invoice Number: |525 Invoice Unit Discount:
Invoice Currency: |United States Dollar  USD _-|  Invoice Unit Fee:
Vendor: Ebsco
Original Purchase Price: [V | $3.00  [United StatesD... USD _- |
Invoice Line Fee(s): Fee | Amount |
Binding Cost: Depreciation Rate (Per Year) : 10%
Lamination Cost: Maximum Depredation: S0%
Surcharge: s.15 Reader Suggestion Status:
Reason For Recommendation:
P
Additional Remarks:
-~

[~ Masked Delete Edit Refresh Close

Note: The ability to view the Acquisitions tab of the Item Record is
permission-based.
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Update Receipts

Select Acquisitions - Receipt > Add/Update. The Add/Update Receipt Request
window appears.

7 Add/Update Receipts ... |= ) OB |
Order No:

Reguest | Cancel |

Note: If an order has been received, the software will not stop the user from
receiving the order again.

Enter the Order number.

Tip: If you do not know the order number search the OPAC for one of the items
and look at the Statuses tab.

Click the Request button. The Receipt window appears.

W Receipts - phoenix E]@
PC Mumber: 6555
Vendor: O'Connell Publishing
PO Line Items:
Line | N. | Vendor Tit... | Title | Location Orde... | Recei... | PO Line Status Condition
1 A farewell to arms | Ernest Headguarters 1 0 Ordered
Hemingway. Library/Technical
Services
2 The Mick Adams stories. Pref.  |Headguarters 1 0 COrdered
by Philip Young. Library fTechnical
Services
| Item Reminder | Expand | Express Receive
When Saving...
{* Exit This Window (™ Repeat This Function ™ Immediately Proceed To Invoices
‘ Reminders ‘ oK |

Highlight the line item and click on the Expand button. The Line Item Receipt
Information window appears. From this window you may receive, edit or delete
copies of the item.
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W Line Item Receipt Information - phoenix E]@

Line Information l

PO Mumber: 6555 Quantity Ordered: 1
PO Line Mumber: 2 Quantity Received: 0
Title: The Nick Adams stories, Pref, by Philip Young. Quantity Returned: 0
Quantity Expected: 1
Received Copies:
Print Replace Print  Return P... | MBL | Received | Receipt Date | Condition | Status | Orde... | Print File
[ l_ (| [+ 1 3142012 Correct Item Received Satisfactory 1
Notes Add Delete |

Cancel |

Edit information about the copies received.

Modify the information and click Save. The window closes and the Line Item
Receipt Information window becomes active.

W Line Item Receipt Information - phoenix E]@

Line Information l

PO Mumber: 6555 Quantity Ordered: 1
PO Line Mumber: 2 Quantity Received: 1
Title: The Nick Adams stories. Pref. by Philip Young. Quantity Returned: 0

Quantity Expected: a

Received Copies:

Print Replace Print  Return P... | MEL | Received | Receipt Date | Condition | Status | Orde... | Print File
l_ l_ (| [+ 1 3/14f2012 Wrong Edition Received Satisfactory 1
MNotes Add Delete |

Cancel |

If you need to delete a received item, highlight the item and click on the delete
key. The software does not ask for confirmation.

Note: This does not delete the item from the purchase order; it updates the
quantity expected and received to show the item as not received.

Click Save on the Line Item Receipt Information window. The window closes,
and the Receipts window become active.

Click Save to save the receipt. The software will respond: The receipts have been
updated.
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Invoice Management

Recommended Explanation
Workflow
The invoicing function is used to record invoices as they
Add are received from a vendor. Multiple purchases orders
Invoice may be attached to one invoice provided they are from
the same vendor.
I Virtua allows users to modify invoices prior to creating
nsert . . . .
Invoice vouchers. A user typically needs to modify the invoice for
two reasons:
e To add additional invoice items
e To delete invoice items
Edit Invoice
Line Items Users with appropriate permissions can perform invoice
transactions such as adding, updating, viewing, or
deleting invoices.
Save . L
Invoice Once an invoice is created and saved, you can update
various aspects of the record until the invoice is paid or
partially paid.
l Summary
e Create an invoice
Delete e Attach purchase order(s) to an invoice
Invoices & e Edit Invoice Line Items
Line ITtems e Apply Fees and/or Taxes
e Save Invoice
Key Terms
e Fees
e Invoice
e Invoice Fees
e Invoice Status
e Line Fees
e Price Variance Threshold
e Supplemental Invoice
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Currency Rule
e The currency chosen at the time of invoice may be
different from the currency used for the purchase
order.
e The currency chosen for the invoice must be the same
as for the voucher payment
e Fluctuations in currency exchange rate values are not
dynamically updated. Libraries are responsible for
updating currency exchange rates in accordance to
their established policies.
Profiler Parameters
Invoice Line Item Fees: Allows you to set types of
fees that apply to specific line items on an invoice.

Invoice Header Fees: Allows you to set types of fees:
to apply to the invoice as a whole; specify the
account to which you want the fees charged; specify
a fiscal year of the account to be charged; specify a
default fee.

Taxes: Allows you to define different types of taxes
that you want to make available in the Virtua Client.

SAP Codes: Allows you to define three sets of codes
and code descriptions, one set each for invoices,
payment vouchers, and credit memos. The codes
appear in the SAP drop-down lists on the Invoice-
Select Invoices for Payment window.

Invoice Price Variance Threshold: Allows you to: set
a threshold to indicate the amount that the unit
price of an invoice line item can exceed the price of
the line item on the purchase order; choose whether
the system notifies the user if a threshold
percentage is exceeded; choose whether the user
can decide to continue with the addition or
modification of the unit price of the invoice line item
even through the threshold percentage is exceeded.

Statuses (Invoices): Determines the statuses
associated with Acquisitions records at the Invoice
stage.

Payment Methods: Allows you to define the methods
for paying an invoice, which appear in the Method of
Payment drop-down list on the Invoice window in
the Virtua client.

Invoice Line Item Display: Allows you to determine
if ALL purchase order line items will be displayed on
the Add Invoice window or only RECEIVED purchase
order line items.
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Add Invoice

Select Acquisitions 2> Invoices > Add or Click on the Invoice icon on the
Acquisitions toolbar to add an invoice. The Add Invoice window appears.

P T

Add Invoice Request
Invaice:

|

Vendar:

|A.B. PRULTT =]

Invoice Location:

|Headquarters ﬂ

Purchase Qrder ID:

Reguest Cancel |

Note: Virtua locks the invoice record and the associated purchase order when an
invoice is being updated or deleted. If you try to access a record that is being
updated or deleted, you will only be permitted to view it, not edit it.

Enter an Invoice number (may be up to 35 characters, alphanumeric and case-
sensitive).

Select a Vendor from the drop-down menu.
Enter a Purchase Order ID. Optional.

If you enter a purchase order number, the line items will appear in the Add
Invoice window.

If you do not enter a purchase order number, you will have to insert the line
items from the Add Invoice Line Items window.

Note: It is possible to add the same invoice humber from a paper copy. If you
have received a paper copy, just enter the same invoice number so it will link to
packing lists and payments. If you do not have a pre-invoice, then enter any
invoice number.

Click the Request button. The Add Invoice window appears.
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W Add Invoice Request

Primary Invoice Information
Invaice: 702 Wendor Discount Percent:
Vendor: O'Connell Publishing Method of Payment: |';‘.:hed< j
Status: Valid for Payment =l Invoice Date: | 3/15/2012 -
Line Total: £10.00 Currency Type: |L|nibed States D... USD j
Invoice Discount: 5.00
Invoice Fee Total: £.00 Invoice Total: £ 10.00
Invoice Tax Total: £.00
Invoice Order Line Information

Order | | Vendor Til... | Title Price | Oty | Amount Status Discount | FeeT... | TaxTotal

6580-1 The torrents of spring; aro... $10.00 1 £ 10,00 Valid for Pay... £.00 £.00 £.00
<] B

Line Taxes | Line Motes | Line Fees ‘ Insert ‘ Edit | Delete |

When Saving ...

™ Exit This Window {" Repeat This Function {* Immediately Proceed to Payments

Print | Receipt Report ‘ Invoice Taxes ‘ Invoice Discount| Invoice Notes | Invoice Fees ‘ Add Cancel |

Note: If you select Immediately Proceed to Invoices from the Purchase Order or
Receipts window or you enter a purchase order number from the Add Invoice
Request window, the Invoice Order Line Information list box on the window will
display the line items for the selected purchase order. Otherwise, it will be empty

as shown above.

Insert Invoice Line Items
Click the Insert button on the Add Invoice window. The Add Invoice Line

Items window will appear.

Profiler Tip: The Invoice Line Item Display parameter lets you determine which
purchase order line items appear on the invoice during the add invoice process.

See Working with the Acquisitions Basic Options Parameters: Setting the Invoice
Line Item Display Parameter in the Virtua Profiler/Acquisitions Parameters User’s

Guide for more information.
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-

W Add Invoice Line ltems - phoenix

mEx]

Order Mumber: ||

Line |T|ﬁe

[z

Line Mumber:

Selected Line Item Info:

Qty Ordered:

Qty Received:

Qty Previously Invoiced:

Qty Mot Invoiced:

Qty Received - Qty Invoiced:
PO Line Status:

PO Line Unit Price:

PO Line Currency Type:

Request

5.00

Selected Line Item Invoice Info:

Invoice Unit Price:

Receive Quantity:

|
Invoice Quantity: |
|
Invoice Status: |

[

Invoice Currency Type:

v Indude All ines on Invoice

=

[ Indude Line Item on Invoice

Cancel

Note: You can continue inserting line items that are on different purchase orders
but are associated with the same vendor. There is no limit as long as all the
purchase orders are in the same currency.

Enter a purchase order number.

Tip: If you can't remember the PO humber do an OPAC search on one of the titles
in the order. You can find the PO number on the Statuses tab of the View

Record window.

Click on Request. All line items associated with the purchase order that have the
status Received will display in the Add Invoice Line Items window.

Acquisitions Workflow-Based Reference Guide
*Updated to 16.1

Last Revised: October 2017




152

W Add Invoice Line Items - phoenix E]@
Order Mumber: | Line Mumber:
T |T|He Selected Line Item Info:
1 The torrents of spring; a romantic novel in honor  vgS Qty Ordelred: 1
of the passing of a great race, Qty Received: 1
Qty Previously Invoiced: i
Qty Mot Invoiced: 1
Qty Received - Qty Invoiced: 1
PO Line Status: Ordered
PO Line Unit Price: £ 10.00
PO Line Currency Type: usD

Selected Line Item Invoice Info:

Invoice Unit Price: | £ 10.00|
Invoice Quantity: |1

Receive Quantity: |1

Invoice Status: |1.n'alid for Payment ﬂ
Invoice Currency Type: usD
v Incude Line Item on Inveoice Iv Incude All lines on Invoice

Search ISBM | ISSM [0]4 | Cancel ‘

Click on a line item number to select the item for inclusion in the invoice.
Information about the item will appear in the Selected Line Item Info area of
the window.

Review the information in the Selected Line Item Info area of the window. The
new Invoice Unit price may be significantly higher than the price on the purchase
order. If the price difference exceeds the threshold set in the Virtua Profiler, the
following screen will appear.

L o

Error

The invoice price exceeds the purchase order price by mare than the acceptable threshald.
Changes will not be saved. Do you wish to override?

Profiler Tip: Invoice Price Variance Threshold Settings are used to set a
threshold percentage. Once that threshold is reached, permissions can also be
set to accept the threshold and not proceed with the invoice or to allow the user
to override. See Working with the Acquisitions Basic Options Parameters:
Invoice Price Variance Threshold Settings in the Virtua Profiler/Acquisitions
Parameter User’s Guide for more information.

Click on OK to close the Add Invoice Line Items window. The Invoice window
will now contain the items from the purchase order.

The software verifies that this is a valid invoice for the vendor you selected
during ordering.
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The line item information is updated as the invoice is created for each purchase
order added to the invoice.

Edit Invoice Line Items

Four common functions performed from this window are:

Edit: Price, Quantity, and Status may be changed
Line Fees: Add a charge to an individual line item

Profiler Tip: The Invoice Line Item Fees parameter lets you define fees and
taxes that apply to specific line items on an invoice. The fee or tax is charged to
the same account as the line item itself. The fees that you define in this
parameter will appear in the Virtua client in the drop-down list of fee types
available in the Line Fees Modification dialog box. See Working with the
Acquisitions Fees: Working with Invoice Line Item Fees in the Virtua
Profiler/Acquisitions Parameter User’s Guide for more information.

Invoice Fees: Add a charge to the entire invoice

Profiler Tip: The Invoice Header Fees parameter controls the drop-down list of
fee types available in the Invoice Fee Modification dialog box in the Virtua client.
See Working with the Acquisitions Fees: Working with Invoice Header Fees in
the Virtua Profiler/Acquisitions Parameter User’s Guide for more information.

Taxes: Tax types and amounts may be added. To assign taxes to an invoice,
the Use Taxes setting in the Taxes Parameter of the Virtua Profiler must be
enabled.

Profiler Tip: The Taxes parameter lets you define different types of taxes that
you want to make available in the Virtua client in order to track taxes separately
from invoice fees. See Working with the Taxes Parameter in the Virtua
Profiler/Acquisitions Parameter User’s Guide for more information.
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¥ Update Invoice

rPrimary Invoice Information

Invaice: 702 Wendor Discount Percent:
Vendor: O'Connell Publishing Method of Payment: I LI
Status: |vaiid for Payment =l Invoice Date: 3/15/2012 -
Line Total: £20.00 Currency Type: United States D...  USD ;I
Invoice Discount: £.00
Invoice Fee Total: £.00 Invoice Total: £ 20.00
Invoice Tax Total: £.00
rInvoice Order Line Information
Order | | Vendor Titl. .. | Title | Price | Qty | Amount | Status | Discount | FeeT... | TaxTotal |
6580-1 The torrents of spring; aro... $20.00 1 §20.00 Valid for Pay... £.00 .00 £.00
[il I | [i]
Line Taxes Line Motes Line Fees Insert Edit | Delete
When Saving ...
" Exit This Window i~ Repeat This Function {+ Immediately Proceed to Payments
Print | Receipt Report | Invoice Taxes | Invoice Discountl Invoice Notes | Invoice Fees | Save I Cancel

Modify line items by highlighting a line item and clicking on the Edit button. The
Invoice Line Item window appears. Price, Quantity, and Status of line items

may be modified.
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W Invoice Line Item - phoenix E]@
Line Information l
Price: | S 20,00 Accounts
" |1 Fiscal ... | Account Name

e 2010 [0 ADULT HQU
Receive Quantity: |1
Status: |1-'a|id for Payment j

Discounts

’ Fiscal Year:
[ Discount Percent:
2010 |

[ Discount Amount:

MNew Account:

SO ADLLT HQU |
Tax Type | Tax Amount

[ Apply New Account

Post | Cancel

From here, you may:

Change the unit price

Change the quantity to be invoiced

Change the status of the line item

Manually apply a discount by percentage or monetary unit. (A discount will
automatically be applied if there is a discount set on the Customer Account tab
of the Vendor record. If the customer account has no discount assigned, then if
the Acquisitions Info tab of the Vendor record has a discount percent
assigned, that will be used.)

Review tax type and amount

Change fiscal year and account. If you make these changes, you must check the
Apply New Account checkbox.

Make any changes to the line item.

Note: If you have Allow Ordering for Multiple Locations enabled in the Virtua
Profiler, you will have a locations tab of the Invoice Line Item window where
you can specify the quantity of items you are invoicing for each location that
ordered copies of the item. See Working with the Acquisitions Basic Options
Parameter in the Virtua Profiler/Acquisitions Parameters User’s Guide for more
information.

Acquisitions Workflow-Based Reference Guide Last Revised: October 2017
*Updated to 16.1



156

% Invoice Line ltem - Venus88 o | = |3
Ship to Address | Order Quantity | Received Qu... | Invaice Quan... |
HE Central Hong Kong Central (*1000000) 2 2 2
ACQ Group Aberdeen (501000000) 5 5 5

Post | Cancel

Click the Post button; you will return to the Add Invoice window.

Fees

From the Add Invoice window, fees may be applied to line items or to the entire

invoice.

e To add a charge to an individual line, highlight the line and click on the Line

Fees button

e To add a fee to the entire invoice, click the Invoice Fees button

To add a fee to the entire invoice click on the Invoice Fees button on the Invoice

footer. The Invoice Fees window appears.

-

¥ Invoice Fees

BEX]

Fee Type

Amount

$.00

Cancel

Click the Insert button. A dropdown menu appears with a list of fees that may be

applied to the line item.
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Enter a fee amount and select the fee type.

W Invoice Fee M... g ||

Amount: | £2.00

Invoice Fee Type:

|State taxes |

Post | Cancel |

Click the Post button. The Invoice Fees window will be active with the fee
displayed

W Invoice Fees E]@
Fee Type Amount
State taxes 52.00

Insert ‘ Edit | Delete | Save | Cancel |

Click the Save button on the Invoice Fees window. The Add Invoice window
will be active.

On the Add Invoice window, Invoice header fees will appear in the header.
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W Update Invoice

Primary Invoice Information

Invoice Order Line Information

Invoice: 2

Vendor: O'Connell Publishing

Ciahiss Valid for Payment ﬂ
Line Total: £ 17.00

Invoice Discount: 5 .00

Invoice Fee Total: §2.00

Invoice Tax Total: .00

Vendor Discount Percent:

Method of Payment: |Check ﬂ
Invoice Date: | 3/15/2012 |
Currency Type: |L|niheu:| StatesD... USD =

Invoice Total: £ 19.00

Order Vendor Titl... | Title | Price | Qty | Amount Status | Discount | FeeT... | TaxTotal
& The torrents of spring; aro... § 20.00 £ 20.00 valid for Pay... §3.00 .00 5.00
< 2]
Line Taxes | Line Motes ‘ Line Fees | Insert ‘ Edit | Delete ‘
When Saving ...
" Exit This Window " Repeat This Function f* Immediately Proceed to Payments
Print ‘ Receipt Report | Invoice Taxes ‘ Invoice Discount‘ Inwoice Notes ‘ Invoice Fees | Save | Cancel ‘

On the Add Invoice window, Invoice line fees will appear in the Fee Total
column of the Add Invoice window. Note: If Customer Accounts set up on the
vendor record are used, then if there is a default surcharge in the Customer
Account tab, it will be applied to the invoice line as a Miscellaneous Servicing line

fee.

Taxes

Taxes may be applied to line items or to the entire invoice.

e To add a tax to an individual line, highlight the line and click on the Line Taxes

button.

e To add a tax to the entire invoice click the Invoice Taxes button.

To add a fee to the entire invoice click on the Invoices Taxes button on the
Invoice footer. The Invoice Taxes window appears.
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W Invoice Taxes [Z]@

All Available Taxes: Selected Taxes:

Spedal Tax =
Default Fee
STATE TAXES 07
STATE TAXES 03
STATE TAXES 09 a5
STATE TAXES 10
Extra Tax

State tax 2010

B

=

£ [ (]

Apply | Cancel ‘

Any taxes that have been entered in the Taxes parameter of the Profiler will
appear in the All Available Taxes column. Highlight the tax or taxes you wish to
apply and use the arrows to move to the Selected Taxes column.

W Invoice Taxes [Z]@

All Available Taxes: Selected Taxes:
Default Fee Taxes
STATE TAXES 07
STATE TAXES 08 Special Tax
STATE TAXES 09
STATE TAXES 10 =
Exira Tax
State tax 2010
_<|
£
3| (]

Apply Cancel ‘

Click the Apply button.

Invoice taxes will appear in the header of the Add Invoice window.
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W Update Invoice E]@
Primary Invoice Information
Invoice: 702 Vendor Discount Percent:
vendor: O'Connell Publishing Method of Payment: |Check -
Status: Valid for Payment =l Inveice Date: | 3/15/2012 -]
Line Total: £21.10 Currency Type: |Urited States D... USD =
Invoice Discount: .00
Invoice Fee Total: £2.00 Invoice Total: 424,53
Invoice Tax Total: £1.43
Invoice Order Line Information
Order Vendor Titl... | Title | Price | Qty | Amount Status | Discount | FeeT... | TaxTotal
6560 The torrents of spring; aro... §20.00 1 £ 20.00 Valid for Pay... .00 .00 5110
< 2]
Line Taxes | Line Motes ‘ Line Fees | Insert ‘ Edit | Delete
When Saving ...
" Exit This Window " Repeat This Function f* Immediately Proceed to Payments
Print ‘ Receipt Report | Invoice Taxes ‘ Invoice Discount‘ Inwoice Notes ‘ Invoice Fees | Save | Cancel

Line item taxes will appear in the Tax Total column.

Save Invoice

When all line items have been edited, select an option for saving:

Exit This Window: closes the Add Invoice window
Repeat This Function: opens the Add Invoices Request window
Immediately Proceed To Payments: opens the Voucher window

Click on Add at the bottom right of the invoice screen. This will save the invoice.

The software checks to make certain that the invoice is saved successfully.

The Statuses tab is updated on the bibliographic record to show that the items

have been invoiced.
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W View Bibliographic Record - phoenix E]@

ﬂﬂ 53 /73

Order ID/Line Pairs:

Ful | Items | MaRC Statuses |

|5560 - 1

Order ID: 6560

Order Status Information:

Order Type: Manograph

Payment Type: Standard Add/Update]  View | JJ View JJ

Receipt Status Information: Payment Status Information:
j Status: Received Satisfactory Voucher ID; 207
Quantity: 1 Status: Paid in Full
Condition: Correct Item AmountPaid: £ 20.00
Date: 3f15/2012 Date: 3/15/2012

Line Mumber: 1
E;I::Eruslirs: COrdered Invoice Status Information: Credit Status Information:
Quantity: 1 Invoice ID: 702
Location: Headquarters Library,Technic 5131:“5_: valid for Payment
Vendor: O'Connell Publishing Quantity: 1
Price: £20.00 Price: £ 20,00
Date: 3/15/2012 Date: 3/15/2012
Update | view | < | vew | | |
[~ Masked Agency Reg ‘ | Edit | Request Bib | Add Ttem | Refresh ‘ Close |

Add Line Items

Typically only one purchase order will be associated with a given invoice, but
Virtua allows multiple purchase orders for the same vendor to be combined on

one invoice.

Select Acquisitions > Invoices > Update from the Virtua main menu. The
Update Invoice Request window will appear.

Enter the invoice humber, and select the vendor linked to the invoice from the list
box. Select None from the Vendor dropdown menu to search by invoice number

only.

Update Invoice Request

Invoice:

|702

Vendor:

|N|:|ne

Invoice Location:

|Headquarters

Reguest |

Cancel ‘

Click the Request button. The Update Invoice window appears.
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If only ONE invoice with the specified number is found, the View/Update
Invoice window appears.

If MORE than one invoice with the specified number is found, the Invoice by
ID window appears

W Invoice By ID - phoenix - 702

=X

Vendor | Lines | Date Currency Total |
WESTOMN WOODs5 1 3f16/2012 usp 512,66
Q'Connell Publishing 1 3f15/2012 usp 520,00

0K Cancel

On the Invoice by ID window, highlight the line of the invoice that you want to
view and click the OK button. The View/Update Invoice window appears where
you can view/update the invoice.

W Update Invoice g@

Primary Invoice Information
Invoice: 702 Vendor Discount Percent:
Vendor: WESTON WOODS Method of Payment: |Ehed< j
Status: Valid for Payment =l Invoice Date: | 3/16/2012 |
Line Total: £ 10.00 Currency Type: |United StatesD... USD -
Invoice Discount: %.00
Invoice Fee Total: §2.00 Invoice Total: $12.66
Invoice Tax Total: § .66
Invoice Order Line Information

Order | | Vendor Titl... | Title | Price | Oty | Amount | Status | Discount | Fee T... | TaxTotal |

6562-1 Richard Brautigan's Trout fi... $10.,00 1 £10.00 Valid for Pay... .00 £.00 £.00

< ] I | [ )]

Line Taxes | Line Notes | Line Fees | Insert | Edit | Delete |

When Saving ...

" Exit This Window i Repeat This Function * Immediately Proceed to Payments

Print | Receipt Report | Invoice Taxes | Invoice Discount| Invoice Notes | Invoice Fees | Save | Cancel |

Click the Insert button to add additional line items. The Add Invoice Line

Items window will appear.
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W Add Invoice Line ltems - phoenix

BEX

Order Number: |

Line |T|ﬁe |

[ san 1]

Line Number:

Selected Line Item Info:

Qty Ordered;

Qty Received:

Qty Previously Invoiced:

Qty Mot Invoiced:

Qty Received - Qty Invoiced:
PO Line Status:

PO Line Unit Price:

PO Line Currency Type:

Request

.00

Selected Line Ttem Invoice Info:

Invoice Unit Price: $.00

Receive Quantity:

|
Invoice Quantity: |
|
Invoice Status: |

=l
Invoice Currency Type:

[ Indude Line Item on Invaice W Indude All lines on Invaice

Note: Check the Selected Line Item Information provided for invoice status.

Enter the order number of the item(s) you want to add. Click OK to return to the

Invoice window. Note that the Items have been added to the item list.

Click Save to save the invoice. The system responds with Invoices updated.

Delete Invoices and Invoice Line Items

Select Acquisitions > Invoices > Delete from the Virtua main menu.

Enter the Invoice ID and the Vendor. Click Request.

Delete Invoice Request

Inwoice:

|702

Vendar:

|WESTON WOQoDs

[~

Inwoice Location:

|Headquarters

Request |

[~

Cancel ‘

The Delete Invoice window appears.
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W Delete Invoice g@

Primary Invoice Information

Invoice: 702 Vendor Discount Percent:

Vendor: WESTON WOODS Method of Payment:

Status: Valid for Payment j Invoice Date:

Line Total: £ 10.00 Currency Type: |Unibed StatesD... USD J
Invoice Discount: £.00

Invoice Fee Total: $2.00 Invoice Total: $12.60
Invoice Tax Total: £ .66

Invoice Order Line Information

Order | | Vendor Titl... | Title | Price | Oty | Amourt | Status | Discount | FeeT... | TaxTotal |
6552-1 Richard Brautigan's Trout fi... §10.00 1 £ 10.00 Valid for Pay... §.00 £.00 £.00
< (2]

Line Taxes | Line Motes | Line Fees | Insert | Edit | Delete |

When Saving ...
{* Exit This Window " Repeat This Function «

Print | ReceiptReport| InvoiceTaxes| Inwvoice Discount| Invoice Motes | Invoice Fees | Delete | Cancel |

Note: There are two delete buttons; one to Delete Line Items, one to Delete
Invoices.

Delete Line Items

Highlight a line item and click on the Line Item Delete button.

The system prompts, The line item will be deleted. Are you sure? Click on OK to
delete the highlighted invoice line item. Encumbrance totals are adjusted.

Warning

'i The line item will be deleted. Are you sure?

Cancel |

Delete an Entire Invoice

To delete an entire invoice, click on the Invoice Delete button.
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i o

Warning

"'_-. This invoice will be DELETED and cannot be recovered!
L

ARE YOU SURE?

The software checks for outstanding transactions that may be linked to the
invoice. Click Yes to delete the invoice. If none exists the invoice is deleted.

Print Invoices

Acquisitions searching allows single or multiple invoices to be printed. Invoices
may be printed from the View Invoice window, Update Invoice window or
from the Acquisitions Search Results window.

Select Acquisitions > Invoices > View from the Virtua Main Menu. The View
Invoice Request window opens.

View Invoice Request

Invoice:

|a753

Vendar:

|Hanity Publishing j

Invoice Location:

|Be||eﬁ:nnte j
Reguest | Cancel |

Enter the invoice number, vendor, and invoice location and click Request. The
View Invoice window opens.
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W View Invoice 2l
Primary Invoice Information
Invoice: 9753 Vendor Discount Percent:
Vendor: Hanity Publishing Method of Payment: Check A
Status: Invoice Date: 8/24/2011 v
Line Total: £20.00 Currency Type: United States D... USD = I
Invoice Discount: £.00
Invoice Fee Total: £.00 Invoice Total: £20.00
Invoice Tax Total: £.00
rInvoice Order Line Information
Order | | Vendor Titl. .. | Title | Price | Qty | Amount | Status | Discount | FeeT... | TaxTotal I
6420-1 Being and nothingness : an... $10.00 1 £10.00 Valid for Pay... .00 £.00 £.00
6420-2 Mo exit, and three other pl...  §10.00 1 £10.00 Valid for Pay... .00 £.00 £.00
[il i | [l]
Line Taxes | Line Motes | Line Fees | Inserk | Edit | Delete |
—When Closing...
{* Exit This Window {~ Repeat This Function {~ Immediately Proceed To Vouchers
Print | Receipk Report | Inwvoice Taxes | Invoice Discount Imvoice Motes Invoice Fees | QK I Cancel

Select the Print button.

Select the template file from the drop-down list box.

Choose Template - Phoe... W

select a template file:

Click OK. Modify any of the available settings, if needed, and click OK to print the
invoice.

Print - Phoenix 2JEd

Printing

Format: Invoice ;I

—Range opies

ol Mumber of copies: I:l j
{* Selected Records

= Selected with Child Records

Printer Setup | QK I Cancel |
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Note: Select the Print in Background check box on the Print dialog box to allow
all normal Acquisitions functions to be performed while large numbers of records

are being printed.

Select Acquisitions > Search Acquisitions from the Virtua Main Menu. The

Search Acquisitions window opens.

W Search Acquisitions - phoenix

BE[X]

Purchase Order |0H1er ]

Purchase Order

[~ Order Type [~ Order State Status

[~ Currency [ Order Status
[~ Payment Type I~ Ship To Location
[~ Fiscal Year [ Material Type:

[~ Subject Code [T Collection Code

BEAEN

[ Purchase Order [~ Receipts [V Invoices I Payments ™ Account [~ Purchase Request

Keyword

[vendor 1d | [a38 | | =]
| 3| 3 | 5 —

| = 3 | 7

| = 3 | o ==
| =i 5

Filters

| [ Order Prefix e
) r [
*| | Line Number

w

'A' [ Enumeration/Chronalogy

" [~ Frequency

~

l»| [ Price | J |

| [ Order Quantity

B ]

[~ Last Modified Date [~ Due Date [~ Order Date [ Subscription ™ Cancellation Date
Start Date Start Date Start Date Start Date Start Date

| [~ | [~ I | | [~
Stop Date Stop Date Stop Date Stop Date Stop Date

| [~ | [~ I | | [~

Select the Invoices check box and search criteria. Click Search to open the

Acquisitions Search Results window.

Highlight an invoice and right-click to select Print Invoice.
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W Acquisitions Search Results - phoenix g@
Purchase Orders  Invoices l
Vendor Name | Invoice Id | PO Id PO Li... | Title | Date | Status | Price | Quan... | Curr...
O'Connell Publis... 8642 5410 1 Hercule Poirot's Christmas ;...  8/19/... Vvald forP... § 10.00 1 usD
0O'Connell Publis... 8642 5410 2 Black coffee : a new Hercul...  8/19/... vald forP... $10.00 1 usD
Q'Connell Publis,.. 529 5414 1 Hammond world atlas fHa...  8/19/... valid forP... $15.00 1 usD
0'Connell Publis, 6414 2 Geography and cartograph... 8/19/... Vvald forP... £ 10.00 1 usD
0'Connell Publis. : \;':"E This? + The torrents of spring; aro... 3/6/2... Vald forP... £ 15.00 1 usD
O'Connell Publis... 1222 ats Ths! The garden of Eden Erne...  3f§/2... Vvalid forP... § 15.00 1 usD
Bibliographic Record
Update Invioice
View Invoice
Print Invoice
View Purchase Order
View Receipt
Vendor
Page Up | Page Down |
Vendor Id: 438
Close

Select the template file from the drop-down list box.

Choose Template - Phoe...

Select a template file:
|§nvoiceprint.utF j

CK | Cancel ‘

Click OK. Modify any of the available settings, if needed, and click OK to print the
invoice.

Add Supplemental Invoice

Virtua supports supplemental invoicing. The need for supplemental invoices occurs
when a library generates an invoice and pays for, say, a renewal quotation and
then later in the year needs to generate another invoice for the same renewal in
order to adjust the price of some items. In this situation, the library must be able
to generate a supplemental invoice for items that have already been invoiced and
paid.

Virtua lets you add a supplemental invoice via the Acquisitions main menu.
Since you can attach the invoice to particular purchase order line items, you will
be able to track the supplemental invoices along with the original invoices via the
Statuses tab on the View Bibliographic Record window. In this way, you can
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reconcile the original invoices with supplemental invoices that are created
throughout the year. The system will also recognize and support supplemental
invoices that are brought into the system via EDIFACT.

To create a supplemental invoice

On the Virtua menu bar, click Acquisitions.

Choose Invoices, and then choose Add Supplemental.

Add Supplemental Invoice
Invoice:

Vendor:

|a.B. PRUTTT |
Invoice Location:

|Headquarbers j
Purchase Crder ID:

Request | Cancel |

Complete the information in the dialog box.
Click the Request button.
The Add Supplemental Invoice window appears where you can create

supplemental invoice line items and attach them to individual purchase order line
items.
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W Add Supplemental Invoice == E
Supplemental Invoice Information

Invoice: 702 Vendor Discount Percent:

Wendor: O'Connell Publishing Method of Payment: Check LI
Status: fvald for Payment =l Invoice Date: 3/16/2012 =]

Line Total: $.00 Currency Type: United StatesD... USD = |
Invoice Discount: g.00

Invoice Fee Total: £.00 Invoice Total: £.00

Invoice Tax Total: 5.00

rInvoice Order Line Information

Order | | Vendor Titl. .. | Title | Price | Qty | Amount | Status | Discount | FeeT... | TaxTotal I
[il i | [l]
Line Taxes Line Motes Line Fees : Edit | Delete |
—When Saving ...
% Exit This Window {~ Repeat This Function i~ Immediately Proceed to Payments

Print | InvoioeTaxesl Invoice Dismuntl InvoiceNobesl Invoice Fees | Add | Cancel |

Edit the supplemental invoice and click Add to save the supplemental invoice.
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Managing Payments

Recommended
Workflows

Explanation

Pay All Invoices

Create
Voucher

Select all
invoices for

A

Print
Voucher

Pay Partial
Invoices

Create
Voucher

\ 4

Select
Invoices/Lin

\ 4

The voucher function is used to pay invoices. A voucher
may be used to pay multiple invoices provided they are
from the same vendor. In addition, vouchers may be
paid in whole or in part.
Summary

Create a voucher

Pay all of the invoices on a voucher

Pay part of the invoices on a voucher

Print the voucher

Processing vouchers without invoices
Key Terms
e Credits
e Voucher
e Voucher ID

Currency Rule
e The currency chosen for the voucher must be the

same as for the invoice.

Profiler Parameter
Payment Methods: Allows you to define payment
methods that you want to appear in the drop-down
list in the Virtua Client.

Statuses (Payment): Allows you to add, modify,
and delete statuses associated with payments.
Allows you set a default payment status.

InfoStation Report
Vouchers: Generates a summary of all vouchers
that meet the account, vendor, and date range

Print
Voucher criteria set in the report configuration.
Processing
Special
Payments
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Pay All Invoices

Create the Voucher

Click the Voucher icon on the Acquisitions toolbar or select Acquisitions >
Vouchers > New from the Virtua main menu. The Create Voucher Request
window will appear.

L 1

Create Voucher Request - Customer Support...

‘endor Name:

Chanting Bird Press j

|w Create From fwvaiable Imvoices

Request | Cancel |

Note: It is important to create the Payment Voucher in the Acquisition system
even if your payments are processed outside of the Acquisition module. Saving
the Voucher, even if you never send it, is very important to have the Expenditures
updated in the Account information. This is the only way to reconcile
Encumbrances and Expenditures completely.

Select a Vendor from the drop down menu.

Check the Create from Available Invoices box to include all unpaid invoices from
the selected vendor. If left unchecked, a voucher will be created without a list of
available invoices.

Click on Request. The Select Invoices for Payment window appears.
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W Select Invoices for Payment - Customer Support Library g@
Balance Information:
Woucher I1D: | nes fnarmaton
Total: 526.00
Vendor: O'Connel Publishi
snaor A A ECE Previousty Paid: 5.00
Payment Date: | 32612014 | R e
Print Fie Prefic |engprintvoucher utf i Appied Credits: $.00
Accession Number: | Fayment: 5.00
Currency: USD MNew Balance: 525.00
Invoices
Invoice | Diate | Invoice Total | Invoice F&&sl Imvoice Tax... | Credits | Prev Paid | Payment | Balance
705 |ar21/2012 |2 25.00 |5 .00 |5 .00 |5 00 |5 oo |5 .00 |5 2500
| | | __Pwa | |
When Saving...
{¥ Exit This Window " Repeat This Function Notes ‘ Save ‘ Cancel ‘

Searching for Vouchers

Select Acquisitions > Vouchers > Search Vouchers from the Virtua main

menu. The Voucher Search window will appear.

The Voucher Search window lets you search for vouchers according to Voucher
ID, Accession Number, Invoice Number, Fiscal Year/Month, Voucher Status,

Vendor, or Date Range.

To perform a search, type or select your search criteria and click the Search
button. Vouchers meeting your search criteria appear in the results pane.
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%/ Youcher Search, - clay68

Filkers

Woucher ID Accession Number Wendor | Total Payment |
Woucher Id: 010411 AMazon,com $563,29 A
| 04082010 Amazon, com $23.52
PU——— 041210 AMazon,com $92.97
041410 AMazon,com $91.51
| 04142010a AMazon. com $211.91
Trvvnice Mumber: 04162010 Amazan.cam 420,00
| - 042010 AMazon, com
042110b AMazon,com $66.14
042110c AMazon,com $313.05
042110d AMazon,com $47.98
042110e AMazon,com $71.97
042610 AMazon,com $31.54
04262010 Amazon, com $50.73
042710 AMazon,com $a.09
050310e AMazon,com $23.46
¥ “endor 050310g AMazon,com $58.75
a1 endor 3 0504100 AMazon,com $10.95 &
Alibris (‘“ o : —_— S
American Gunsmithing Institute
Armerican Yeterinary Medical Asociation Payment Date: 4/20/2010
Aramco Services Company w Total Amount: 430,94
: : Total Applied Credits: $.00

I~ Create Date
Start Date

[ 21 szot+ =]

Stop Date

Search | Cancel |

Click on a voucher to view details about that credit below the results, or double-
click on a voucher to open the Display Voucher window.

Select Invoices for Payment Window

Voucher Header

Voucher ID: An alphanumeric string of up to 30 characters.

Vendor: Non-editable. The name of the vendor you specified on the Voucher
Request. This field is non-editable.

Payment Date: The default is the current date but it can be edited.

Print File Prefix: Defines which text file will be used to print the voucher.
Accession Number: Optional. Virtua does not use this field but it can be used
to store an accession number (or any other alphanumeric code) that will be
saved as part of the voucher.

Currency: All invoices attached to a voucher must have the same currency and
this field will be non-editable. If all invoices for the vouchers do not have the
same currency assigned the word “All” will display in a drop down menu and all
invoices will be displayed in the dropdown menu. The only active buttons will be
Expand Credits, Notes, and Cancel. You must change currency of the non-
conforming invoice or delete the invoice from the voucher in order to proceed.
Balance Information: Non-editable. The software calculates the balances for
you.
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Invoice Options
e Expand Invoice: Displays additional invoice information.

Payment Options

e Pay Balance: Pays the selected invoice in full, including the invoice fees and
line fees. The button is enabled only if the selected invoice has a balance greater
than 0.

e Pay Cancel: Cancels the payment of the selected invoice and undoes any
credits applied. The button is enabled only if the selected invoice has a payment
greater than 0.

¢ Pay All: Pays all the invoices in the display box.

Credit Options

e Expand Credits: For all invoices, displays the Apply Credits to Invoices
window.

e Apply Credits: Button is enabled only if credits with the specified currency exist
in the potential payment record and some of the invoices have already been
paid.

e Un-apply Credits: Undoes any credits that have been applied.

Note: An enabled Expand Credits button alerts the user that credits exist for the
Vendor. Click on the Expand Credits button to display all available credits. The

user may choose to apply the credit(s) or save the credits for another invoice to
that vendor.

Select All Invoices for Payment

Fill out the necessary header information on the Select Invoices for Payment
window.

To pay all of the outstanding invoices click the Pay All button.
Select a When Saving option.
Click Save.

The system responds, Voucher was added successfully. Click OK.

Information

\]::) The voucher was added successfully.
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Print Voucher

The Print voucher window is displayed to the user to allow immediate printing of
a payment voucher.

Print - Phoenix E]

Printing

Voucher hd

Copies

Mumber of copies: 1 jj

OK | Cancel |

Click OK to start the voucher print program. The voucher print program will use
the form designated in the Print File Prefix box of the Select Invoices for
Payment window. Once the printing is finished, the user may return to perform
additional payments or go back to other acquisitions transaction processing.

Note: Select the Print in Background check box on the Print dialog box to allow all

normal Acquisitions functions to be performed while large numbers of records are
being printed.

Pay Selected Invoices

Create the Voucher
(See Pay All Invoices Create the Voucher)

Select Invoices/Line Items for Payment
Partial payments can be made at either the invoice level or the line item level.

Select an Invoice for Payment
From the Select Invoices for Payment window, highlight the invoice to be paid.

Click the Pay balance button. The voucher will pay any outstanding balance
associated with that invoice.

Select Line Items from an Invoice for Payment

To view additional information for a specific invoice, highlight the invoice in the
Select Invoices for Payment window and then click the Expand Payment
button.

The Invoice window is displayed detailing line item information.
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From the Invoice window you can select a line item and pay the balance, or pay
the balance for the entire Invoice. Highlight a line item; then click on Pay
Balance.

Note: The screen above shows the first line item paid, with the balance showing
for the unpaid items. Note the Payment and Balance columns that tracks which
items have been marked for payment.

If Pay Invoice is selected, all line items are paid. When OK is clicked, the user is
returned to the updated Select Invoices for Payment window.

Note: the Payment and Balance columns show total payment to be made and the
outstanding balance for each invoice.

When all desired invoices or line items have been paid, click Save. The software
saves the voucher and prompts you to print it.

To pay the outstanding balance on the invoices, create a new voucher for that
vendor. Any invoices for that vendor with outstanding balances will appear on the
voucher.

Print Voucher
(See Pay All Invoices Print Voucher)

Reprint a Voucher

View the Voucher

Select Acquisitions > Vouchers 2> View from the Virtua main menu. The View
Voucher Request window will appear.

7 1

View Voucher Request - Customer Support L...

Youcher 1D

Request Cancel |

Type in the Voucher ID.

Click the Request button. The Display Voucher window appears.
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¥ Display Voucher - Customer Support Library = E]ﬁ
Payment Information:
Voucher ID: 4691 ILELELIEIELLT
Vendor: ©rConnel Pubishing Total Amount: S
Payment Date: 10/4/2013 Total Applisd Credits: $ .00
Print File Prafix: ntvoucher.utf
" r ELLELOELELE Total Payment: 3 10.00
Accession Number:
Payment SAP: DEF Defauit
Nt | Imeice | Date | Invoice Amount Paid | Invoice Fees Paid | Invoice Taxes Paid | Total Paid
1964 1042013 $10.00 $.00 5.00 $10.00
When Closing...
’7 % Exit This Window {~ Repeat This Function
Print Expand Credit= | Expand Inveice Motes TG

Select the Print button.

Select the template file from the drop-down list box.

-,

Choose Template - Cust... W

Select a template file:

QK Canced |

Click OK to start the voucher print program. Modify any of the available settings,
if needed, and click OK to print the voucher.
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- "\
Print - Phoenix 23
Printing
Format: |1-'u::uu:her j

Range Copies

Mumber of copies: 1 :ll

~
~
~
Printer Setup | 0K Cancel |

Note: Select the Print in Background check box on the Print dialog box to allow
all normal Acquisitions functions to be performed while large numbers of records
are being printed.

Processing Special Payments

There are times when a payment has to be processed prior to ordering or to
proceed and invoice. For example, you may need to pay a "Membership” to get a
discount on a future order or you may have to create a Payment to reserve a
“Pre-Publication Future Order”. You can also create this as an additional payment
for an existing purchase order such as an unexpected payment bill after Invoice
has been processed. Any Payments created not linked at a purchase order will
have to have an account link.

Creating a Payment Voucher without Invoices
To create a payment voucher without invoices:

Select Acquisitions > Vouchers > New from the Virtua main menu.

The Create Voucher Request dialog box appears.

[ oy

Create Voucher Request - phoenix

Vendor Mame:

|.B. PRUITT |

| Create From Available Invoices

Reguest Cancel |

De-select the Create From Available Invoices check box.
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Click the Request button.

The Voucher Without Invoices window appears.

W Voucher Without Invaices - Customer Support Li... g@

Voucher 1D: I
Vendor: AB. PRUITT
Payment Date: [10r arz013 ~
Print File Prefoc Iengprinhfc-u cher.utf j
Accession Number: I
Currency: |united States Dolar uso |
Payment SAP: IDEF Default j
oucher Total: 300
—#Account Information:
Fizcal Year:
Fiscal Year |AccountlD |ﬁmnunt |
|2011 |
2011 AudicBocks  § .00
Account:
| AudioBooks -
Amount:
Delete Account | Add Account | | $ .00
—When Saving...
{+ Exit This Window {" Repeat This Function
Motes | Save | Cancel

Add the Voucher ID.

If the name in the read-only Vendor field is truncated, pass your mouse cursor
over the field to see the full name in a tooltip.

Voucher ID: I

vendor: TRADEMARK REGISTER NATIONAL PRESS BL
Payment Date: | TRADEMARK REGISTER NATIONAL PRESS BUILDING|
Print File Prefix: Iprintvu:uud'uer.utf ;I

Accession Mumber: I

Currency: ILInited States Dollar uso - |

Edit the Payment Date as needed.

Choose the file that you want to use to print the payment voucher.
Complete the Accession Number field (optional). Note that the Accession
Number field accepts alphanumeric data.
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Edit the Currency field, which displays the base currency by default.

(If the Use SAP flag is enabled in the Virtua Profiler choose a Payment SAP code
from the drop-down list box.)

Type at least ONE set of entries for Account/Fiscal Year/Amount data:
Complete each of the three fields: Account, Fiscal Year, and Amount.

Click the Add Account button. The data appears in the Account Information
table on the window. (Repeat the process as necessary.)

Click the Notes button to view any notes directly or indirectly attached to the
payment voucher

-OR_

Click the Notes button to add, modify, or delete any notes that are directly
attached to the payment voucher.

Choose a When Saving... option and click the Save button. The payment
voucher is saved to the data base.

Acquisitions Workflow-Based Reference Guide Last Revised: October 2017
*Updated to 16.1



182

Credit Management

Recommended
Workflow Explanation
Virtua Acquisitions supports four types of credits:
Add a Credit
Specific Credits - Linked directly to a vendor and
used against any future invoice presented for
v payment.
Complete Internal Credits — Created internally and used to
Credit Info adjust the expenditure for an account.
Prepaid Credits - Used when a vendor issues a
v credit for an order that has already been placed.

Use a Credit Internal Order Credits - Applied to a single order
line, and used to adjust the expenditure for an

account.

v Summary

View a Add a specific credit
Credit Add an internal credit

Add a prepaid credit

i Add an internal order credit

View a credit record
Modify a credit record
Apply a specific credit

Update a
Credit

Delete a credit

v Key Terms
Delete a Applied Credits
Credit Credit

Credit Memo

Internal Credit

Specific credit

Prepaid Credit

Internal Order Credit
Profiler Parameter
Statuses (Credit): Add, modify, and delete statuses
associated with credit; set a default credit status.
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Specific Credits
Add a Specific Credit

Click on the New Credit icon E on the Acquisitions toolbar or select Acquisitions
- Credits > New on the Virtua main menu. The Add Credit Request window
will appear.

i =y
Add Credit Request
Credit Type:
" Internal
{+ Specific
" Prepaid

(" Internal Order

Credit Mumber:

Request | Cancel |

Select the credit type Specific.
Enter a credit number.

Note: The number can be alphanumeric, up to 30 characters long, and is case
sensitive.

Click Request. The Add Credit window will appear.

W7 Add Credit
Credit Information ]
Credit ID: 12345
Credit Type: Specific
Currency: |L|nited States Dollar usb -
Amount: | $0.0000
Fiscal Year: |2I311 ﬂ
Account: |Adult Fiction j
Credit Status: |Valid for Use |
Create Date: | g/11/2013 ~|
Last Modified Date: | J
Expiration Date: ||_ j
Vendor: |s.B. PRUCTT ~|
Crder Mumber: |
Order Line Number: |

‘ Motes ‘ Save | Cancel |

Complete the credit by entering the following information:
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Select a currency

Enter an amount (optional for a specific credit)

Choose an account (the fiscal year will be filled in automatically)
Select the credit status

Created and last modified dates are system-supplied

Enter expiration date (optional)

Select vendor

Enter order number (optional)

Enter order line number (optional)

Notes:

e If you choose a specific account, the credit will be available only if all the line
items on the payment voucher are being paid from that account.

e If you complete the optional fields Order Number and Order Line Number on
this credit record, the accounts that appear in the Account drop-down list will be
only those associated with the original order.

Click Save to save the credit to the database. As part of the save process the
software:

e Validates the currency

e Logs the event in the transaction log

e Makes the credit available the next time an invoice from that vendor is
presented for payment.

Update a Specific Credit

Select Acquisitions > Credits > Update from the Virtua main menu. The
Update Credit Request window will appear.

Update Credit Request

Credit Mumber:

Reqguest | Cancel

Enter the Credit number to retrieve the credit for modification. The Update
Credit window will appear.
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W Update Credit

Credit Information ]

Credit ID:
Credit Type:
Currency:
Amount:

Fiscal Year:
Account:

Credit Status:
Create Date:
Last Modified Date:
Expiration Date:
Vendor:

Order Mumber:

Order Line Mumber:

12345

Specific

|United States Dallar ush =

| § 25.0000
2010 |
|ADULT FIC HQU |
|'u'a|id for Use ﬂ
|11/15/2010 |
| [ |
o [
|A&E HOME VIDEO |
|

|

Rescind Approval ‘ Motes ‘ Cancel

Modify the credit information and click Save.

Use a Specific Credit

Specific credits can be applied against any voucher created for that vendor that
uses the same account and currency.

Internal Credits

An internal credit is created internally and used to adjust the expenditure for an
account, for example, when an order for a partially paid item is canceled.

Add an Internal Credit

Click on the New Credit icon EJ on the Acquisitions toolbar or select
Acquisitions > Credits > New on the Virtua main menu. The Add Credit
Request window will appear.
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Add Credit Request

Credit Type:
{* Internal
(" Specific
" Prepaid
(" Internal Order

Credit Number:

Request | Cancel

Select a credit type of Internal.
Enter a credit number.

Note: The number can be alphanumeric, up to 30 characters long, and is case
sensitive.

Click Request. The Add Credit window will appear.

- -
W Add Credit
Credit Information }
Credit ID: 12345
Credit Type: Internal
Currency: |L|nited States Dollar usb -
Amount: | 5 0.0000
Fiscal Year: | 2011 j
Account: |.‘5|IZ|LI|t Fiction ﬂ
Credit Status: |Valid for Use |
Create Date: | 9/11/2013 |
Last Modified Date: | J
| Motes | Save | Cancel |

Complete the credit by entering the following information:

Select a currency
Enter an amount
Choose a fiscal year (only open fiscal years will display)
Choose an account (filled in when fiscal year is selected)
Select the credit status (specifies the system-defined credit status)
Created date is system-supplied but can be edited
Notes can be added (optional)
Acquisitions Workflow-Based Reference Guide Last Revised: October 2017

*Updated to 16.1



187

Note: If the credit status Valid for Use is selected the system applies the credit
to the specific account and the credit status changes automatically to Fully Used.

Click Save to save the credit to the database. As part of the save process the
software:

Validates the currency
Logs the event in the transaction log
Adjusts the account balance to reflect the credit

Update an Internal Credit
Same as Update a Specific Credit.

Use an Internal Credit
Same as Use a Specific Credit.

Prepaid Credits
Add an Prepaid Credit

Click on the New Credit icon EJ on the Acquisitions toolbar or select
Acquisitions > Credits > New on the Virtua main menu. The Add Credit
Request window will appear.

Add Credit Request

Credit Type:
(™ Internal
("~ Specific
(% Prepaid
" Internal Order

Credit Mumber:

Reguest | Cancel ‘

Select a credit type of Prepaid.
Enter a credit number.

Note: The number can be alphanumeric, up to 30 characters long, and is case
sensitive.

Click Request. The Add Credit window will appear.
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W/ Add Credit
Credit Information ]
Credit ID: 12345
Credit Type: Prepaid
Currency: |United States Dollar uso -
Amount: | £0.0000
Credit Status: |valid for Use -]
Create Date: | 9/13/2013 |
Last Modified Date: | J
Expiration Date: ||— ﬂ
Vendar: |.B. PRUTTT -]
Order Mumber: |
Order Line Number: |

‘ MNotes | Save | Cancel ‘

Complete the credit by entering the following information:

Select a currency

Enter an amount

Select the credit status (specifies the system-defined credit status)
Created date is system-supplied but can be edited

Enter expiration date (optional)

Select vendor

Enter order number (optional)

Enter order line number (optional)

Notes can be added (optional)

Click Save to save the credit to the database.

Internal Order Credits

An Internal Order Credit applies to a single order line and is used to adjust the
expenditure for an account; for example, when only one line item from a multi-
line order is canceled.

Add an Internal Order Credit

Click on the New Credit icon EJ on the Acquisitions toolbar or select
Acquisitions > Credits > New on the Virtua main menu. The Add Credit
Request window will appear.
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Add Credit Request

Credit Type:
" Internal
" Specific
" Prepaid
{* Internal COrder

Credit Mumber:

Request | Cancel

Select a credit type of Internal Order.
Enter a credit number.

Note: The number can be alphanumeric, up to 30 characters long, and is case
sensitive.

Click Request. The Add Credit window will appear.

There are two tabs on the Add Credit window for Internal Order credits: Credit
Information and Purchase Order Information.

Enter the following information on the Credit Information tab:

Select a currency

Enter an amount

Select the credit status (specifies the system-defined credit status)
Created date is system-supplied but can be edited

Enter expiration date (optional)

Select vendor

Notes can be added (optional)
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- -,
W/ Add Credit
I Purchase Order Information
Credit ID: 12345
Credit Type: Internal Order
Currency: IUnitecI States Dollar usD ;l
Amount: I
Credit Status: [valid for Use -
Create Date: | 9/11/2013 |
Last Modified Date: I ;I
Expiration Date: Ii'_u LI
vendor: |4.B. PRUTTT -
Rescind Appraval | Motes | Save I Cancel |

Enter the following information on the Purchase Order Information tab:

Enter order ID
Enter order line number
Enter an amount
Notes can be added (optional)
W/ Add Credit
Credit Information  Purchase Order Information |
Order ID: |654EI
QOrder Line Mumber: I 1
Amount: I § 2.0000 Add
Order ID | Line Mumber | Amount |
5549 1 £ 2.0000
Remave |
Rescind Approwval Motes | Save I Cancel |
Click Add to add the amount and then Save to save the credit to the database.
When an Internal Order credit is applied the credit amount linked to each order
line will be added to the new Revenue column of the order line’s accounts.
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Internal Order credits do not affect the account balance; they only affect the
revenue total for each account.

The Credits tab appears on the Order Line Editor window whenever an Internal
Order (or Prepaid or Specific) credit has been associated with the order line via
the Add Credit window.

% Order Line Editor - Customer Support Library
Order Info,Distribution l Bibliographic Information ]
The dangerous summer f Ernest Hemingway ; introduction, James A. Michener.
Line Item Header Information ] Locations l Enriched Data l Account Information  Credits l
Credit ID | Credit Type | Amount
21432 Internal Order £ 2,0000
Claims

Delete a Credit

Credits maybe deleted if they are no longer needed. Use the Delete Credit
Request window to select a credit to delete. Credits are deleted on the Delete

Credit window.
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Serial Purchase Orders

Recommended Explanation
Workflow
Steps in the Serial Purchase Order workflow are similar to
Create the steps in the Monograph workflow with the noted
Purchase exceptions. Please refer to the monographic workflow
sections if you have questions.
Summary
Obtain e Add a Serigls_ Purcha_se Order
Bibliographic e Obtain a Bllbllogrgphlc Record
Recond e Insert line items into the Purchase Order
e Edit Line Items
e Transmit the Purchase Order
Insert e Send the Purchase Order
Line Items e Print the Purchase Order
e Confirm Transmission
v e Renew a Subscription
IIEtcélnt;me Key Terms
e Bibliographic Record
e Chronology
A e Enumeration
Save e Line Item
Purchase e Order Type
e Payment Type
\ e Purchase Order
Send e Serial
Purchase e Transmission of order
e Vendor
Currency Rule
A 4 If a currency is selected for the order that is not the default
Print database currency, all items on the order will use that
Purchase currency.
A4
Confirm
Transmissio
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Profiler Parameters
Sublocation: Sublocation is used to determine the
holdings location for a subscription.

InfoStation Reports
Canceled Serials: Generates a list of serial
subscriptions that have been canceled.

Serials Acquisitions: Generates a list of recently
acquired serials that meet the criteria set in the report
configuration.
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Add Serial Purchase Order
Select Acquisitions > Orders > Add from the menu bar or the icon.

Select Serial as the Order Type. This will add the Enumeration Information tab in
the Line Item Information window.

7 Add PO Request m
Crder Prefix: | ------- ﬂ
Order Mumber: |
Order Type:
|5eria| ﬂ
Payment Type:
|5tandard ﬂ
Vendor:
|wESTON WOODS |
Location:
|Headquarters ﬂ
[ Exchange Order

Retrieve | Canicel ‘

Insert Purchase Order Line Items

This is the same workflow as Monograph orders. See Preparing Book Orders:
Insert Purchase Order Line Items.

Edit Purchase Order Line Items

Edit the Line Item Header Information and Account Information tabs the
same way as monographic orders.

Click on the Enumeration Information tab. This tab is unique to Serials
Purchase orders. The following screen will appear.
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W Order Line Editor - phoenix
Order Info,Distribution ] Bibliographic Information
National geographic,
Line Item Header Information ] Account Information  Enumeration Information l
Enumeration Information:
Start Subscription:
o =l
End Subscription:
[ =l
Cancel Date:
i =l
Motes | | Save | Cancel |

Enter the start and end date of your subscription, the cancel date of the
subscription if applicable, and the enumeration information for the subscription in
the free text box.

Note: If the Alert if Serials Titles Are Duplicated On Other Serials Orders
flag is enabled in Acquisitions Basic Options in the Profiler, then if a line in the
order has been ordered previously is added, an alert message will appear upon
saving the order.

Save Serial Purchase Order

This is the same workflow as Monograph orders. See Preparing Book Orders:
Save the Purchase Order.

Send Serial Purchase Orders
You have two options for transmitting serial purchase orders.

To transmit a purchase order from the Order window, select the radio button
Immediately Proceed to Receipts or Immediately Proceed to Invoices at
the bottom of the window. Click the Save button.

OR
Save the Purchase Order and use the Send Orders option by selecting

Acquisitions 2> Orders 2> Send from the Virtua main menu. See Preparing
Book Orders: Send Purchase Orders.

Note: Transmission of the order will automatically create a holding record
attached to the bibliographic record or records that are ordered.
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W View Bibliographic Record - phoenix g@

Jea e Y

Ful s | Marc | statuses |

Tite: National geographic.
Publication: [Washington, D.C.] :,National Geographic Socety, ,c1959-
CurrentFreg...  Monthly

Location Copy Number -
Bordeaux

Cliffdale

East Regional

Headguarters OM CORDER.

Headguarters

Hope Mills -
'l 3

Item Search | Check-T | View Record |
Current Selection: 1/8 HE eck-In iew Recor

[~ Masked Agency Req ‘ | Edit | Request Bib Add Ttem ‘ Refresh | Close |

Print Serial Purchase Order

Virtua automatically displays a Print dialog box after you transmit a purchase
order via the Send Orders function.

Send Order Summary

After the order is printed, the Send Orders Summary window appears. If any
orders did not print correctly, the checkbox next to the order number should be
cleared so that the order status remains at Approved and the order can be
retransmitted. See Preparing Book Orders: Send Purchase Orders.

Note: By clicking OK the status of all checked orders is set to Ordered and line
items from these orders can now be received.

Renew Subscription from Acquisitions Menu

Virtua allows the user to renew Serials orders without creating a new purchase
order. There are two ways to conduct a renewal, from the Acquisitions >
Orders > Renew option, or from the Reminders window.

Select Acquisitions > Orders > Renew from the Virtua Menu Bar.

Enter the existing Purchase Order humber for the subscription in the Renew PO
Request window. The purchase order will be retrieved.
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=,

FW Renew PO Request E]

Order Mumber: |
Retrieve | Cancel |

Edit the Enumeration Information window to reflect the current year’s
subscription information.

Note: You cannot add new line items to a renewal purchase order.

Save the Purchase order. The Statuses tab will be updated to reflect the renewal.

Renew from Reminders Window
Searching and Viewing Serial Order Reminders

Serial Order Renewal reminders will be created for all serial orders that have
Start Subscription and End Subscription dates specified in the Order Line Editor
window.

Note: The Serial Order Renewal Reminders tab of the vendor record must be
configured for serial order renewal reminders to be created successfully.
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il
7 Edit Vendor - 1D 438 - DEF - phoenix
Contact Info | Acquisitions Info | EDIFACT | Notes | Customer Account | Serial Order Renewal Reminders |
Renewal Alert Interval: IZ j Price Inorease %: I 5.0000 %
Subscription Period: Il j I |
[v Active Delete | Save | Close

To add and search for serial order renewal reminders:

Select Acquisitions > Reminders to access the General Reminders Request
window.
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= =]

W General Reminders Request - phoenix g [

Type

" All Serials Reminders
(™ Serials Check-In Expected Reminders
(™ Serials Claim Expected Reminders
(" Serials User Defined Reminders

{— All Acquisition Reminders
(™ Acquisition Expected Reminders
™ Acquisition Claim Expected Reminders
(™ Acquisition User Defined Reminders
f* Serial Order Renewal Reminders

Additional

Location: | |
Date From: Iv 2/22/2011 »| Te: [vizpsjmiz v
Vendor: | |
Order Type: | =l

Ok Cancel |

Select the Serial Order Renewal Reminders radio button (and additional
search criteria) to search for serial order renewal reminders. Click OK.

The serial order reminders that meet your search criteria, along with reminders
for serial order lines eligible for renewal within the past month, are displayed on
the Acquisition Reminders window.
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i Uy
W Acquisition Reminders - phoenix g@
Title Vendar Claim Count Date Location |
Corporate management ABC-CLIO ] a1l Bellefonte

[electronic resourcel........... What's This?
Renew
Select all

PO Number - Line: 6399 - 1

Order Type: Serial

Quantity: 1

Ignore Until Date: 3/4/2011 12:00:00 AM
User Hame: staff

Reminder Type: PastDue
Renewal Allowed: Mo

Refresh Add Reminder Claims Ignore Until Delete Close

Locate a reminder whose corresponding holdings record uses a vendor whose
Serials Order Renewal Reminders tab is configured.

Note: For Serial Order Renewal Reminders, the Date column and Ignore Until
Date field contain the date that the order line’s subscription is eligible for
renewal.

Renewing Serial Orders

To renew serial orders, highlight the reminder, right-click and select Renew, to
display the Serial Order Renewal window with order lines for the selected
reminders listed. This option will only be enabled when all of the selected
reminders are Serial Order Renewal reminders.
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PO Id | Line ... I Title: | Vendor | Quan... [ Price | Start Subs... | End Subsc... ’ Status I

What's This?

Bibliographic Record
Holdings Record

Remove from List J Renew I Cancel I

Because entire serial orders must be renewed instead of individual lines, order
lines that were not selected on the Acquisitions Reminders window but that
appear on the same order as lines that were selected will also be displayed on the
Serial Order Renewal window.

Order lines brought into the Serial Order Renewal window will be linked to the
current fiscal year. If the order line’s account does not exist in the current fiscal
year, the order line will be assigned a status of Needs Approval.

For each purchase order line, the following information is displayed:

PO ID: The purchase order ID.

Line #: The purchase order line number.

Title: The title of the order line’s subscription.

Vendor: The name of the vendor associated with the order.

Quantity: The quantity ordered.

Price: The subscription’s unit list price. By default, this will be the previous price
plus the percentage increase (if any) specified by the Serial Price Increase %
field in the vendor record.

Start Subscription: The date the subscription starts. By default, this will be the
previous renewal’s End Subscription date plus one day

End Subscription: The date the subscription ends. By default, this will be the
previous year’'s End Subscription date plus the interval specified in the
Subscription Period of the vendor record.

Status: The status of the order line (Needs Approval or Approved). By default
order lines being renewed will be given a status of Approved. However, if the
fund account does not exist in the current fiscal year, a status of Needs Approval
will be assigned instead.

The Serial Order Renewal window contains the following buttons:

Edit: Brings up a window similar to the Order Line Editor that will allow details
such as quantity, price, Start Subscription, End Subscription, Enumeration /
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Chronology, and Fund Account to be edited for the order line. This button will
only be active if exactly one order line is highlighted.

Renew: Saves any changes made to the order lines and renews the order lines
shown. The corresponding Serial Order Renewal reminders for the order lines
appearing on the orders of the lines shown will be deleted. New Serial Order
Renewal reminders will be displayed when the order lines shown are once again
eligible for renewal. The Serial Order Renewal window will close.

Remove From List: Reverts any changes made to the selected order lines and
removes them from the list of order lines to be renewed. The Serial Order
Renewal window will stay open with the order lines that were not selected.
Removing order lines will cause them not to appear on the renewed version of
the order. Removing all lines for an order from the list will cause the order to
not be renewed.

Cancel: Reverts any changes made to the order lines and cancels the renewal.
The Serial Order Renewal reminders will not be deleted. The Serial Order
Renewal window will close.

The right-click menu available on the Serial Order Renewal window contains the
following options:

Bibliographic Record: Brings up the View Bibliographic Record window. This
option will only be available when exactly one order line is selected.

Holdings Record: Brings up the View Holdings Record window. This option will
only be enabled when exactly one order line is selected and that order line is
directly linked to a holdings record.
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Alternative Order Types

Recommend Explanation
Outline
Combined Order Group (COG) consists of Standing Orders,
Standing Monographic Sets, and Planned Orders. The purpose of the
Orders, COG order is to handle non-standard order types and
Monographic workflows. Because titles are not necessarily known in
Sets, and advance, a bibliographic record is not required and Bib IDs do
Planned not have to be assigned to the master title. Once the order
Orders has been transmitted, line items are entered as they are
received, with the line item going directly from a status of
Approved to Received.
Vouchers
When No e Standing Order - An order for a series, subject area, or
Purchase selected set of publications. In most cases the title will be
Order or known in advance of receipt.

Monographic Set - An order for a publication that appears
at irregular intervals, may or may not be numbered, and may
be published and received out of sequence. The title may or
may not be known in advance of receipt.
Planned Order - An order type such as an Approval Plan,
Blanket, or Membership that relies on a profile established
with the vendor before ordering or receiving individual
publications. The title is not know in advance of receipt.
Voucher without an order or invoice
Summary
Complete a standing order
Complete a monographic set order
Complete a planned order
Complete a voucher without a purchase order or invoice
Key Terms
Chronology
Coverage (Subscription Year)
Enumeration
Monographic Set Order
Notes
Planned Order
Standing Order

Standing Order, Monographic Set, and Planned Order

Workflows

While the order of the steps is different from the monographic order, the process
within each step is the same unless otherwise noted. Please refer to the
instructions in the monograph purchase order if you have questions.
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Add Purchase Order
Select Acquisitions 2> Orders > Add from the menu bar or the icon.

Choose Standing order, Monographic Set, or Planned Order from the drop down
menu.

Edit Purchase Order

W Add Order [Z] @
Order Number: 68573 Order Type: Standing Order
Vendor: Q'Connell Publishing Payment Type: Standard
Exchange Order: r

Order Header Information lBiIIing | Shipping Information ]

Status: |Approved jje: |United States Dollar ush - Total Price: $.00
Order Date: | 3/21/2012 j |engcogprinu:-o.utf ﬂ Total Quantity:
Cancel Date: ||_ j

Order Description:

Line Items

Number | Vendor Title ID | Status Title Wolume | Price |Qt§.r. |T0ta| Discount [F==

Create Brief Bib | | | |

When Saving...

f» Exit This Window " Repeat This Function i " Transmit and Reopen For Update
[ Rush Order r Motes | | Save | Cancel |

Note: There is an Order Description box on the order screen that does not exist
on the monograph purchase order screen.

In the Order Description area, you may enter information one of two ways:
Enter a description of the order, or reference an attachment for more complex
orders. Enter volumes or numbers. In the case of Planned Orders, enter
information about the order that your library and the vendor have agreed upon.
OR

Drag-and-drop bibliographic information from the View Record window into the

Order Description area. If you drag bibliographic data into the field where typed
information already exists, the typed information will be cleared.
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Note: The elements of the Order Header Information tab of a COG order are
the same as on a Monograph order except for the Cancel Date field, which is
optional and lets you set the date when the order is to be canceled. Also, note
that in the Print File field, the default file for a COG order is engcogprintpo.utf

The Copy button will allow the order to be copied for another location or for
another vendor.

Save/Transmit Purchase Order

Before you add a line item to a COG order, you must transmit it. Virtua provides
the option to save and transmit in one step.

Select an action when saving.

Note the difference in save options. Immediately proceed to receipts is grayed
out, and the user is offered the option to Transmit and Reopen for Update. In
many cases you will be creating a COG order after you physically receive ordered
line items, so Virtua provides a feature that lets you create, transmit and update
an order by inserting line items in one uninterrupted workflow.

Click the Save button. The order will be transmitted.

Send Purchase Order

After the order is transmitted, you can insert line items and add claims, notes, or
reminders immediately, but you cannot edit the Order Description field.

Print Purchase Order
See Preparing Book Orders: To Print Purchase Orders.

Send Order Summary
See Preparing Book Orders: Send Purchase Orders.

Insert Line Items

If the item does not already exist in the database, you will have to create a brief
bibliographic record for each received line item that you want to insert as a line
item. Insert line items using the same drag-and-drop function used in
monographic orders

Edit the Enumeration Information Tab

Display the Order Line Editor. In the detail box of the Enumeration
Information tab, enter the enumeration and chronology information for the line
item.

Notes

For COG orders, especially for Monographic Sets, notes are important for tracking
purposes. Enter any notes relevant to the order or line item.
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Edit Purchase Order Line Items

Line items can continue to be added as each bibliographic record is added to the
database. Line items are then received, invoiced and paid using the same
workflows as monograph and serial orders.

Voucher When No Order or Invoice Exists

Click on the New Voucher icon on the Acquisitions toolbar or select
Acquisitions > Vouchers > New from the Virtua main menu.

The Create Voucher Request window opens:

L o

Create Voucher Request - phoenix

Vendor Mame:

|O'Cu:unne|| Publishing ﬂ

[ Create From Available Invoices

Request | Cancel |

Select a Vendor and uncheck the Create From Available Invoices checkbox.
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L 1
W Voucher Without Invoices - phoenix E]@

Voucher ID: |

Vendor: O'Connell Publishing

Payment Date: | 3/21/2012 |
Print File Prefix: ||:urintw:uuu:her.utf ﬂ
Accession Mumber: |

Currency: |L|niteu:| States Dollar UsD j
Voucher Total: £.00

Account Information:

= Fiscal Year:

Fiscal fear |AccountID Amount
2012 =l

2012 Books Ledger 5.00
Account:
|Bu:u:-ks Ledger j
Amournt:

Delete .ﬁ.ccnunt| Add Account | | & .00
When Saving...
f* Exit This Window ™ Repeat This Function
Motes | Save | Cancel

The Voucher ID must be entered and must be unique.

The payment date can be changed as needed.

The accession number can be entered or left blank. Note that alphanumeric data
may be entered in this field.

The currency must be selected.

The account must be selected and this displays the fiscal year linked to that
account.

Additional accounts may be added by clicking on the Add Account button.

The payment amount should be entered.

When all information is complete, click on the Save button to add the voucher.

When the voucher is saved, the Voucher Print window is displayed. Chose Print
to print the voucher, or Cancel to exit the window without printing the voucher.
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i

m

1

—Printing

[~ Print In Background

Format: iesher

—Range
Al
¥ Selected Recards
= Selected with Child Recards

opies

Mumber of copies:

O

Printer Setup |

Cancel
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Updating Purchase Orders

Recommended Explanation
Outline
Virtua provides the flexibility to edit purchase orders,
receipts, and invoices.
Acquisitions e Purchase orders may be modified by adding notes,
Notes editing line items, changing the status, number of
copies, unit price, due date of a line item, requestor
barcode, discount amount, surcharge amount, and
Update enumeration/chronology information (start
Purchase subscription date, end subscription date, and cancel
Orders date) or copying. Orders may also be deleted if they
have not been transmitted.
Approve e Receipts may be modified by editing or deleting line
Purchase items or adding notes.
Orders e Invoices may be modified by changing the price,
quantity, or status of line items, by deleting line
Copy items or by adding notes. Entire invoices may also be
Purchase deleted.
Orders Summary
e Add, modify and delete acquisitions notes
Delete e Modify purchase orders
Purchase e Copy purchase orders or line items
Order e Delete purchase orders or order line items
Line Items e Cancel orders or order line items
e Relink purchase orders
Key Terms
Cancel e Acquisition Notes
Purchase e Cancel Order
Order or e Directly Linked Notes
Line Item e Family Priority Notes
e Indirectly Linked Notes
Relink
Purchase
Order
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Explanation (cont.)

InfoStation Reports
Canceled Serials: Generates a list of serials subscriptions that

have been canceled.
Canceled Orders Summary Report: Creates list of orders that

have been cancelled.
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Acquisitions Notes

Acquisitions notes allow free-text descriptive information to be added to records
at all stages of the acquisitions process. Notes buttons are available from the
following windows:

Order (PO Header level note)

Order Line Editor (PO Line Item note)
Line Item Receipt Information
Invoices

Credits

Payments

Voucher Without Invoices

Adding or Editing a Note

From any of the windows listed above, click the Notes button. The Acquisitions
Notes window will appear. Any previously entered notes will appear in the
windows.

W Acquisitions Notes - phoenix g@

Family Priority Motes:
Date | MNote Type | Notes Text |

Motes:

Priority | Date Motes Text

Add ‘

The Family Priority Notes section displays the date, note type and text of any
notes that are indirectly linked to the record and that have been set as a
priority note. For example, if you are adding a note to a receipt, and the
corresponding purchase order has an order note attached, the order note would
display here. Family Priority Notes can only be modified from the record that
owns the note.
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The Notes section of the window displays the priority, date and text of notes that
are directly linked to your record. These notes are editable from this screen. For
example, you are adding a receipt note and there is a previous note related to the
same receipt.

To add a note to the record, click the Add button. To edit a note, click Edit.

Type your note in the Edit Note window.

s Ty
W/ Edit Note - phoenix
Mote Text:
| Priority Mote
Save Cancel

To assign priority to a note, check the Priority Note box.

To print the note or otherwise transmit it to the vendor, check the Transmit to
Vendor box.

Click the Save button. The software has several ways to alert you of when an
active record is associated with notes

A pop-up “alert” indicates that family priority notes are associated with a record
on the Receipts window).

A plus (+) sign indicates a priority note in the Acquisitions Notes window.

An asterisk (*) on the Notes button on the View Order window indicates that
notes exist for the purchase order.

An asterisk (*) preceding the Line Item in the list box on the View Order
window indicates that notes exist for the line item.

An asterisk (*) on the Line Notes button on the Invoice window indicates that
notes are associated with a line item.

To view acquisition notes, navigate to the appropriate window with an alert
displayed.

Click the Notes button.
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W View Order E]@
Order Mumber; 6574 Order Type: Monograph
Vendor: O'Connell Publishing Payment Type: Standard
Ordered By: staff Exchange Order: -
Order Header Information | Billing / Shipping Information
Status: Ordered Currency Type: usD Total Price: £8.00
Order Date: 3/21f2012 Print File: ENGMOMPrintPO,utf Total Quantity: 1
Line [tems
MNumber | Vendor Title ID | Status Title Price | Oty. | Total Discount Fee
1 Ordered The Nick Adams stories. Pref, by Phil...  § 10.00 1 £8.00 £2.00 £.00
Item Reminder | | | ‘ View |
When Closing...
" Exit This Window " Repeat This Function " Immediately Proceed To Invoices
r r Reminders | Copy | | Close |

You can edit or delete individual notes from the Acquisitions Notes window.
When you are finished with Acquisitions Notes, click the Save button to close
the window.

Deleting a Note

To delete a note directly attached to the active record or line item:
On the Acquisitions Notes window, highlight a note in the bottom note field.
Click the Delete button.

The software asks you to confirm the deletion.
Click the Yes button.

The note is removed from the display area.

Working with Family Priority Notes

You can only view those notes that are 1) linked indirectly to an active record and
2) flagged Priority. These notes are the Family Priority Notes, which appear at the
top of the Acquisitions Notes window. An asterisk on the Notes button will
indicate whether a priority note is available. For example, if there are priority
notes attached directly to an invoice that is linked to a purchase order you are
updating, the Notes button on the Order window will display an asterisk. If you
click the button, the system will display those notes in the Family Priority Notes
area of the Acquisitions Notes window.
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Similarly, if you are on the Invoice window and a priority note is attached
directly to a purchase order linked to the invoice record, the Notes button on the
Invoice window will display an asterisk. Clicking the button will display the note
in the Family Priority Notes area of the Acquisitions Notes window.

The following table lists the rules that govern viewing priority notes on other
records.

The Family Priority notes in the Acquisitions Notes window accessed from:

This Window Includes These Priority Notes

Purchase Order Header Invoice Header Notes of invoices lined
to the purchase order.

Order Line Editor Window Receipt notes, invoice line item notes,
and credit notes lined to the purchase
order line item.

Receipt Window Purchase order line item notes,
purchase order header notes, invoice
line item notes, and credit notes
linked to the purchase order/line item.

Invoice Window (Header) Purchase order header notes and
payment notes lined to the invoice.

Invoice Window (Line Item) Purchase order line item notes,
receipt notes, and credit notes lined
to the invoice line item.

Select Invoices for Payment Window Invoice header notes and credit notes
lined to the voucher.

Modifying of Deleting Family Priority Notes

To modify or delete Family Priority notes, you must first access the record that
“owns” that note and then display the Acquisitions Notes window.

To modify or delete a Family Priority note:
Display the “owning” record.
Click the Notes button.
On the Acquisitions Notes window, highlight the note that you want to edit or

delete.
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Click the Edit button or Delete button as required.

In the Edit Note dialog box, modify the note, and then click the Save button.

-OR-

Confirm that you wish to delete the Note.

Update Purchase Orders

After a Purchase order is created, it may be modified. However, not all aspects of
an order can be modified at all stages of the acquisitions process (see chart

blow):

Prior to Prior to Prior to Prior to After
Transmit Receipt Invoice Payment Payment

Line

Items

Approve X

Add X X*

Edit X X*

Delete X X*

Cancel X

Claim X X X X X

Notes X X

Order

Approve X

Delete X

Cancel X

Copy X X X X X

Claim X X X X X

Notes X

* Standing Orders, Monographic Sets and Planned Orders only.

Select Acquisitions > Orders > Update from the Virtua main menu. The
Update PO Request window appears.

/oS

W Update PO Request

Order Mumber: |

Retrieve |

Cancel |

Enter the PO number.

e If the PO has not been transmitted the next window will be the Update Order
window.
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If the order has been transmitted a warning window will appear.

Information

{.:.

This order has been transmitted. You may add/update daims, notes, reminders or change a line item's due date, requestar barcode,
unit price, copies, discount amount, surcharge amount ar enumeration information. Do you want to continue?

Note: The following fields can be modified after a Purchase Order has been
transmitted: claims, reminders, notes, number of copies, unit price, due date of a
line item, requestor barcode, discount amount, surcharge amount, and

enumeration/chronology information.

Proceed to the View Order window.

W View Order [Z] @
Order Number: 6574 Order Type: Monograph
Vendor: O'Connell Publishing Payment Type: Standard
Ordered By: staff Exchange Order: r
Order Header Information | Eiling f Shipping Information
Status: Ordered Currency Type: usD Total Price: £3.00
Order Date: 3f21/2012 Print File: EMGMOMPrintPO. utf Total Quantity:
Line Items
Number | Vendor Tile ID | Status Title Price | Qty. | Total Discount Fee
1 Ordered The MNick Adams ... £ 10.00 1 £8.00 £2.00 £.00
Item Reminder | | | | View |
When Closing...
f Exit This Window " Repeat This Function " Immediately Proceed To Invoices " Immediately Proceed To Receipis
I r Reminders | | Motes™® | Claims | oK | Close |

Approve Order

If you have adequate permissions, you may approve the order, and the order

will be saved with the status of “"Approved”.

If you do not have permission to approve orders, the order will be saved with
the status of “"Need Approval”. A user with adequate permissions for approval
will have to update the order and save the purchase order again.
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Note: The option to automatically approve completed orders is controlled by
parameters set in the Profiler.

Copy Purchase Order Line Items

Purchase order line items may be copied and added to an order before the order
is transmitted. To copy line items on a purchase order after the purchase order
has been saved:

Select Acquisitions > Orders > Update from the Virtua main menu.

Enter the purchase order number the item is attached to. The View Order
window will display.

Highlight the line item to copy and click on the Copy Item button. Another copy
of the line item will appear in the line item box of the purchase order window.

Delete Purchase Order Line Items

Purchase order line items may be deleted from an order before the order is
transmitted. After that, they must be canceled. To delete line items after the
purchase order has been saved:

Select Acquisitions > Orders > Update from the menu bar.

Entered the purchase order number the item is attached to. The View Order
window will be displayed.

Highlight the line item to delete and click on the Delete button. The software will
ask the user for confirmation:

Warning

"j Do you really want to remowve the line item from the order?

Click Yes to delete the line item.

Copy Purchase Orders

To minimize the need to re-key information, data from a previous order can be
duplicated in a new order and then modified as needed.

Select Acquisitions > Orders > Copy from the Virtua main menu or click the
Copy button from the Update Orders window.
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Virtua will prompt you for the original order number, a new order number and the
vendor name for the new order.

s -1
W Copy PO Request E]
Old Order Mumber: |65?4
Mew Order Prefix: | ------- ﬂ
Mew Order Mumber: |65]"5
Vendor:
Chanting Bird Press j
lm Cancel |

The user can choose a different vendor from the vendor drop-down list. If a new
order number is not supplied, it will be generated by the system.

When all the necessary information has been entered, click on Retrieve. The Add

Order window will appear with the original order information but with the new
vendor name and order number.

Delete Purchase Orders

An entire order may be deleted prior to transmission of the order. After
transmission, the order must be canceled.

Select Acquisitions > Orders > Delete from the Menu bar.

Enter the order number for the order you want to delete. The Delete Orders
window appears.
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W Delete Order g@
Order Mumber: 6575 Order Type: Monograph
Vendor: Q'Connell Publishing Payment Type: Standard
Ordered By: staff Exchange Order: -

Order Header Information | Biling / Shipping Information

Status: Approved Currency Type: usD Total Price: £ 10,00
Order Date: 3/21/2012 Print File: ENGMONPrintPO. utf Total Quantity: il
Line Items
Numnber | Vendor Title ID | Status | Title Price | Oty. | Total Discount Fee
1 Approved The Mick Adams stories, Pref, by Phil... £ 10.00 1 £10.00 £.00 £.00

[t | | | e |

When Saving. ..
% Exit This Window " Repeat This Function i r

r r Motes™ | Claims | Delete | Cancel |

Click on the Delete button. The following window appears:

e

Confirm w

¢ Do youreally want to delete this order?

Click the Yes button to confirm the deletion.

Cancel an Order or an Order Line Item

After an order has been transmitted, any non-received item on the order can be
canceled, or if no items have been received the entire order can be canceled.

Select Acquisitions > Orders > Cancel from the Virtua main menu.

Enter the order number. The Cancel Order window appears.
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W/ Cancel Order -Jo&d

Order Number: 6578 Order Type: Monograph
Vendor: 0'Connell Publishing Payment Type: Standard
Ordered By: staff Exchange Order: |

Order Header Information | Biling / Shipping Information

Status: Ordered Currency Type: usD Total Price: £20.00
Order Date: 3f22/2012 Print File: ENGMONPrintCancelPO. utf Total Quantity:
Line Items
MNumber I Vendor Title ID I Status I Title I Price I Oty. I Total Discount Fee
1 Ordered The Mick Adams ... $ 10,00 2 $20.00 £.00 $.00

Create Brief Bibl Cancel Al | Cancel Line |

—When Saving. ..
% Exit This Window {~ Repeat This Function = Immediately. Proceed To Invoices " Immediately Proceed To Receipts

I~ Rush Grder I~ &uko Receive Motes | Claims | Save I Cancel |

Tip: If you do not know the order number, search the OPAC for one of the items
and look at the Statuses tab.

Highlight the item you wish to cancel.
Click on Cancel Line.

The Order Line Editor Window will appear so that the details of the line item
can be confirmed.
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7 Order Line Editor - phoenix &
Order Infa,Distribution |wog—m1nﬁtmﬁm|
The Nick Adams stories. Pref. by Philp Young.
Line [tem Header Informaton | Locations | Account Information |
Urit Price: | Subject Code: | =
Copes: | Status: | =
Total Price: $.00 Shipping Sent To: B ers LibraryTechnical Sav]
Due Dte: | =l Locaton: Jriesdquane |
Collecton Code: | | Source of Selection: | =1
Material: | | Surcharge Amount: |
Discount Amount: | Music M |
Vendor Tie l: |
Reguestor Barcode |
Copies Received: |0 Copies To Cancel: [ -

Notes | chos | Cancel |

Click on Save in the Order Line Editor window.
Repeat the process for any other items you wish to cancel.
Note: If none of the items on an order have been received, the entire order may

be canceled by clicking on Cancel All. The status of all items is now To be
canceled.
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W Cancel Order g@

Order Number: 6576 Order Type: Monograph
Vendor: O'Connell Publishing Payment Type: Standard
Ordered By: staff Exchange Order: r

Order Header Information | Biling / Shipping Information

Status: Ordered Currency Type: usD Total Price: $ 10,00
Order Date: 3f22j2012 Print File: ENGMONPrintCancelPO.utf Total Quantity:
Line Items
Mumber | Vendor Title ID | Status | Title | Price | Qty. | Total Discount Fee
1 Ordered The Nick Adams ... §10.00 1 $10.00 $.00 $.00
>3 To Be Canceled The Mick Adams ... $10.00 1 £ 10.00 $.00 $.00

Cancel All | Cancel Line |

When Saving...
{*' Exit This Window " Repeat This Function i

r I MNotes | Claims | Save | Cancel |

r

Click Save in the Cancel Order window to save the changes. Confirm
cancellation.

L 1

Confirm

o , Doyouwantto proceed with cancellation?

Click OK in the Information window.

-,

Information

\'J) Purchase order canceled: 6576

1

Note: the message indicates that the order has been canceled. However, if any
of the line items in the order were not canceled, they can be received, invoiced

and paid as usual.

To complete the cancellation process, the canceled orders must be transmitted.
Select Acquisitions > Orders > Send Orders from the Virtua main menu.
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W Send Orders - phoenix E] [

{* Al Qutstanding |

(" Single Order

" By Vendor

(" By User | J

(" ByDate | =

[ Filter by Location

" Rush Orders | J
Report | Send | Cancel ‘

[ Transmit Canceled Orders

Click on the check box labeled Transmit Canceled Orders. Select the template for
printing the cancellation.

W Send Orders - phoenix E] [

{s Al Qutstanding |

" single Order

" By Vendor

" By User |

™ By Date |

[ Filter by Location

" Rush Orders

KN S K [ KN B K

Report | Send | Cancel

[v Transmit Canceled Orders

|Nor1e| j

Mone
—|engcogprintcancelpo. utf
engmonprintcancelpo. utf
engserprintcancelpo.utf

Choose whether you want to transmit All Outstanding canceled orders, a Single
[canceled] Order, canceled orders By Vendor, or canceled orders By Date.

Click on Send to transmit the selected canceled orders. At this time, the
transmission method for all cancellations in Virtua is “Print.” Encumbrance totals
are adjusted.
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Use the Send Orders Summary to confirm that canceled orders were printed
correctly.

Note: After transmission, the status of selected items/orders will change from To
be canceled to Canceled.

Select Acquisitions — Orders - View to the see the order in the View Order
window. The cancellation date will now display.

W View Order g @

Order Number: 6576 Order Type: Monograph
Vendor: 0'Connell Publishing Payment Type: Standard
Ordered By: staff Exchange Order: -

Order Header Information | Billing / Shipping Information

Status: Ordered Currency Type: usD Total Price: £10.00
Order Date: 3/22/2012 Print File: ENGMONPrintPO. utf Total Quantity:
Line Items
Number | Wendor Title ID | Status | Title | Price | Qty. | Total Discount Fee
1 Ordered The Mick Adams ... $ 10,00 1 £ 10,00 £.00 $.00
=2 Canceled 3/22/2... The Nick Adams ... £ 10.00 1 5 10.00 5.00 5.00

Item Reminder | | | | Wiew |

‘When Closing...
f+ Exit This Window " Repeat This Function i Immediately Proceed To Invoices i Immediately Proceed To Receipts

r I~ Reminders | Copy | | Claims | | Cloze |

Note: The canceled date will also display on the Acquisitions Statuses tab of
the View Bibliographic Record window.
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Relink a Purchase Order
If you need to delete a bibliographic record (either brief or full) from a purchase

order and replace it with another record, you need to remove the Acquisitions
Statuses tab attached to the original bibliographic record and relink it to the new
bibliographic record.

To move the Acquisitions Statuses tab to a new bibliographic record:

On the Virtua main menu go to Acquisitions > Orders > Update.

When the Order window appears, highlight the item to be updated.

Click the Edit Item or View Item button (the Edit item button will display if the
order has not been transmitted.).

On the Order Line Editor window, click the Bibliographic Information tab.

W Order Line Editor - phoenix

Order Info/Distribution  Bibliographic Information

Title: The snows of Kiimaniarg and other stories [
Author: Hemingway, Ernest,

ISBM: 0654504441 (pbk.) :

Price: 5$12.00

MNotes | Save | Cancel
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Search the OPAC for the record to which you want to move the order line item. On
the View Record window, click the Full tab.

Drag-and-drop the bibliographic data to the Bibliographic Information tab.
Click the Save button on the Order line editor.
Save the updated purchase order.

The Acquisitions Statuses tab for that purchase order will now be attached to
the new bibliographic record.

If appropriate, delete the old bibliographic record from the database by opening
the record in the MARC Editor and selecting File > Delete Record from
Database.
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Recommended Explanation
Workflow
Virtua provides reminders and claiming for Serials and
Acquisitions Acquisitions.
Reminders e Acquisitions Reminders: Used to remind acquisitions

staff that expected items have not arrived.

; ¢ Acquisitions Claiming: Used to identify and claim
View orders or parts of orders that do not arrive when
Reminders expected.

e Serials Claiming: Used to identify and claim specific
issues that do not arrive when expected
Modify
Reminders The claiming function in Virtua has two parts.
e Identifies purchases not received by an expected date
l e Notifies the vendor that the purchase has not been
received
Create a Summary
Reminder e View Reminders
e Modify Reminders
e Create a user-defined Reminder
e Delete a Reminder
e Create a Claim for an order or line item
Acquisitions e Transmit a single Claim or all outstanding Claims
Claiming Key Terms
e Claim
Create Claim e Claim Interval
i e Reclaim Interval
e Reminder
Transmit e Serials Claiming
e User-Defined Reminder

Serials Claiming

View
information
Introduction (cont.)
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Profiler Parameter

Auto Cancel Purchase Order Flag: Controls whether
purchase orders or line numbers are canceled during a batch
claiming operation if the claim sequence number of a claim
exceeds the maximum number of claims as defined in the
Acquisitions Info tab of the vendor record.

Acquisitions Reminders
Reminders in Acquisitions serve many functions. They can alert you if:

A new title on order has not yet been received.

An Order Expected reminder has expired and a Claim Expected reminder is
added.

A claim that has been issued is late.

There are special conditions such as published late, which will entail an
adjustment to the Expected interval.

Virtua supports two types of acquisitions reminders, system generated reminders
and user defined reminders.

System Generated: Virtua Acquisitions creates and deletes system-defined
reminders automatically to serve most reminder functions.

User Defined: A free text reminder enables the user to enter any information of
their choosing. User-defined reminders give your library a way to customize
reminders to serve local needs.

Virtua allows you to generate lists of three types of reminders.

Acquisitions Expected reminders: These are system generated for purchase
order line items that have not been received by the due date, which the system
calculated when the order is transmitted. The system derives the due date by
adding the lead time (the time expected for the vendor to fill the order) to the
current date. The value for the lead-time is stored in the Acquisitions Info tab of
the vendor record. You can either let the software display the Expected reminder
on the due date OR if you want the software to ignore the reminder until a
specified date, you must specify a New Ignore Until Date.
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Claim Expected Reminders: These are system generated when an item is
claimed or reclaimed either manually or automatically by the claim batch job
AutoClaim. The system calculates these reminders by using the value of the
reclaim interval as specified in the vendor record. Each Claim Expected
Reminder is linked to a specific purchase order line item.

Profiler Tip: The Schedule Auto Claim parameter allows you to schedule
autoClaim.exe to be run automatically. The utility autoClaim.exe processes
acquisitions and serials claims in batch. When autoClaim.exe is run, Virtua
processes claims using the same criteria as when you process claims manually
in the Virtua client. After you run this program, you can use the Virtua client to
transmit the claims that autoClaim.exe processed. See Working with the
Schedule Auto Claim Parameter in the Virtua Profiler/Acquisitions Parameters
User’s Guide for more information.

User-Defined Reminder: These are user-generated. Users can tailor reminder
messages and dates to specific needs. You must add and delete User-Defined
reminders from the Reminders window, which contains an Add Reminder
button and a Delete button.

View Reminders

A Reminder search can be defined by entering a location, a beginning date range
and an ending date range.

To access Reminders, click on the Reminders icon on the Acquisitions

toolbar or select on Acquisitions > Reminders from the Virtua main menu. The
General Reminders Request window will display.
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s o

W General Reminders Request - phoenix g

Type

" Al Serials Reminders
(" Serials Check-In Expected Reminders
(" Serials Claim Expected Reminders
{" Serials User Defined Reminders

" All Acguisition Reminders
(" Acquisition Expected Reminders
(" Acquisition Claim Expected Reminders
" Acquisition User Defined Reminders
(" Serial Order Renewal Reminders

Additional
Location: | |
Date From: |
Vendar: | =l
| =
Cancel |

Select All Acquisitions Reminders.

Choose a location, if desired. This will display a reminders list of Acquisitions at
only the specified location. Leaving this blank will display reminders for all
locations.

Choose a starting and ending date range; Virtua defaults to the last 30 days.

If you do not specify a date range, by un-checking the start and ending date
range check boxes, Virtua displays all outstanding reminders.
To see reminders that are not yet active, specify a date range that includes
future date(s).

Choose a vendor, if desired.

Choose an order type, if desired.

Click the OK button. The Acquisition Reminders window will open displaying a
list of all Acquisitions reminders that meet the specified parameters.
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7 Sy
W Acquisition Reminders - phoenix g@
Title | Vendor Claim Count | Date | Location | _
The Ghirardelli chocolate Hristowvi Publishing i} 3/17/2012  Headquarters ||

oookbook.
H. G. Wells ; a biography Hristovi Publishing ] 3172012  Headquarters
/ by Norman and Jeanne
Mackenzie.
H.G. Wells : aspects of a  Hristovi Publishing ] 3172012  Headquarters
life / Anthony West,
H.G. Wells, first citizen Hristovi Publishing ] 3172012  Headquarters
of the future / Keith |
Ferrel, ™

PO Number - Line: 6514 - 1

Order Type: Maonograph
Quantity: 5

Ignore Until Date: 3/17/2012 8:33:49 AM
User Name: staff

Reminder Type: Expected
Renewal Allowed: Mo

Refresh Add Reminder Claims Ignore Until Delete Close

The Acquisition Reminders window displays a list box containing one line per
reminder. The bottom half of the window contains additional information about
the selected reminder.

You can sort column in the List Box. Click any column header to re-sort the list
by the data in that column.
If more reminders are listed than can fit in the window, up and down arrows
beside the list box will let you scroll through the list.
You can multi-select reminders when modifying the Ignore Until date or Deleting
reminders.

The six command buttons are:

Refresh: Refreshes the Acquisition Reminders window after changes.

Add Reminder: Displays the Add Reminder window where you can create a
User-Defined reminder.

Claims: Displays the Claims window for the purchase order or purchase order
line item linked to the selected reminder.

Ignore Until: Displays the Set Ignore Until Date dialog box where you can
set a new Ignore Until date or modify the original Ignore Until date.

Delete: Deletes the selected reminder.

Close: Closes the Reminders window and automatically saves any changes.
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Modify Reminders

Once a reminder displays on the list, it is sometimes necessary to change the date
the reminder becomes active. Highlight the reminder and click the Ignore Until
button.

Note: you can multi-select items from the Acquisition Reminders window by
using the Shift or Control keys.

Increment the reminder date by selecting a set length of time or change the date
manually.

W Acquisition Reminders - phoenix |
Title Vendor | Claim Count | Date | Location |
The Ghirardeli chocolate @ Hristovi Publishing 0 3/17/2012  Headquarters il
cookbook,... ... ..

H. G. Wells : a biography Hristowvi Publishing 0 370012 Headouarbers
/ by Morman and Jeanne o7 Set | Until Date - phoeni
Mackenzie, — gnore o [g E
H.G. Wells ; aspects of 8 Hristovi Publishing 0| Select a radie button option or manually enter a new date
life [ Anthony West. In the new ignore untl date field,
H.G. Wells, first citizen Hristovi Publishing 0
of the future [ Keith (" Increment 1 day
Ferrel. (" Increment 1 week _
- " Increment 2 weeks
PO Number - Line: 6514 - 1 -
Order Type: Monogragh Increment 3 weeks
Quantity: 5 {~ Increment 4 weeks
Ignore Until Date: 3/17/2012 8:33:49 AM  Inaenent 1month
User Name: staff
::n'":::‘;r.:"pe: . ﬁ""d&d Original Ignore Until Date: =]
Mew Ignore Untll Date: 3f17/2012 j
oK | Cancel |
Refresh | Add Reminder | Claimsl ] ‘

Click OK to save the new reminder date. If you set a New Ignore Until Date,
the new date must be equal or greater than the current date. You will not be able
to change the date again until the new Ignore Until Date rolls around, i.e., when
the reminder is displayed on the Reminders window.

Create User Defined Reminders

Occasionally a user may need to add a reminder manually to expedite problem
resolution.

From the Acquisition Reminders window, click Add Reminder. The Add
Reminder window will appear.
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W Add Reminder - phoenix
Remark:
Ignore Until:
3/26/2012 -
oK Cancel ‘

Enter a reminder message in the Remark text box.
Accept the current system date or set a new date in the Ignore Until date box.
Click the OK button. The system responds that the Reminder was added and

should now display in the Reminders window the next time a user views
reminders and selects User Defined Reminders.

Deleting Acquisitions Reminders
Select an issue from the Acquisition Reminders window.

Click on the Delete button. Once an expected reminder is deleted, you need to
recreate or re-predict the issue to reinstate it. Click Yes to confirm the deletion.

e ™y

Information

\]:?) Do you really want to delete this reminder?

Note: The system automatically deletes the Acquisitions Expected Reminder when
an issue is checked in.

Claims

It is recommended that claims be issued at the line-item level.
If you transmit a Purchase Order header level claim, the only information the
claim letter will contain is the Claim ID and the Purchase Order number.
If you transmit an Item level claim, the claim letter will contain bibliographic
information about the item as well as the claim id and the purchase order
number.

The Claiming function in Virtua has two parts:
Identifying library purchases that have not been received by the vendor by an
expected date; and,
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Notifying the vendor of the situation. You can create claims and transmit claims
by means of printing.

Create Claim

Select Acquisitions > Orders > Update from the Virtua main menu. The
Update PO Request window appears. Alternately, you can double-click on an
item from the Title/Remarks column of the Reminder window and issue a claim
from the View Order window.

Enter the PO number.
If the PO has not been transmitted the next window will be the Update Order

window.
If the order has been transmitted a warning window will appear:

Information

& This order has been transmitted. You may addfupdate daims, notes, reminders or chanage a line item's due date, requestor barcode,
\y unit price, copies, discount amount, surcharge amount or enumeration information. Do you want to continue?

From the Update Order window, you will need to access the Claims window.

To claim the entire order: Click the Claims button at the bottom of the View
Order window.

To claim an order line item: Highlight the line item and click on View. The
Order Line Editor will appear. Click the Claims button at the bottom of the
Order Line Editor window.

Note: The Claims button on the View Order window remains active even after
the order has been received.

The Claims window will appear. Click on New Claim to create a claim.

The status will be Created if you never received the items ordered. The status will
be Filled if you received the items, but not satisfactorily. The claim will also
display the reason for the claim: the default system Reason is No copied
received.

Note: If you are unable to create a claim at this point, the Vendor Record may be
incomplete. Please see Managing Vendor Records: Claims for details on how to
complete the vendor record fixed fields to allow claiming.
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Note: Acquisitions claims will not be deleted when purchase order cancellations
are sent; instead, those claims will acquire the status of Canceled.

% Claims - clay6B |Z| |E| E|

Se.,. | Creation Date Skatus Transmission Method Transmission Dake Reason

014 4:06:16 PM Created Prink Mo copies received

[ Edit ‘ Rerinders ‘ | Save | Delete | Transmit | Clase |

Use the Edit check box to enable the drop-down lists to update the Reason,
Status, and Transmission Method fields. Note: All of the Claims statuses are
system defined.

%, Claims - clay68

Se... | Creation Dake Status Transmission Method Transmission Cate | R.easan |
2 9/25/2014 4:06:16 PM  Created Prink | j

Mo copies received

W'rong ikems supplied
Impetfect ikems supplied
Too many Copies received
Insufficient copies received

v Edit | Feminders ‘ | Save | Lielete | Transmit | Close |

Note: To preserve claim history and to allow claims for damaged items to be
added, acquisitions and serial claims are not deleted when an order line or issue is
received satisfactorily; instead, those claims acquire the status of Filled. In
addition, acquisitions claims are not deleted when purchase order cancellations
are sent; instead, those claims acquire the status of Canceled.
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Transmit Claims

Claims can be transmitted individually or in batch. Currently, the only valid
method of claim transmission is Print.

Transmit a Single Claim

The claim must first be created in the Claims window.

From the Claims window, click on Transmit. The Print dialog box will appear.

Print - phoenix
Printing
Claim Records
Format: |§Acquim'ﬁons Claim ﬂ
[~ Print In Background
Range Copies
o Mumber of copies: 1 j‘
=
-
Printer Setup 0K | Cancel |

Click on OK to print the claim. You will receive the following confirmation:

-

Confirm

-,

The daim letter was queued for printing. Did it print OK?

If the claim was successfully printed, click Yes.

The status of the claim will change from Created to Sent and a Transmission Date
will appear.
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% Claims - clay6B |Z| |§| g|

Se.,. | Creation Date Skatus Transmission Method Transmission Date Reason
Qf25/2014 Prink 0

26 PM Mo copies received

[~ Edit Resend ‘ Reminders ‘ Tewy Claim | Delete | Close |

Transmit All Outstanding Claims at Once
To transmit all outstanding claims in batch:

Select Acquisitions 2> Claims 2 Transmit Claims from the Menu Bar. The
Claims Request window opens.

Select a Location (All) and a Type (Any, Serials, or Acquisitions).

W Claim Request - Customer Support Library g [

Select Location: |;u| =
Select Tvpe: Iﬁkﬂ‘; j
Select Viendor: IN-::-ne j

To transmit claims for a specific vendor, use the Select Vendor drop-down list.
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W Claim Request - Customer Support Library g

Select Locaton:  |A

=
Select Type: |f’\ﬂ‘;‘ j
Select Vendor: |AB. PRUITT |

AB. PRUITT

ALE HOME VIDED
ABC-CLIO

ACCT# MT0622
ACCUITY

ACCURATE MAPS, INC
ACTIVE WORLD CO., INC
AEJones

Click Send to transmit all claims. The Print dialog box will appear.

Print - phoenix

Printing

Claim Records

Format: [Acquisitions Claim ﬂ

[~ Print In Background

Range Copies

Mumber of copies: 1 ﬂ

B

Printer Setup 0K | Cancel |

Click on OK to print all outstanding claims.

Confirm
@y LlettersTol vendors were queued for printing. Did all letters print/Email OK?
\.."\r)

Note: After printing all claims, the system returns the message: There are no
outstanding claims to transmit. This means that there are no further claims for
Virtua to transmit; all claims have now been transmitted.

Re-send a Claim That Has Already Been Transmitted

To re-send a claim that has already been transmitted, click the Resend button on
the Claims window. The button is enabled when the selected claim (or claims) has
a status of Transmitted.
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Serial Issue Claims

Serial issue claiming in Virtua is handled differently than claiming an order or
order line item. Vendor information is linked to a Serial Holdings record via the
941 tag of the holdings record. The holdings record and the 941 tag are
automatically created when a serial order is placed. The system populates the
subfields of the 941 tag with information from the order itself and from the vendor
record.

The 941 tag of the holdings record must contain the following information in order
for serial claiming to occur:

\a vendor id \i claim interval \j reclaim interval \k max claims
Note: For those libraries using subject codes in conjunction with their Serial
purchase orders, the 941 tag will also contain the subfield \m, which stores the

subject code value.

Use the Claims button on the Received tab of the Serials Check-In window to
view old claims for the selected issue and add a new claim for a wrong issue.

7 Serfals Check-In - phoenix M=<
Expected Received
Title: iz A
ISSM: 1531-3247
Publisher: Mew York : Hearst Communications,
Frequency: Monthly except June and Aug. B |
Location: Bordeaux el
I | 5 | M | B | Issue | Expected Date | Received Date  +
Will & Kate Special Issue 4f14/2012 11/14/2011 Y
Vol. 11No. 11 Nov. 2011 11/14/2011 11/14/2011 Fl
vol. 11 Mo, 12 Dec. 2011 12/14/2011 11f14/2011
Vol 12Mo. 1 Jan. 2012 1/14/2012 11/14/2011
Yol 12 Mo, 2 Feb, 2012 2{14/2012 11/14/2011
vol. 12 Mo, 3 Mar. 2012 3/14/2012 11/14/2011
Vol 12MNo. 4 Apr, 2012 4f14/2012 11f14/2011
Yol, 12 Mo, 5 May 2012 514/2012 11/14/2011
Yol 12Mo. & June 2012 6/14/2012 11/14/2011
Vol. 12No, 7 July 2012 7/14/2012 11f14/2011
Vol, 12Mo. 8 Aug, 2012 3142012 11/14/2011
Vol, 12 Mo, 9 Sept. 2012 af14/2012 11/14/2011
vol. 12 No. 10 Oct. 2012 10/14/2012 11f14/2011 —
Vol 12 Mo, 11 MNov, 2012 11/14/2012 11/14/2011 _ _.v.
£ »
Uncheck-In
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For more information about Serials Claiming, see the Serials Application User’s
Guide.
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Processing Gift, Exchange and
Deposit Accounts

Recommended Explanation
Workflow
When gifts or legal deposits are received, Virtua
Receive provides a way to both record and acknowledge receipt
a Gift or via the 541 tag of the MARC bibliographic record. The
Deposit information from the subfields in the 541 tag are used
to generate acknowledgment letters.
\ Summary
. e Receive a Gift or Deposit
Configur e Configure the Letter
Ientﬂfr e Print the Thank you Letter
e Clear the Thankyou.dat file
\ Key Terms
Print the : gi?'t]medlate Source of Acquisition) 541 Tag
Letter(s) e Thankyou.dat file
e Unicode Editor
l InfoStation Reports
Gifts Received by Month: Generates a count and
Clear the calculation of all gifts received in the specified date
Ihc?antkyo range sorted by month.

Received Gifts List: Generates a list of all gifts
received in the specified date range.

Receive a Gift or Deposit
On the Cataloging toolbar, click the New Record icon El or on the Virtua main
menu, click File > Records - Create Record.
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You can select a default workform via Cataloging Options on the Options
menu, which will then appear in the MARC Editor or if you do not select a specific
workform to appear by default, then the Create Record window will appear.

Create Record

Look in: | ) Cataleg j |‘=_‘”F Ef-
|[C)Mappings 110aulab. wim arcfly.wim fi
[Z)Mew Fixed Field Files acg.wim comm,wfm fi
[ Mew Waorkforms analytica.wfm comnmlab, wim g
(CMSsAW analytich. wim comp.wim g
(D) validate book.wfm complab.u\'fm g
110au.wfm booklab.wfm frbrexpr, wim g
File name: |'.wfm
Files of type: |User Workdfoms (" wfm) ﬂ Cancel

Select a library-defined workform from the list of files. Click the Open button.

That workform will appear in the MARC Editor. Complete the record, using all
required fields as well as the541 tag (Immediate Source of Acquisition), which
contain additional information needed for the acknowledgment letter.

$a - Source of acquisition (NR) The name of the person or organization that is
the source of the material.

$b - Address (NR)

$c - Method of acquisition (NR) The terms under which a transfer of physical
custody occurs for example, by gift, loan, or purchase.

$d - Date of acquisition (NR)

$e - Accession number (NR) The identification code assigned to materials
acquired in a single and separate transfer of custody. Note that the accession
number may be alphanumeric.

$f - Owner (NR) The individual or organization with legal custody over the
described materials.

$h - Purchase price (NR)

$n - Extent (R) The number of items acquired.

$0 - Type of unit (R) The name of the unit of measurement, for example,
cartons.

$3 - Materials specified (NR)

$5 - Institution to which field applies (NR)

$6 - Linkage (NR)

$8 - Field link and sequence number (R)
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Note: In a future implementation, it will be possible for Virtua to generate a
thank you letter to a second donor by use of the subfield \8 field link and
sequence number.

Example: Generate a letter to one donor:

541 ## \a European Musicological Society \b 1091 W. 17t St. Washington, DC
20091 \c gift \d October 1, 2002

On the Virtua menu bar, click MARC Editor > Remember for Thank You
Letter. An Information dialog box will appear.

7 o

Information

& Thank you letter data fram this record now resides in a file. {ThankYou.dat)
1 You can print this data and other previously stored thank you data by selecting the Print Thank You Letters menu item,

Note: When you choose Remember for Thank You Letter, the system will append
the data in the 541 tag to the data file. In this way, all related bibliographic
objects are processed together, which serves to prevent multiple letters being
generated for the same gift.

Save the new record to the database.

Configure the Letter(s)

Before you can print an acknowledgement letter, you must configure the letter.
Virtua provides a sample thank you letter in English.

Using the sample thank you letter template as a guide, your library might want to
create a different letter template for each language of each giving institution.
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& sampleenglishthankyou.tyl - Notepad E]@
File Edit Format WView Help
[CURRENT_DATE]

[NAME]
[ADDRESS_LINE_1]
[ADDRESS_LINE_2]
Dear Ssir,
Thank you for your [METHOD] of:
[GIFT]Title: ,author: ,Publication Information: ,
wWe greatly appreciate your generosity in providing this{these) item(s)
on [RECEIVE_DATE].

Sincerely,

Libby A. Librarian
Director

( il >

Using this template in conjunction with printing data pulled from the 541 tag in
the bibliographic record, this is what the printed letter would look like. The
bracketed data indicates where the system finds the information to print. If any
gift information is not provided in the bibliographic record(s), the line in the letter
where that information would appear is omitted.
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11 Jan 2001 [current date]

John L. Espley [541 §a]
1701 Keaft De. (41 3]
Blacksburg VA 24060 [541 §b]

Dear Zir,
Thank yvou for your [541 3o gift of:

Title: History of VILS [243 3a]

Author: Espley. John L. [Txx 3a]

Publicaton Informarion: Blacksburp, VA - VTLS Ine., 2010, [260]
Title: Forest Wildfire Managernent [245 3a]

Avthor: Bahlur. Bruce. [Ixx 33]
Publicanon Informarion: Les Alames, NA : Dept. of the Intencr., 200

[260]
We greatly appreciate vour generosity in providing this(these)] mem(s) on [date from
341 34d].

Zincerely,

Libby A. Librarian
Dhirector

Edit the Letter Template File

Open the template file sampleenglishthankyou.tyl using your favorite editor. If
you have accepted the default location for the Virtua installation, the file resides
in the VTLS\Virtua\Catalog directory on your PC.

Edit any text not surrounded by brackets [ ].

Save the file. If desired, assign it a different name, but always use the extension
.tyl and put the file in the \Catalog directory.

Print the Letter(s)

To Print the Same Acknowledgement Letter(s) for All Donors

On the Virtua menu bar, click File.

Acquisitions Workflow-Based Reference Guide Last Revised: October 2017
*Updated to 16.1



246

Choose Print Thank You Letters.

The Thank You Letter Choice dialog box appears, displaying the name of the
recipient (derived from $a of tag 541) in the Letter Recipient field.

Thank You Letter Choice - phoenix

Letter Redpient: |Jclhr| L. Ezpley,

Choose Letter;  |sampleenglishthankyou. tyl

[v Use Same Letter for Other Recipients

Cancel

Choose the letter template file that you want to print. You can have any number
of files in this list. Only files with the extension .tyl appear here.

Leave the check box Use Same Letter for Other Recipients checked, unless you
want to print different letters to different recipients.

Click the OK button. The Print dialog box appears.
Choose the number of copies you want to print.

Click the OK button. Virtua prints the letters, which will list all remembered
bibliographic objects.

To Print a Different Letter to Different Donors
De-select the check box Use Same Letter for Other Recipients.
Print the first letter.

The Thank You Choice dialog box reappears, this time displaying the name of
the second recipient.

Choose a different letter file.

Print the second letter.
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Note: If the check box is de-selected, it remains de-selected during the current
printing of the series of letters only. After the current printing, it returns to the
default value of selected.

Clear the Thankyou.dat file

After you finish printing, you will want to clear the data file ThankYou.dat of the
bibliographic information retained for this printing.

On the Virtua menu bar, click File > Clear Thank You Information. The system
asks you to confirm the action and then clears the file.

¥ S

Confirm

&

Are you sure you want to dear all the thank you letter data you've collected so far?

Cancel |

Now you are ready to start the gift/deposit receipt and acknowledgment process
again for new material.

If, after you clear all thank you information, you try to print another thank you
letter, the system will display the following dialog box:

¥ o

Information

& You must first collect thank you letter data. To do this,
1 bring the records of the gifts into the MARC Editor and select the
Remember for Thank You Letter menu item under the MARC Editor menu,
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Editing Virtua Acquisitions Text
Files

Recommended Explanation
Workflow

Virtua provides nine templates for use with printed

Open file in purchase orders, receipts, claims, and vouchers. These
Text Editor templates are text files that can be modified to reflect

the needs of specific libraries. In addition, you may
translate these files and save them under a different

name.
Summary
e Open a template in a text editor

Edit the
Default

e Distinguish between editable and non-editable part of
the file

Save or e Change the formatting of the document
Save As e Save the file as a new document

Key Terms
Header
Label
Strings
Text file
Comments
Delimiter
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Open Default Text File

The acquisition templates reside in the VTLS\Virtua directory, typically
C:/Program Files/VTLS/Virtua/. The template files installed with Virtua are named
as follows:

Purchase Order Type Template file
Monographic Purchase engmonprintpo.utf
Order

Monographic engmonprintcancelpo.utf
Cancellation

Serial Purchase Order engserprintpo.utf
Serials Cancellation engserprintcancelpo.utf
Standing order types engcogprintpo.utf
Stand order cancellation engcogprintcancelpo.utf
Receipt receipt.utf

Voucher engprintvoucher.utf
Claim Letter engprintclaim.utf

Open the desired text file in a Unicode text editor such as Notepad for Windows
2000.

Note: You can edit every aspect of the template files for the purchase order
letter including: the textual content of the letter; placement of the header,
salutation, and closing; format and placement of the vendor address; size of the
margins; labels of columns and rows; columns widths and row labels.

Edit Text File

Your Library can customize the output by editing the text files.

Example: text file

¥% prints the optional header information.

¥% | inesDown determines how many lines to go down from the top before

#% printing the header. If a value is not specified it is assumed to bhe 0,
% parcentover determines what percent of the printable part of the paper
¥ to leave blank before the header strings are printed. This should he
% hetween 0 and 100, If a walue 95 not specified it s assumed to he 0.
BeginHeader

LinesDbown=1

Percentover=20

Headerstringsl=english Maonograph order.

Headerstrings2=second optional header string.

EndHeader

The lines of text starting with ** are comments. Editing these lines will not
affect output. They are instructions or information to help you in editing the file.
Comments pertaining to an editable section are above that section.
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Below the comments are the editable regions. Information to the right of the
= sign can be edited.

BeginHeader Begins the header section of the document

LinesDown=1 Type a number that indicates the number of lines from the top
of the page to leave blank before starting the header

PercentOver=20 Type a number between 0 and 100 that indicates the
percentage of the page from the left to leave blank before starting the header.
Alternatively, type the word Leftjustify, Center, or Rightjustify

HeaderStringsl=... Type the first line of the header
HeaderStrings2=... Type the second line of the header
EndHeader Ends the header section

Note: The editable regions are shown in bold and text regions are shown in italics
for clarity. The actual text files do not contain either bold or italic type.

Header: The header consists of various header strings. Each text string contains
a line of information such as your library's name, a special department, your
institution's address, or any other suitable information. Additional strings may be
added by using successive numbers:

Example:

HeaderStringsl=... First line of text
HeaderStrings2=... Second line of text
HeaderStrings3=... Third line of text
HeaderStrings4=... Fourth line of text

Vendor: You cannot edit the vendor name and address that appear on the printed
purchase order as they are pulled directly from the vendor record. However, you
can rearrange or delete elements of the VendorFormat: City, State, ZIP, and
Country (see comment for details)

BeginVendor

LinesDown=2

PercentOver=60
VendorFormat=CityStateZipCountry
EndVendor
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Labels: Labels are specified for both columns and rows; the position of the label
and the text can be changed.

BeginTableColumns
POLineNo=Line No.,0,10
ISSN/ISBN=ISSN/ISBN, 11,25
AccountID=Account ID,26,40
Coverage=Coverage,41,55
Quantity=Quantity,56,70
Price=Unit Price,71,85
LineTotal=Line Total,86,100
EndTableColumns

Example: AccountID=Account ID,26,40
AccountID= Virtua Database field name that cannot be edited except to

move or delete
Account ID Label in output that can be edited

, Delimiter — denotes the end of the label text string

26 Position of the start of the column - 26% of the page is to the left
, Delimiter

40 Position of the end of column - 40% of the page is to the left

Display Right-To-Left Language Data in Printed Purchase Orders

To display the data in a right-to-left language, users may edit the printpo.utf
template file and add the option: BeginRowLRO as the first line in the
BeginTableRows section of the text file. When this option is specified, entries in
the table are displayed with the label first, followed by the associated data.

Save Text File
Virtua allows you to save translations of the text files.

Open the file in a Unicode editor such as Notepad.
Edit the file.

Save the file using the following file naming conventions:
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TR
Save in: | (3 Vitua [v] O e E-
5 [C)Catalog E] engserprintcancelpo.utf reque
i :3 |CT)DETables m engserprintpo, utf m sampl
My Recent [iHelp m engserprintparush, utf m sampl
Documerts | |[(2)New Acquisitions Files erb.rec Tl searc
o @centre_cndes-cuuntry_cndes_uc.rtf @] holdlabinput. tet \j:] aslea
|_ o circhack.exe [Z] labinput. txt o virtuz
Desktop b CircBack.ini 4] ibeay32.di irtuz
3 distributionprint.utf odc.rec wirtuz
. ﬂ engcogprintcancelpo, utf [Z] patterns. txt
_J ﬂ engcogprintpo.utf pow.rec
My Documents _‘ engcugpru.'nujurush.utf pclwren.rec
ﬂ engmonprintcancelpo.utf |ﬂ printvoucher.utf
~ ﬂ engmonprintpo. utf E] purchaserequest.utf
le)g ﬂ engmonprintporush, utf m receipt.utf
] ﬂ engprintdaim.utf |ﬂ receivingreport. utf
Mty Computer
[{ ] 1l | [ )]
.% File name: |engm0n|:urint|:un.l.rtf [V] I Save ]
Wy Metwork Save as type: |AJI Files [v] [ Cancel ]
Encoding: |ANS| [v]

First 3 characters of file name = language code
Remainder of file name should match the original file name

Extension should be .utf

Example:
engmonprintpo.utf

(English default file)

fremonprintpo.utf(French translation)

Save as type: All Files

Encoding: UTF-8

The following is a printout of a purchase order and the corresponding text file.
Look at the text file and the printout; the corresponding sections are identified for
you. Compare the printout with the text file to better understand the formatting

commands.
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Example of Print File: Monographic Purchase Order

** Prints the optional header information.
** LinesDowm determines how mawny lines to go dovm from the top before
** printing the header. If a value is not specified it is assumed to be 0.
** PercentOwver determines what percent of the printable part of the paper
** to leawe blank before the header strings are printed. This should be
Header ** between 0 and 100. If a wvalue is not specified it is assumed to be 0.
BeginHeader
LinesDown=1
PercentOver=20
Header Strings1=English Monogreph Order.
Header Strings2=Secoxd opticszal header string.
> EndHeader
> ** Prints the vendor nawme and address.
** LinesDowm determines how many lines to go down from the top before
** printing the wvendor infomar.iém. If a wvalue is not specified it is assumed to be 0.
** PercentOver determines what percent of the printable part of the paper to
** leave blank before primting the vendor information. This should be between
** 0 and 100. If a wvalue is not specified it is assumed to be 0.
** VendorFormat determines how the address will be printed. (issume an address
** yith City = Blacksburg, State = VA, Zip = 24060 and Country = USA.)
Vendor ** ZipCityStateCountry prints the Z4060 Blacksburg, VA and USA on the next line
** ZipCityState prints the Z4060 Blacksburg, VA
** CityStateZipCountry prints the Blacksburg, VA Z4060 and USA on the next line
** CityStateZip prints the Blacksburg, VA Z4060
BeginVendor
LinesDown=2
PercentOver=60
VYendorFormat=CityStateZipCountxry
EndVendor
L—»
** The format that the date should be printed in. d=Day, =Morth, amnd
' yyyy=tear. If there is just yy, then the year will be printed in 2 digits.
** LinesDowm determines how many lines to go down from the top before
** printing the date. If a walue is not specified it is assumed to be 0.
** PercentOwver determines what percent of the printable part of paper to leave
** blank before primting the date. This should be between 0 and 100,
** If a value is not specified it is assumed to be 0.
Date
BeginDate
DateFormat=d mmmm yyyy
LinesDovm=2
PercentOver=60
EndDate
L—»
** Prints the purchase order mmber label and order number.
—p ** LinesDowm determines how many lines to go doom from the top before
** printing the label. If a wvalue is not specified it is assumed to be 0.
** PercentOver determines what percent of the printable part of the paper
** to leawe blank before printing the label. This should be between 0 and 100.
** If a walue is not specified it is assumed to be 0.
Entity N
BeginEntityID
LinesDovm=1
PercentOver=410
EntityID=Order ID:
EndEntityTD
— ** Drints the salutation for the letter.
—p ** LinesDown determines how many lines to go dowm from the top before
** printing the salutation. If a value is not specified it is assumed to be 0.
** PercentOver determines what percent of the printable part of the paper
** to leawve blank before printing the salutsation. This shouwld be between
Salutation ** 0 and 100. If a value is not specified it is assumed to be 0.
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Example of Output: Monographic Purchase Order

Salutation

LinesDowmn=
PercentOver=
Salutat:i.chF:Dgs‘ Veandor,
Salutation2=

e kindly submitting this order for the following items:

Pre-Table
Comment
& Pre'TabIe ;gsm;icm before the table.

BeginPreTab
EndPreTable

** Prints data repetitively in column format.
** The fie] to be specified for esach entry are the label, begin position
o and end position of the column.
Table

Column s

—rmmﬁ:rr' No.,0. 10
ISSNFISBN=L4SNFISBN 11,25

RiccountID=fAgcount ID, 26 .40
Coverage=Covyerage, 6 41, 55
Quantity=Quantity, 56, 70
Price=Unit Ixicp, 71,85
LineTotal=Line Total, 86,100

a repetitively in row format.
to be specified for each entry are the label, begin position
1l and begin position of the data string.

Table Row

L 0,11
Title=Title{, 0,11
EditionStatgment=Edition: 0,11
Publication§tatement=Publ .:, 0, 11
Itemdote=Ttem Wte:,0,11
EndTsbleRows )

** Prints rdws at the end of the table.
** The fields to be specified for each entry are the label, begin position
Bl and begin position of the data string.
Post-Table

e:, 0,11

** Prints the signature at the end of the letter.

** LinesDow} determines how nany lines to go down from the top before

** printing [the signature. If a value is not specified it is assumed to be 0.
** PercentOtger determines what percent of the printable part of the paper

** to leave [blamk before printing the signature. This should be between

** 0 and 100. If a walue is not specified it is assumed to be 0.

Signature

S:i.g-nant.we1=ﬂe hope thet you will be able to fill owr order proumptly. Themd you
cooparation
Signature2=
Signatwe3d=Jirmcerely yowus,
Signatuwred=
SignatwreS=jJccuisitions Depertment
EndSignaturd
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Note: Virtua lets you desighate Rush orders with a checkbox on the Order
window. If you want to create a special Rush Order letter, you can create a
template by modifying one of the default templates.

Header » English Monograph Order.
Second optional header string.
AAA Bookstore
> 600 Kraft Dr.
»
Ven d or Blacksburg VA 24060
United States
»
Date » 15 March 2001
Entitv >
Order ID: 66, Order Type Monograph
- Dear Vendor,
. »
Sa I utation We are kindly submitting this order for the following items:
Ta b | e > Line No. ISSN/ISBN Account ID Coverage Quantity Unit Price Line Total
1 0521205557 : 13003 1 .00$ .00%
» Author: Hallam, A. (Anthony), 1933-
Table Row v Title: Jurassic environments / A. Hallam
Publ.: Cambridge [Eng.] ;, Cambridge University Press,, 1975.
2 No Isbn/Issn 13003 1 .00$ .00$
Author: Hawkes, Jacquetta Hopkins, 1910-
Title: Prehistory and the beginnings of civilization, / by Jacquetta Hawkes and Sir Leonard Woolley
Edition: [1st ed.]
Publ.: New York:, Harper & Row,, 1963
Bill To: Garcia Library, 1420 Manutius Ave., Philadelphia, PA 19403, UNITED STATES
Ship To: Garcia Library, 1420 Manutius Ave., Philadelphia, PA 19403, UNITED STATES
Post-Table >
We hope that you will be able to fill our order promptly. Thank you for your cooperation.
Sincerely yours,
- Acquisitions Department
Table Row >
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Appendix A: Key Terms

Account Name: The alphanumeric name assigned to a fund account, limited to
30 characters. This name appears on all windows that access the fund accounts
such as Order Line Editor, Account windows, Credit windows.

Account Number: The number assigned to a fund account in Acquisitions,
limited to 30 digits. This number is used to associate the account name with the
fund allocation throughout the Acquisitions subsystem.

Account Status: Disabled and Enabled are the only two valid fund account
statuses. If an account is Disabled, then the account is unavailable and only an
authorized user with the appropriate permission can change it to Enabled.

Acquisitions: The activities related to obtaining library materials by purchase,
exchange, gift or other means. New items received are often publicized to users in
an acquisitions list of one form or another. Virtua uses a NBL (New Book List) for
this purpose.

Acquisitions Subsystem: One of the subsystems in Virtua. The Acquisitions
subsystem provides the means to create and administer fund accounts, and to
administer all aspects of the purchase process: purchase orders, receipt of items,
invoices, payment vouchers, claims and reminders.

Allocation: The funds appropriated for an account and all of its “child” accounts
for a given fiscal year. No allocations are entered for deposit accounts.

Applied Credits: The total amount of credits that have been applied to the
selected item (i.e., invoice record, invoice line item, invoice fees, or line fees)
during the current Add Voucher request process.

Audit Trail: A tracking by the system of a sequence of financial events in
Acquisitions and Circulation. Any transaction dealing with patron accounts, fund
allocations, fund expenditures, fund transfers or the exchange of money is logged
as a unique audit trail transaction.

Available Balance: The amount available for distribution and fund transfers from
one account to another.

Bibliographic Record: A type of record that contains data for cataloging in the
MARC bibliographic format. Bibliographic formats contain the following descriptive
elements: title and statement of responsibility (author, editor etc.), edition,
material type, publisher/distributor, publication date, physical characteristics,
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series, notes, standard number (ISBN, ISSN, etc.), and terms of availability,
including price.

Cancel Order: To void an order and notify the vendor that the order is not to be
filled. After an order has been transmitted, any non-received item on the order
can be canceled, or if no items have been received the entire order can be
canceled.

Child Accounts: Accounts at the lowest level of the Account Management
hierarchy. Only child accounts are spending accounts.

Chronology: Information in the 853-855 tags of a holdings record which
indicates the amount of time between publications of serial issues.

Claim (Acquisitions): A library’s demand to a vendor for delivery of new titles
that were ordered via a purchase order and that are overdue based on a claim
date. The claim date is calculated from the order transmission date plus the order
interval as specified in the vendor record plus the claim interval specified in the
Claim Interval field of the vendor record. If these values are set to 000, the
default parameters set in the Virtua Profiler will be used.

Claim Interval: The number of days after a due date that an order is claimed for
the vendor. The claim interval is specified in the vendor record.

Comments: In editable text files for form letters, etc. the lines of text starting
with ** are instructions or information to help you in editing the file. These lines
may be edited without affecting the output.

Coverage (Subscription Year): The time between the starting and ending date
for the subscription of a serial. This information can be entered on the
enumeration tab of the Add Line Item window.

Credit: Two types of credits can be applied to accounts, specific and internal.
Both types are linked to a vendor and the existence of either type of credit for a
specific vendor will activate the Apply Credits button on the voucher window when
creating a voucher for that vendor.

Credit Memo: Once an order is paid or partially paid, you cannot modify, cancel,
or delete the purchase order record. You can only modify or otherwise adjust the
order with a credit memo.

Currency Code: A unique three-character identifier assigned to an individual
country or region’s currency. These codes are specified in ISO 4217.

Delimiter: a blank space, comma, or other character or symbol that indicates the
beginning or end of a character string, word, or data item.
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Directly Linked Notes: Acquisition notes created while in a specific acquisitions
record, e.g. invoice # 2001002, are directly linked to that record and can be
edited.

Distribution: The sum of all the money in a given Management account that has
been allocated to one or more Spending or Management accounts. A Spending
account does not have a distribution associated with it.

EDI: Electronic Data Interchange. A general term for the transmission of business
data in a standardized format between different Electronic Data Processing (EDP)
systems.

EDIFACT: Electronic Data Interchange For Administration, Commerce, and
Transport. It is a data exchange standard used to electronically exchange ordering
information between vendors and libraries.

Enumeration: Values stored in the 853 tag in the holdings record that describe
the way in which a serial is divided. For example: volume, issue and/or part.

Enumeration and Chronology: Values stored in the 863 tag of the MARC
holdings record that are linked to the captions created in the 853 tag. These
values/captions specifically identify a volume or a piece. This information can be
either free-text or in subfields as described in the MARC 21 Concise Holdings
Format.

Encumber: To commit (funds) to be spent. You can set a parameter in the VSC
to encumber funds automatically after a purchase order is approved and
transmitted. Encumbered funds can be spent only on orders for which they are
earmarked.

Encumbrance: The amount of money committed to be spent, but not yet spent.
Encumbrances cannot be changed during a Modify Account action. Any new
orders, cancellations, or payments update the encumbrance.

Expand: This feature allows you to view and edit the item level information of
receipts, invoices, credits, and vouchers.

Expend: To spend from a fund account in the Acquisitions subsystem. For
example, encumbered funds are expended when the ordered items are received,
invoiced, and paid for (see also Encumber).

Expenditure: the amount of money spent from a Spending Account. The amount
cannot be changed in a Modify Account action. Can be changed by applying a
refund; credit or other sources of returned money. Funds are reapplied to the
original account using a formal Credit Memo from the vendor or via an internal
credit created to adjust funds locally.
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Express Receive: receives selected item(s) directly using the default receipt
values. This feature is useful when a number of items are received in good
condition, the correct titles, etc.

Family Priority Notes: notes attached indirectly to the record; these notes
appear in the top Acquisitions Notes window. To add, modify, or delete notes that
are indirectly linked to the active record, you must access the record “owning”
that note.

Fees: Costs assigned to the user or library for services such as photocopying,
shipping, handling, or setting up booked material and equipment.

Fiscal Year: A 12-month period between settlement of financial accounts in
Acquisitions Fund Accounting. All fiscal year information is pulled from the VSC
Acquisitions parameters. Libraries define the format for displaying the fiscal year,
which is limited to 30 character positions.

Fiscal Year Rollover: Process of transferring existing account structures,
allocations, encumbrances and outstanding orders from one fiscal year to another.

Fixed Field: Tags of the MARC record that contains fixed-length data elements;
specifically the 006, 007, 008 tags and the leader.

Fixed Field Editor: An editor in the Virtua software that allows you to select
fixed field elements from dropdown menus.

Free Balance: The amount in a fund account that has not been encumbered or
expended.

Fund Transfer: You can transfer allocations and existing balances between two
fund accounts in the same fiscal year or in different fiscal years no matter where
the accounts exist in the hierarchy.

Gift: An order payment type whereby an item such as a sample issue, depository
item, or sample issue is received at no cost to the library. Gift processing is
usually handled via an acquisitions subsystem, but in Virtua it is handled via the
Cataloging subsystem.

Header: Information at the top of a document, usually for the purpose of
identification.

Immediate Source of Acquisition: the 541 tag of the bibliographic record.
Virtua requires information from this tag to generate thank you letters for gifts.
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Indirectly Linked Notes: Acquisition notes that are linked to the record but
were not originally created from that notes window, e.g. a note created with the
invoice but being viewed from the voucher window. In order to edit the note, you
must return retrieve the invoice to access the note as a direct link.

Internal Credit: Created internally, linked directly to a vendor, and used to
adjust the expenditure for an account, for example, when an order for a partially
paid item is canceled.

Invoice: A bill for goods or services showing itemized quantities, prices,
discounts and terms, and net amount due. Paying invoices is a main function in
Virtua Acquisitions.

Invoice Fees: fees such as special taxes and postal or delivery charges that
applied to the entire invoice and are viewed via the Invoice fees tab.

Invoice Status: The Virtua Profiler is shipped with preset status values that can
be modified. Status parameters determine the way Virtua processes acquisitions
transactions involving purchase orders, receipts, invoices, payments, and credits.
For example, in the Invoice Status parameter, you can associate the action Hold
with the invoice status Incomplete. In this way, Virtua will not present for
payment an invoice with the status of Incomplete.

Label: a word or phrase indicating that what follows belongs in a particular
category or classification.

Line Item: a specific item attached to a purchase order, invoice, receipts, or
voucher. A line item will have one associated bibliographic record, but may
include multiple copies.

Line Fees: Fees, such as special taxes and postal or delivery charges, that apply
to a specific line item that can be viewed from the Line fees tab.

Management Account: A “root” account to which funds can be added and from
which funds can be transferred (see also Spending Account.). At least one
management account must be defined at the “root”, or first tier, of the account
structure.

MARC Labels: The MARC Editor can operate in "Use MARC Labels" mode, which
facilitates quick and simple record editing for novice catalogers by providing
textual labels for the MARC tag numbers.

MARC Editor: An editor accessible via the Cataloging subsystem of the Virtua
Client that lets you edit records adhering to the MARC standard.
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Monographic Set Order: An order for a vendor to ship a publication, usually
published at irregular intervals, until the order is specifically canceled. Does not
require a bibliographic record prior to ordering.

New Book List (NBL): In Acquisitions, a check box on the Add Receipts window
that indicates whether or not a line item should be printed on the New Book List
(NBL), which will be produced by the Reports Client. Once the NBL is printed, the
NBL check box is automatically de-selected.

Notes: Notes may be added add anytime in the acquisitions process. All notes
related to a series of transactions (e.g. purchase order, receipt, invoice, and
voucher for a specific order) will display the same “family” of notes in the upper
window of the notes screen. Notes are either directly linked and can be edited or
indirectly linked and cannot be edited from that screen. Directly linked notes
appear in the bottom half of the notes screen.

Order Type: Virtua supports five types of purchase orders through the
acquisitions sub-system: monographic, serial, monographic set, planned, and
standing orders. A sixth type (gifts) is supported though the cataloging sub-
system.

Over-encumbrance: An encumbrance that is greater than the original allocation
to the fund account. In Acquisitions, a user can allow an account to be over-
encumbered as a percentage or as a specified dollar amount.

Over-expenditure: An amount of money allowed to be spent over and above the
original allocation to a Spending account. In Acquisitions, accounts may be over
expended by a specified percentage of the allocation or by a specified dollar
amount (see also Expenditure).

Parent Account: the hierarchical tree structure of Virtua’s fund accounting
system is based on the “parent” account-"child” account concept. You can have as
many parent-child relationships as necessary. Each parent account can be linked
to an unlimited number of child accounts.

Payment Type: Virtua supports three payment types: Standard, Pre-Paid, and
Deposit/Donation.

Planned Order: An order such as an approval plan, blanket, continuation, or
membership, whereby an agreement is made with a vendor before ordering or
receiving individual publications. Does not require a bibliographic record prior to
ordering.

Prepaid: An order payment type in Acquisitions whereby the payment satisfies a
vendor’s requirement that the library pay for a specific order before it is filled.
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Price Variance Threshold: A library-defined percentage value that defines the
point at which the difference between invoice price and purchase order price
becomes unacceptable. When this threshold is reached, i.e., when an invoice price
is the specified percentage above the purchase order price, the system warns the
user.

Purchase Order: An Acquisitions record that a staff creates to purchase one or
more items from a vendor for a library’s collection or holdings. You can create a
purchase order only for an item that has a bibliographic record in the database.

Receipt: The recording of the arrival of ordered material. It is attached to a
purchase order with an internal receipt ID.

Reclaim Interval: The number of days after a claim date that a claim is
reclaimed. A reclaim for an ordered title can be issued when the claim sequence
number field has a value greater than 1; this value is stored in the vendor record.
You can issue a reclaim interactively any time after the first claim was issued.
Masked Record: Records that are hidden for some reason, often because they
are on order. Records that are masked will not appear in the results of searches
performed by users who do not have permission to view masked records (usually
library patrons).

Reminder: An automatically generated list of items, (acquisitions), or issues,
(serials), whose expected arrival date has passed. The expected date is based on
information from the vendor record, or default parameters set in the Profiler
(Acquisitions) or from the 941 tag of the holdings record (serials).

SAN: The Standard Address Number (SAN) is a unique identifier for an
organization involved in the book industry. SANs facilitate the communication of
data surrounding activities such as purchasing, shipping, and billing.

Selection List: A list of materials recommended for purchase. In Virtua items for
selection lists can be submitted electronically and integrated into the Acquisitions
sub-system.

Serial Order: An order for a publication issued in successive parts bearing
numeric or chronological designations and intended to be continued indefinitely.
Requires a bibliographic record prior to ordering.

Serials Claiming: A library’s demand to a serial subscription agent for delivery of
an overdue issue. The decision to issue an automatic claim is based on several
values and settings, including information in the 941 tag of the serials holding
record.

Specific Credit: Linked directly to a vendor and applied to future invoices for that
vendor in order to offset the payment.
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Spending Accounts: A “child” account to which funds can be added. Money can
be expended from Spending Accounts only. Spending Accounts cannot become
Management Accounts.

Standard Payment: An order payment type in Acquisitions that is NOT a deposit
account, gift, government deposit, or prepaid order payment type. The workflow
for a standard payment is that the library creates an order, the vendor sends the
invoice with the ordered items, and then the library pays the invoice.

Standing order: An order, usually for a series or subject area, whereby a vendor
supplies new issues of a series, or new titles in a subject area, as they are
published. Does not require a bibliographic record prior to ordering.

Statuses Tab: describes the current state of the Order, Receipt, Invoice,
Payment and Credit for the associated Bib-ID. Statuses appear in the client on the
View Record window/Statuses tab.

String: A linear sequence of symbols, words, characters, or bits that is treated as
a unit

Text File: a computer file that contains text (and possibly formatting instructions)
and can be edited with a Unicode editor.

Thankyou.dat File: An editable text file in Virtua that allows libraries to generate
thank you letters for gifts.

Transmission of order: Currently the only way to transmit an order in Virtua is
to print the order.

Unicode Editor: an editor that supports the Unicode standard for full multilingual
text.

User-defined Reminder: A reminder type in Virtua that allows users to define a
reminder and set the reminder date rather than have Virtua automatically
generate a reminder.

Vendor: The party responsible for supplying titles or serial issues to the library.

Vendor ID: A unique number sequentially assigned by the system to each vendor
record as it enters the database. This number is stored in the vendor record.

Vendor Notes: Note fields in the vendor record used to store information that
does not have another place in the vendor record. These notes can generate
alerts when the record is accessed.
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Vendor Record: A database record, which describes a provider of library
materials.

Voucher: A form that can be printed that details the total amount to be paid to
the vendor for selected invoices or invoice line items. The form is sent to the
agency responsible for creating the payment method (e.g., check, wire transfer,
etc.).

Voucher ID: A unique number assigned to each voucher as it is created. This
number is used to retrieve the voucher at a later date.

Workform: Virtua templates for inputting MARC and MARC-like records.
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Appendix B: List of InfoStation
Reports for Acquisitions

Acquisitions Report Notice Function

Group

Account Summaries N Summary of acquisitions accounts

Acquisitions Audit Trail N Summary of acquisitions account activity that
meets a date criteria set in the report
configuration parameters.

New Books List N List of books currently marked “new”.

Gifts Received by Month N Count and calculation of all gifts received in the
specified date range sorted by month.

Items Received by N Count and calculation of all items received

Month through the Acquisitions subsystem in the
specified date range.

Order Status N List of orders with a specified order status.

Received Gifts List N List of all gifts received in the specified date
range.

Received Items List N List of all items received through the
Acquisitions subsystem that fall within the
specified date range.

Titles on Order N List of titles currently on order.

Vendor List N List of Vendors sorted by parameter set in
report configuration

Vendor Performance N List of vendors with accompanying performance
statistics: fill rate, cancel rate, claim rate, etc.

Vouchers N Summary of all vouchers for a specified
vendor(s) and date range set in report
configuration.
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Appendix C: Acquisitions in a
Consortium Environment

Acquisitions Parameters in the Profiler

In the consortium environment, institutions along with their associated locations
and sub locations have the ability to define their own acquisitions policies. This is
accomplished by allowing acquisitions parameters to be set at the institution level.

User Permissions

e Acquisition users defined on the Global tab of the Profiler have the ability to
manage fund accounts and create purchase orders, invoices, and vouchers for
their institution only.

e Acquisitions users may not see the acquisitions activity of another institution.

The following Acquisitions Profiler parameters are set at the institution level:

General Parameters

¢ Acquisitions Basic Options: contains a variety of flags that control different
aspects of the Acquisitions subsystem one of which is the Filter Acquisitions
Records by Log-in Location parameter: If this flag is Disabled then acquisitions
data is filtered at the institution level. If this flag is Enabled then acquisitions
data is filtered at the location level within the institution.

o Distribution Groups: provide for centralized acquisitions and the distribution of
materials to specific libraries or groups of libraries.

e Fiscal Year: lets you define fiscal years for use within the Acquisitions
subsystem.

e Statuses: defines Credit, Invoice, Payment, Purchase Order, and Receipt
statuses that display throughout the Acquisitions subsystem.

Purchase Order Parameters

e Acquisitions Addresses: controls the linking of specific addresses to one or
more location names for the purposes of billing and shipping purchase orders.

e Shipping Methods: defines shipping methods that appear in the Shipping
Method drop-down list on the Add Order window.
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e Subject Codes: defines optional codes used to keep track of orders related to a
particular part of your collection. Subject Codes display in the drop-down list on
the Line Item Header Information tab of the Order Line Editor window.

Receipt Parameters

e Condition Codes: Describes condition in which item is received

Invoice Parameters

¢ Invoice Header Fee: controls the drop-down list of fee types available in the
Invoice Fee Modification window.

¢ Invoice Line Item Display: displays ALL purchase order line items or displays
only RECEIVED purchase order line items on the Add Invoice and Add Invoice
Line Items window in the Virtua client.

e Invoice Line Item Fees: defines fees and taxes that apply to specific line
items on an invoice. The list of defined fees will appear in the drop-down list of
fee types in the Line Fees Modification window.

¢ Payment Methods: defines payment methods that appear in the Virtua client
in the Method of Payment drop-down list on the Invoice window.

e SAP Codes: define three sets of codes—one set each for invoices, payment
vouchers, and credit memos. Libraries that interface with administrative and
accounting offices require the use of SAP (System Analysis and Program
Development) codes on invoices, payment vouchers, and credit memos.

e Taxes: defines different types of taxes so that your libraries can track taxes
separately from invoice fees. The Taxes parameter affects the appearance of the
Invoice window in the following ways:

The appearance (or nhon-appearance) of the Line Taxes button and Invoice Taxes
button on the Invoice window.

The list of available taxes, which appears when you click the Line Taxes button or
Invoice Taxes button on the Invoice window.

The tax type that appears first in the list of taxes on the Invoice window.

The calculation of the Tax Amount for a line item, which appears when you click
the Edit button on the Invoice window, and the calculation of the Invoice Tax
Total, which appears in the invoice header.

Claiming Parameters

e Schedule Auto Claim: schedules the running of autoClaim.exe, a batch
processing utility that processes acquisitions and serials claims.
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Selection Lists Parameters

Purchase Request Lists: allows staff and patrons, depending on the
roles/permissions assigned to them in these parameters, to make purchase
requests and to manage the list of titles that have been requested for purchase.

Virtua Client in a Consortium Environment

Vendor Browse Search

Two types of vendor browse searches are available:

Vendor - The search returns only vendor records specific to the logged in
institution.

All Vendors - The search returns all vendor records throughout the database
whether or not they belong to the logged in institution. This allows other
institutions within the consortium to copy vendor records.

Vendor Records

Vendor records are associated with the institution that created them and will not
display in the Acquisitions subsystem of other institutions. Vendor records may be
viewed and copied by other institutions by doing a browse search on All Vendors
and then copying the vendor record.

Claiming

Only those locations linked to the log-in institution appear in the drop-down list of
locations in the Claim Request window. If the All option is selected, the claims will
be generated for those locations linked to the institution. Claims will not be

generated for locations in the database that are associated with other institutions.

Reminders

The Location drop-down list on the General Reminders Request window displays
only those locations linked to the institution associated with the logged in user. If
no location is selected for filtering, Virtua displays reminders for all locations
belonging to the institution. Reminders are not displayed for locations that are
associated with other institutions.

Acquisitions Workflow-Based Reference Guide Last Revised: October 2017
*Updated to 16.1



269

EDIFACT

When EDIFACT fees and taxes are looked up by EDI code, the system takes into
account the associated institution. As a result, the fees and taxes that appear on
EDIFACT invoice messages are associated with the invoice’s institution.
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Appendix D: Viewing Acquisitions
Audit Trail & Transaction Log

Recommended Explanation
Workflow

Virtua is allows users to access Acquisitions Audit Trail
Audit Trail information and Acquisitions Transaction log information in the
Virtua Client.

The Acquisitions Audit Trail is accessible in the Virtua Client,

so that users may view transactions against acquisitions fund

Acquisitions
accounts.

Transaction

The Acquisitions Transaction Log is accessible in the Virtua
Client, so that users may view any acquisitions transactions.
Summary

e View Acquisitions audit trail information.

e View Acquisitions transaction log information.
Key Terms

e Audit Trail

e Transaction Log
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Access Acquisitions Audit Trail

To view acquisitions audit trail details, on the Virtua main menu, go Acquisitions
- Transactions > Audit Trail.

Enter a date range and click the Search button to view the audit trail entries.

W Acquisitions Audit Trail - phoenix

Fitters:
"
From:
3 82012 -

Close

| Date

BEX]
|

Account Name | Fiscal Year | Amount | Action PO ID -Line Mumber | Location

S0 ADULT HQU 3/6/2012 12:06:17 FM 2010 $15.00 Disencumbrance 6532-1 Headquarters
SO ADULT HQU 3f6/2012 12:06:17 PM 2010 £15.00 Digencumbrance £6532-2 Headquarters
S0 ADULT HQU 3f6/2012 12:06: 17 FM 2010 514.25 Encumbrance 6532-2 Headquarters
S0 ADULT HQU 3/6/2012 12:06:17 PM 2010 §14.25 Encumbrance 6532-1 Headquarters
SO ADULT HQU 3f6/2012 12:05:20 PM 2010 £15.00 Encumbrance 6532-2 Headquarters
S0 ADULT HQU 3f6/2012 12:05:20 PM 2010 515.00 Encumbrance 6532-1 Headquarters

Access Acquisitions Transaction Log

To view acquisitions transaction log details, on the Virtua main menu, go to

Acquisitions > Transactions >Transaction Log.

Enter a date range and click the Search button to view acquisitions transaction

entries.
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W Acquisitions Transaction Log - phoenix

-I:Im

Fitters:

¥ Use DatesTime:

From:

[remoz -
[ 1z00:00 an =

Close

Action | Date Account Name | Vendor | Invoice ID | PO ID - Line Mumber I
Invoice Modified 3/6/2012 12:06:16 PM 1227

Invoice Detail Modified 3/6/2012 12:08:16 PM 1222 B8532-1
Invoice Detail Modified 3/6/2012 12:06:16 FM 1222 65532-2
Invoice Detail Modified 3/6/2012 12:05:20 PM 1227 6532-2
Invoice Detail Modified 3f6/2012 12:05:20 PM 1222 6532-1
Invoice Modified 3/6/2012 12:05:20 PM 1222

Purchase Order Line It...  3/5/2012 12:04:35 FM 6532-1
Purchase Order Line [t...  3f6/2012 12:04:39 PM 6532-2
Invoice Detail Added 3f6/2012 11:59:59 AM 1222 8532-1
Invoice Detail Added 3/6/2012 11:59:59 AM 1222 8532-2
Invoice Added 3/6/2012 11:55:58 AM 1222

Receipt Added 3f6/2012 11:39:54 AM 8532-2
Receipt Added 3f6/2012 11:39:54 AM B8532-1
Purchase Order Trans...  3/5/2012 10:51:03 AM 6532
Purchase Order Line [t... 3/6/2012 10:50:11 AM B8532-2
Purchase Order Modified  3/6/2012 10:50:11 AM 6532

Acquisitions Workflow-Based Reference Guide

*Updated to 16.1

Last Revised: October 2017



273

Appendix G - Changes in this
Guide

Changes for Version 16.1

No changes were made.
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